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Šiame skyriuje pristatoma SMART Notebook® mokymosi bendradarbiaujant programinė įranga ir 

paaiškinama, kaip ja naudotis. 
 

 
 

Pradžia 
Naudodami SMART Notebook programinę įrangą, jūs galite kurti .notebook failus su piešiniais, tekstu, 

lentelėmis, linijomis, figūromis, animacijomis ir daugiau. Pristatykite savo failą ir išlaikykite klasės dėmesį 

judindami šiuos objektus ir sąveikaudami su jais. Kai jūsų klasė pateikia pastabų ir pasiūlymų, įrašykite 

juos puslapyje naudodami skaitmeninį rašalą. Galite atidaryti .notebook failus, esančius SMART Notebook 

programinėje įrangoje, naudodami Windows®, Mac ar Linux® operacines sistemas. Taip pat galite 

eksportuoti failus į įvairius formatus, įtraukiant HTML ir PDF. 

 
 

SVARBU 
 

Prieiga prie papildomų SMART Notebook 18 funkcijų priklauso nuo leidimo naudotis programine įranga, 

kuris suteikiamas prijungus prie SMART paskyros el. paštu ar aktyvavus produkto raktą. 
 

 
 

SMART Notebook programinės įrangos įjungimas pirmą kartą 
Kai pirmą kartą įjungsite SMART Notebook programinę įrangą, atsiras pradinis ekranas. Pasirinkite New 

Features pradiniame ekrane ir sužinokite daugiau apie programinę įrangą ir naujas funkcijas. 
 

 

Pažymėkite Don’t show this again langelį, jei nenorite, kad pradinis ekranas atsirastų kiekvieną kartą 

įjungus SMART Notebook programinę įrangą. Galite įjungti pradinė ekraną bet kada, nuėję į SMART 

Notebook programinės įrangos Menu > Help. 

 
Įjungę Notebook, pasirinkite File > New ir sukurkite naują, tuščią failą. Daugiau informacijos pateikta 

creating-and-working-with-files-and- pages.htm. 

 

 

Prisijungimas prie paskyros 
SMART Notebook 18 programinė įranga leidžia jums prisijungti su Google™ ar Microsoft paskyra. 

(Prisijungimas būtinas norint kurti ir naudotis dauguma SMART lab veiklų.) Prisijungus su viena iš šių 

paskyrų, jums ir jūsų mokiniams nereikės prisijungti kiekvieną kartą, kai norėsite naudotis SMART 

response 2 ar kitomis veiklomis, kurioms būtina prisijungti. 

 
Vienkartinis prisijungimas leidžia: 

 
l  Mokiniams prisijungti prie jūsų SMART lab ir response 2 veiklų su vienu nuolatiniu kodu (mokiniams 

nereikės prisijungti kiekvieną kartą). 
 

l  Pasidalinti pamokomis su bendradarbiais naudojant vieną internetinę nuorodą. 
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l  Pasidalinti pamokomis SMART lentose su iQ technologija. 
 

l  Naudotis ribotomis Notebook funkcijomis pasibaigus bandomajam laikotarpiui. 
 
 

PASTABA 
 

Jei neprisijungsite, negalėsite naudotis veiklomis, kurioms jūsų prašoma prisijungti. Jūsų prašys 

prisijungti: 

l  Naudojantis SMART lab kūrimo vedlį pirmą kartą. 
 

l  Naudojantis SMART response 2, Shout It Out! ir Monster Quiz veiklomis. 
 

l  Naudojantis Hand out veikla. 
 

Įjungus programinę įrangą kitą kartą, naujas, tuščias failas atsidarys automatiškai. Norint atidaryti 

mokomąją programą, pasirinkite Help > Tutorial. 
 
 

Daugiau informacijos apie nustatymus ir prisijungimą prie SMART paskyros. 
 
 

Ribotas režimas 
Pasibaigus bandomajam laikotarpiui, Notebook veikia ribotu režimu, nebent jūs įsigijote a SMART Learning 

Suite prenumeratą ir aktyvavote savo Notebook arba gavote teisę naudotis SMART programinės įrangos 

portalu. 

 
Ribotas režimas leidžia naudotis ribotomis SMART Notebook programinės įrangos funkcijomis be 

bandomojo laikotarpio ar prenumeratos įsigijimo, bet papildomos funkcijos bus išjungtos. 

 

 

Pradinis ekranas 
Pradiniame ekrane suteikiama informacija, nuorodos į naujas Notebook savybes ir turinį, failų 

dalinimąsi, naujausią prenumeratos informaciją ir atnaujinimo pasiūlymus. Taip pat matysite paskutinius 

Notebook failus. 
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Sąsajos navigacija 
SMART Notebook programinės įrangos sąsają sudaro šie komponentai: 

 
l  Meniu 

 

l  Įrankių juosta 
 

l  Skirtukai (puslapių rūšiuotuvas, galerija, priedai, savybės ir papildomi įrankiai) 
 

l  Puslapio sritis 

 
Meniu 

Meniu sudaro komandos, skirtos valdyti failus ir objektus. 
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Įrankių juosta 

Įrankių juostoje galite pasirinkti ir naudoti įvairias komandas. Įrankių juostos mygtukai yra 

pateikiami kaip lentelės. 
 

Lentelė  Aprašas 
 

Veiksmai  Veiksmų lentelėje yra mygtukai, skirti peržiūrėti ir keisti 

.notebook failus: 
 

 
 
 
 
 
 

Papildomi įrankiai  Jei įdiegsite SMART Notebook papildomus įrankius, papildomų įrankių lentelė 

atsiras veiksmų lentelės dešinėje: 

 
 
 
 
 

 

Įrankiai  Įrankių lentelėje yra mygtukai, skirti puslapiuose kurti pagrindinius objektus ir su 

jais dirbti: 

 
 
 
 
 

 

Kontekstinė juosta Kai pasirenkate mygtuką įrankių lentelėje, atsiranda papildomi mygtukai. 

Pvz., pasirinkus Pens , atsiras šie papildomi mygtukai: 
 
 
 
 
 
 
 
 
 
 

 
Spauskite Pen Types mygtuką, norėdami pasirinkti rašiklio tipą, tuomet pasirinkite 

vieną linijos tipo mygtuką, kad galėtumėte rašyti ar piešti skaitmeniniu rašalu tuo 

linijos tipu. Galite tinkinti pasirinktą linijos tipą naudodami variantus savybių 

kortelėje ir išsaugoti savo tinkinimus vėlesniam naudojimui (žiūrėkite „Objekto 

savybių keitimas“ 66 puslapyje). 

Naudokite tris savybių selektorius šalia linijos tipo mygtukų, kad nustatytumėte 

skaitmeninio rašalo spalvą, storį, stilių ir skaidrumą. 

Jei paspausite kitus mygtukus įrankių lentelėje, atsiras panašūs papildomų mygtukų 

rinkiniai. 
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PASTABA 

 

Įrankių juostos komandas taip pat galite rasti meniu. 
 
 

Galite pridėti, pašalinti mygtukus ir pakeisti jų padėtį įrankių juostoje paspaudę Customize the toolbar  

(žiūrėkite „Įrankių juostos tinkinimas“ 181 puslapyje). 

 
Nustatyta, kad įrankių juosta atsirastų SMART Notebook programinės įrangos lango viršuje. Jūs galite 

perkelti ją į apačią  paspaudę Move toolbar to top/bottom of window . Tai naudinga, jei jūs ar jūsų 

mokiniai negali pasiekti įrankių juostos, kai ji yra lango viršuje. 

 
Puslapių rūšiuotuvas 

Puslapių rūšiuotuvas rodo visus puslapius atidarytame faile miniatiūros formatu ir automatiškai 

atnaujina šias miniatiūras, kai keičiate puslapių turinį. 

 
Naudodami puslapių rūšiuotuvą galite: 

 
l  Iškirpti, kopijuoti ir įklijuoti puslapius 

 

l  Rodyti puslapius 
 

l  Kurti puslapius 
 

l  Klonuoti puslapius 
 

l  Valyti puslapius 
 

l  Ištrinti puslapius 
 

l  Pervadinti puslapius 
 

l  Pertvarkyti puslapius 
 

l  Perkelti objektus iš vieno puslapio į kitą 
 

l  Grupuoti puslapius 
 

 

Norėdami atidaryti puslapių rūšiuotuvą, spauskite Page Sorter . 
 

 
Galite perkelti puslapių rūšiuotuvą iš vienos SMART Notebook programinės įrangos lango pusės į kitą 

paspaudę Move Sidebar . 

 
Galite pakeisti puslapių rūšiuotuvo dydį vilkdami jo kairį ar dešinį kraštą. Taip pat galite paslėpti puslapių 

rūšiuotuvą, kai jo nenaudojate, pasirinkę Auto-hide pasirinktį. Norint vėl rodyti puslapių rūšiuotuvą, 

spauskite Page Sorter . 
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PASTABA 
 

Windows operacinei sistemai: jei sumažinsite puslapių rūšiuotuvą iki jo mažiausio dydžio, įsijungs 

automatinio paslėpimo funkcija. 
 
 

Galerijos skirtukas 

Galerijos skirtukas yra iliustracijos, fonai, multimedijos, failai ir puslapiai, kuriuos galite naudoti savo 

pamokose. Galerijos skirtukas taip pat suteikia prieigą prie kitų internetinių šaltinių. Daugiau 

informacijos pateikta „Turinio įterpimas iš galerijos“ 82 puslapyje. 

 
Taip pat galite pridėti savo ir kitų mokytojų turinį į galerijos skirtuką. Norint 

atidaryti galerijos skirtuką, spauskite Gallery  . 

Galite perkelti galerijos skirtuką iš vienos SMART Notebook programinės įrangos lango pusės į kitą paspaudę 
Move Sidebar . 

 

 
Galite pakeisti galerijos skirtuką vilkdami jo kairį ar dešinį kraštą. Taip pat galite paslėpti galerijos 

skirtuką, kai jo nenaudojate, pasirinkę Auto-hide pasirinktį. Norint vėl rodyti galerijos skirtuką, spauskite 

Gallery  . 

 
 

PASTABA 
 

Windows operacinei sistemai: jei sumažinsite galerijos skirtuką iki jo mažiausio dydžio, įsijungs 

automatinio paslėpimo funkcija. 
 
 

Priedų skirtukas 

Priedų skirtukas rodo failus ir internetinius puslapius, pridėtus prie naudojamo failo. 

Norint atidaryti priedų skirtuką, spauskite Attachments  . 

Galite perkelti priedų skirtuką iš vienos SMART Notebook programinės įrangos lango pusės į kitą paspaudę 

Move Sidebar . 
 

 
Galite pakeisti priedų skirtuką vilkdami jo kairį ar dešinį kraštą. Taip pat galite paslėpti priedų skirtuką, 

kai jo nenaudojate, pasirinkę Auto-hide pasirinktį. Norint vėl rodyti priedų skirtuką, spauskite 

Attachments .) 
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PASTABA 
 

Windows operacinei sistemai: jei sumažinsite priedų skirtuką iki jo mažiausio dydžio, įsijungs 

automatinio paslėpimo funkcija. 
 
 

Savybių skirtukas 

Savybių skirtukas leidžia jums tvarkyti objektus puslapyje, įtraukiant skaitmeninį rašalą, formas, linijas, 

tekstus ir lenteles.  Priklausomai nuo pasirinkto objekto, jūs galite keisti: 

 

l  Linijų spalvą, storį ir stilių 
 

l  Objektų skaidrumą ir užpildymo efektus 
 

l  Teksto šrifto tipą, dydį ir stilių 
 

l  Objektų animaciją 
 

 
Savybių skirtukas rodo tik tas pasirinktis,  kurios galimos jūsų pasirinktam objektui. Daugiau 

informacijos apie rodymą ir objekto savybių nustatymą savybių skirtuke pateikta „Objekto savybių 

keitimas“ 66 puslapyje. 

 

Norint atidaryti savybių skirtuką, spauskite Properties . 
 

 
Galite perkelti savybių skirtuką iš vienos SMART Notebook programinės įrangos lango pusės į kitą 

paspaudę Move Sidebar . 

 
Galite pakeisti savybių skirtuką vilkdami jo kairį ar dešinį kraštą. Taip pat galite paslėpti savybių skirtuką, 

kai jo nenaudojate, pasirinkę Auto-hide pasirinktį. Norint vėl rodyti savybių skirtuką, spauskite Properties 

. 
 
 

PASTABA 
 

Windows operacinei sistemai: jei sumažinsite savybių skirtuką iki jo mažiausio dydžio, įsijungs 

automatinio paslėpimo funkcija. 
 
 

Papildomų įrankių skirtukas 

Papildomų įrankių skirtukas leidžia jums dirbti su SMART Notebook programinės įrangos papildomais 

įrankiais. 
 

 

Norint atidaryti papildomų įrankių skirtuką, spauskite Add-ons . 
 

 

Galite perkelti papildomų įrankių skirtuką iš vienos SMART Notebook programinės įrangos lango pusės 

į kitą paspaudę Move Sidebar . 
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Galite pakeisti papildomų įrankių skirtuką vilkdami jo kairį ar dešinį kraštą. Taip pat galite paslėpti 

papildomų įrankių skirtuką, kai jo nenaudojate, pasirinkę Auto-hide pasirinktį. Norint vėl rodyti papildomų 

įrankių skirtuką, spauskite Add-ons . 

 
 

PASTABA 
 

Windows operacinei sistemai: jei sumažinsite papildomų įrankių skirtuką iki jo mažiausio dydžio, įsijungs 

automatinio paslėpimo funkcija. 
 
 

Puslapio sritis 

Puslapio sritis rodo faile pasirinkto puslapio turinį. Tai yra puslapio sritis, kurioje kuriate objektus ir  

dirbate su jais. 
 

 
 

Įvadas į veiklų naudojimą 
Sukurkite interaktyvią mokymosi patirtį mažiau nei per penkias minutes ir įtraukite bei nustebinkite savo 

mokinius. SMART lab yra žaidimais pagrįsta mokymosi aplinka su realaus laiko mokinių bendradarbiavimo 

įrankiais ir ugdomoje vertinimo įrankių rinkinys. 

 
Sutaupykite pamokų planavimo laiką tuo pačiu suteikdami savo mokiniams vertingą klasės patirtį. 

 

 

Vaizdo įrašas – veiklos nustatymas: Monster Quiz 
 

 
Skaitykite Monster Quiz nustatymo procedūrą „Monster Quiz naudojimas“ 142 puslapyje. Likę 

šios serijos vaizdo įrašai yra pateikti default.htm. 

Kokią veiklą turėtumėte sukurti? Pasirinkite veiklos tipą pagal savo mokymosi tikslus. 
 

1.   Pridėkite konkurencingą žaidimo elementą į gramatikos pamoką naudodami Speedup 
 

2.   Pradėkite klasės smegenų šturmą naudodami mokinių mobiliuosius įrenginius ir Shout It Out! 
 

3.   Sukurkite išėjimo bilietą naudodami response 2 ugdomąjį vertinimo įrankį 
 

4.   Sulėtinkite pamoką ir sumažinkite informacijos perkrovą naudodami Label Reveal 
 
 

Konkurencingo žaidimo elemento pridėjimas į gramatikos pamoką naudojant 

Speedup 
Tarkime, jūs suplanavote anglų kalbos gramatikos pamoką, kurios metu padėsite mokiniams mokytis apie 

kalbos dalis. Jūs norėtumėte sukurti veiklą, kuri padės mokiniams atskirti daiktavardžius, veiksmažodžius, 

būdvardžius ir prieveiksmius. Norint, kad mokiniai prisijungtų ir aktyviai dalyvautų, jūs turėsite  
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įtraukti mokinius  Speedup lenktynių žaidimą SMART Board klasėje. 
 

 
 
 

Nepriklausomai nuo temos, klasės ir įgūdžių lygio, SMART Notebook veiklos padeda užtikrinti turinio 

tinkamumą ir veiksmingumą pedagoginiu požiūriu.  SMART Notebook programinė įranga suteikia 

pritraukiančias veiklas, kurios tikrai patiks jūsų mokiniams. 

 
Dagiau informacijos pateikta Speedup veiklos pridėjimas. 

 

 
SMART lab veiklos nustatymas 

Jūs užbaigėte pamoką klasėje ir norite įvertinti, ar mokiniai suprato. Atidarykite SMART lab savo SMART 

Notebook 18 programinėje įrangoje. SMART lab Select an Activity kūrimo vedlyje pasirinkite Speedup iš 

veiklų sąrašo ir įrašykite klausimus bei atsakymus, susijusius su daiktavardžiais, veiksmažodžiais, 

būdvardžiais ir prieveiksmiais, arba pasinaudokite anksčiau išsaugotu sąrašu. Dagiau informacijos pateikta 

Speedup veiklos pridėjimas. 
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Galite lengvai valdyti SMART lab turinį ir pritaikyti jį savo veiklos reikalavimams. Žiūrėkite SMART lab 

turinio valdymas. 
 

 
Mokinių dalyvavimas 

Paprašykite mokinių suformuoti nedideles grupes, kad jie galėtų bendradarbiauti žaidimo metu. SMART 

lab greitai parengia veiklą. Galite pateikti keletą kryptingų žodžių, spauskite Start ir žaidimas prasidės. 

Mokiniai pasirinks lenktynių pseudoportretus, važiuos trasa ir atsakys į klausimus iš anksto nustatytose 

vietose. 
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Lenktynės sužadina mokinių dėmesį ir jie greitai išmoksta bendradarbiauti pateikiant teisingus 

atsakymus. Pasibaigus lenktynėms, grupėms parodomas jų greitis, teisingai atsakytų klausimų skaičius 

ir jų pseudoportretų vieta. 

 
Rezultatai 

Peržiūrėkite viktorinos atsakymus kartu su klase naudodami pseudoportretus iš kiekvienos grupės. Po 

lenktynių, spauskite Review, kad pamatytumėte klausimus, jų galimus atsakymus ir žaidėjų 

pseudoportretus.  Spauskite Show Answer, kad pamatytumėte atsakymą į kiekvieną klausimą. Vertingas 

mokymasis taip pat vyksta aptariant neteisingus atsakymus. 
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Jei norite, galite duoti papildomo darbo mokiniams klasėje. Kol jie atliks tą darbą, galite panaudoti šį 

laiką ir sukurti kitą veiklą, kuri papildytų ankstesnę veiklą. 

 

 

Klasės smegenų šturmo pradėjimas naudojant mokinių mobiliuosius 

įrenginius ir Shout It Out! 
Shout It Out! yra mobiliaisiais įrenginiais pagrįsta veikla, kurios metu mokiniai gali naudotis savo 

įrenginiais ar mokyklos suteiktais įrenginiais ir prisidėti prie bendraklasių ar mokytojų prižiūrimų 

diskusijų. Mokytojas gali rinktis tarp į kategorijas suskirstytų išdėstymų, kai mokinai papildo mokytojų 

sukurtas kategorijas, ar atsitiktinių išdėstymų, kai mokinių papildymai yra paskirstomi atsitiktine tvarka. 

Tuomet papildymai gali būti perkelti į SMART Board veiklos puslapį ir, jei norima, suskirstomi į grupes. 

Daugiau informacijos pateikta Shout It Out! pridėjimas. 
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Veikla grindžiama pamoka 

SMART Notebook 18 programinėje įrangoje atsidarykite SMART lab ir pasirinkite Shout It Out! iš veiklų 

sąrašo. Tuomet pasirinkite Randomized ar Categories priklausomai nuo jūsų reikalaujamų papildymų ir 

jūsų skatinamo dialogo. Pasirinkite didžiausią galimą mokinių papildymų skaičių ir, ar norite, kad 

pildytojų vardai būtų rodomi SMART Board. Jūs nustatote, kiek tekstinių atsakymų mokiniai gali pridėti 

vienos veiklos metu. Mokiniai gali pridėti iki 50 paveiksliukų vienos veiklos metu. Taip pat galima 

naudoti žaidimų elementus su Shout It Out! veikla. SMART lab greitai parengia veiklą ir jūs galite pradėti. 

 
Shout It Out! veiklos nustatymas 

Jei pasirinkote Randomized mokinių papildymų paskirstymą, jūsų bus paprašyta pasirinkti priimamų 

mokinių papildymų tipą – tekstą arba paveiksliukus. Jei pasirinkote Categories mokinių papildymų 

paskirstymui, šiai veiklai reikia bent dviejų kategorijų. 

 
Categories mokinių papildymų paskirstymui, pavadinkite kategorijas, kuriose bus talpinami mokinių 

papildymai. Contributions dalyje pasirinkite Text ar Images pagal mokinių papildymų tipą. 

 
Mokinių dalyvavimas 

Tarkime, norite surinkti klasės komentarus prieš ir už dabartinio politinio kandidato pasisakymus. Galite 

paslėpti pildytojų vardus, kad paskatintumėte dalyvavimą šioje veikloje. Perjunkite Student names 

nustatymus į Show ar Hide pagal poreikį. Jei mokiniai aptaria savo atsakymus prieš jų įrašymą, jūs taip pat 

galite nustatyti papildymų skaičių vienam mobiliam įrenginiui. 
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Paprašykite mokinių eiti į classlab.com savo įrenginiuose, įvesti veiklos numerį ir pasiruošti atsakyti į 

klausimus. Veikla ir veiklos numeris atsiras SMART Board, o mokytojas nustatys pradžios laiką. 

 
Pastebėsite, kad papildymai atsiranda labai greitai, skatindami dar daugiau papildymų, bendraklasių 

bendradarbiavimą ir diskusijas. 

 
Norint sustabdyti veiklą dėl papildomų diskusijų ar klasės valdymo, spauskite Pause contributions. 

Visuose įrenginiuose atsiras veiklos sustabdymo įspėjimas. Kai norėsite tęsti, spauskite Resume ir 

mokiniai vėl galės teikti pildymus. Užbaigus veiklą, spauskite End. Visuose įrenginiuose atsiras veiklos 

užbaigimo įspėjimas. 

 
Rezultatai 

Panaudokite klasės ar mažos grupės papildymų rezultatus kaip pradinį tašką diskusijai. Mokiniai greitai 

pastebės, kad skirtingos nuomonės gali būti vertingos ir kad bendraklasiai gali turėti įžvalgų, kurių jie 

galbūt neturėjo. 

 

 

Išėjimo bilieto sukūrimas naudojant SMART response 2 
Išėjimo bilietas yra puikus būdas mokiniams peržiūrėti ir pritaikyti pamokoje įgytas žinias. Galite naudoti 

įvairius metodus. Šis pavyzdys demonstruoja, kaip galite panaudoti SMART response 2 greitai sukurti 

išėjimo bilietą. 
 

 

Daugiau informacijos apie  SMART response 2 versijos įvertinimo platformą pateikta SMART 

response 2 naudojimas. 

 
Veikla grindžiama pamoka 

Šiame pavyzdyje, mokytojas paprašys mokinių atsakyti į viktorinos su įvairiais variantais klausimus 

naudojant SMART response 2. Mokytojas naudos viktoriną kaip klasės išėjimo bilietą, kuris padės įvertinti 

mokinių supratimą prieš paliekant klasę. Mokiniai pateiks savo atsakymus naudodami jų pačių ar mokyklos 

suteiktus mobiliuosius įrenginius  

 
SMART lab veiklos nustatymas 

Atidarykite SMART response 2 SMART Notebook 18 programinėje įrangoje ir greitai įrašykite kelis 

klausimus be atsakymų variantų. Tiesiog greitai įrašykite; vėliau galėsite koreguoti. 

 
Įrašė visus klausimus, pasirinkite Edit ir pakoreguokite klausimus, tuomet spauskite Next. Galite 

peržiūrėti savo turinį ir klausimus Review Content dialogo lange. 

 
Spauskite Finish. SMART response 2 paruošia veiklą per kelias sekundes. Paprašykite mokinių eiti į 

classlab.com savo įrenginiuose, įvesti veiklos numerį ir pasiruošti atsakyti į klausimus. Veikla ir veiklos 

numeris atsiras SMART Board. Mokytojas nustatys pradžios laiką. Viktorinos klausimų pavyzdys: 
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Mokinių dalyvavimas 

Kai veikla bus paruošta, spauskite Start Activity. Mokiniai gali pradėti atsakinėti į viktorinos klausimus 

savo įrenginiuose. Žiūrėkite Mobilaus įrenginio naudojimas prieigai prie SMART response 2. Jei reikia, 

galite sustabdyti viktoriną. Rodoma rezultatų animacija nurodo klasės atsakytų klausimų procentą. Kai visi 

mokiniai pateiks atsakymus, sustabdykite arba užbaikite veiklą. Jei užbaigsite veiklą, visi mokiniai gaus 

įspėjimą į jų mobiliuosius įrenginius, o viktorinos rezultatai atsiras SMART Board. 
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Rezultatai 

Mokiniams pateikus atsakymus ir gavus rezultatus, prasidės rezultatų įvertinimas. Rodomas kiekvienas 

klausimas ir jūs galite pasirinkti juostinę ar skritulinę diagramą nurodyti į klausimą atsakiusių mokinių 

skaičių. 
 

 
 

 
Rezultatų dialogo langelis suteikia mokytojui ir klasei galimybę peržiūrėti klausimus ir patikrinti mokinių 

supratimą. Mokytojas gali įvertinti mokinių supratimą iš karto ir, jei būtina, koreguoti pamoką. 

 

 

Pamokos sulėtinimas ir informacijos perkrovos sumažinimas naudojant 

Label Reveal 
Label Reveal padeda mokiniams nustatyti visumos dalis, o jums patikrinti savo žinias ir pamokos plano 

progresą. Galite pridėti paveiksliuką, paspausti ant jo ir pridėti bet kokį kiekį žymų bei pradėti! 
 

 

Šiame pavyzdyje, jūs įvertinsite mokinių supratimą apie terminus, naudojamus kalbant apie žmogaus 

ląstelę, iš praėjusios pamokos. Naudokite Label Reveal veiklą sulėtinti pamokos planą ir patikrinti 

supratimą, tuomet įvertinkite su SMART response 2. Mokiniai gali dalyvauti po vieną su bendraklasių 

pagalba arba mažomis mokinių grupėmis, kad komandos nariai kartu rastų atsakymus. 

 
Daugiau informacijos apie Label Reveal pateikta „Label Reveal veiklos pridėjimas“. 

 

 
SMART lab veiklos nustatymas 

Užbaikite Label Reveal veiklą už klasės ribų, jei turite pakankamai laiko. Atidarykite SMART lab Label 

Reveal veiklą. Toliau, vilkite ir įkelkite paveiksliuką, kurį norite panaudoti, į langelį Add Content puslapyje 

arba suraskite paveiksliuką pasirinkę Browse for an image 
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. paveiksliukas atsiras veikloje. 
 

 
Dabar vilkite ir įkelkite kiek norite žymų ant paveiksliuko. Atsiras žymų dialogo langelis, kuriame galėsite 

pridėti ar redaguoti paveiksliuko žymą ir pridėti aprašymą iki 150 ženklų. Taip pat galite pakeisti 

paveiksliuką ar rodyklės spalvą šiame puslapyje. 

 
Pabaigę žymų pridėjimą, spauskite Finish. SMART lab paruoš veiklą per kelias sekundes ir jūs galėsite 

greitai panaudoti šią veiklą klasėje: naudokite žaidimų elementus, kad pagyvintumėte įvairius atradimus, 

paveiksliuko diskusiją ir žymų atidengimus. 
 

 
 
 

Mokinių dalyvavimas 

Klasėje, atidarykite Label Reveal veiklą. Jei nusprendėte naudoti laikmačius ar garsinį mygtuką, paprašykite 

dviejų ar trijų nedidelių mokinių grupių prieiti prie SMART Board ir įvardinti ląstelės dalis. Po kiekvieno 

įvardijimo, mokiniai gali nuspausti garsinį mygtuką, parodydami, kad pasirinko, tuomet jie gali pasižiūrėti, 

kiek laiko užtruko jo įvardijimas. Mokiniams patiks lenktyniauti vienas su kitu, siekiant greitai užbaigti 

veiklą. 

 
Kaip alternatyvą, galite paprašyti mokinių po vieną prieiti SMART Board ir atskleisti žymas, taip pat galite 

paprašyti kitų mokinių padėti pasakant užuominas, jei mokiniui reikia pagalbos. 

 
Užbaigus Label Reveal veiklą, pasinaudokite SMART response 2 įvertinimo platforma ir įvertinkite 

mokinių žinias. 

 
SMART response 2, naudokite įvairių tokias pačias pagrindines dalis turinčių ląstelių dalis. Mokinių 

supratimas paveiks ankstesnę diskusiją, kurią sukėlė Label Reveal veikla. 

 
Kai būsite pasiruošę, spauskite Start Activity ir mokiniai galės pradėti atsakinėti į viktorinos klausimus. Jei 

reikia, galite sustabdyti viktoriną. 
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Rezultatai 

Naudokite SMART response 2 įvertinti mokinių supratimą. Rodoma rezultatų animacija nurodo klasės 

atsakytų klausimų procentą. Panaudokite viktorinos rezultatus nustatyti, ar reikalinga papildoma pamoka 

arba individualios instrukcijos. 
 

 
 
 
 

Panaikinimo ir atkūrimo veiksmai 
Kai atliekate failo pakeitimus, jūs galite panaikinti savo ankstesnius veiksmus ir komandas. 

 
 

PASTABA 
 

Jei du žmonės naudoja interaktyvų produktą, paspaudus Undo ir Redo veikiami abiejų naudotojų 

veiksmai. 
 
 
 

Paskutinio veiksmo panaikinimas 
 

Spauskite Undo  . 

 
PASTABA 

 

Galite panaikinti neribotą kiekį veiksmų. 
 

 
 

Paskutinio veiksmo, panaikinto su Undo komanda, atkūrimas 
 

Spauskite Redo  . 
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SMART Notebook programinėje įrangoje galite kurti ar atidaryti SMART Notebook programinės įrangos 

(.notebook) failus. Sukūrę ar atidarę .notebook failą, galite jį išsaugoti, atspausdinti ir užbaigti kitas 

užduotis. 

.notebook failą sudaro eilė puslapių su savo objektais ir savybėmis. Kiekvieno puslapio miniatiūra 

atsiranda puslapių rūšiuotuve. Naudodami puslapių rūšiuotuvą arba meniu komandas, galite rodyti 

esamą puslapį, sukurti tuščią puslapį, sukurti esamo puslapio kloną ar panaikinti puslapį. 
 

 
 

Failų kūrimas 
Kai įjungiate SMART Notebook programinę įrangą pirmą kartą, automatiškai atsiranda pradinis 

ekranas. Kitą kartą įjungus programinę įrangą, automatiškas atsidarys naujas .notebook failas. 

Tačiau, jūs galite sukurti naują failą bet kuriuo metu. 
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Failo kūrimas 

 

 

 

Pasirinkite File > New. 
 

Jei dirbate su failu, kurio pakeitimai nėra išsaugoti, atsiras dialogo langelis ir paprašys jūsų 

išsaugoti failą. Spauskite Yes, kad išsaugotumėte pakeitimus ir tuomet sekite ekrane rodomas 

instrukcijas. 

 
 

 

Failų atidarymas 
SMART Notebook 18 atidaro ir išsaugo jūsų failus .notebook formatu, kuris taip pat yra numatytas 

failų SMART Notebook 9.5 - 16 formatas. 

 
Failo atidarymo metodas yra toks pats visoms SMART Notebook programinės įrangos variantams. 

 
 

Failo atidarymas 

1.   Spauskite Open File . 
 

Atsiras dialogo langelis. 
 

2.   Pasirinkite failą. 
 

3.   Spauskite Open. 

 
PATARIMAS 

 

Galite atidaryti neseniai atidarytą failą nuėję į File meniu ir pasirinkę failą (Windows operacinėms 

sistemoms) ar File > Open Recent (OS X operacinėms sistemoms). 
 
 
 

 

Puslapių rodymas faile 
Galite rodyti bet kurį puslapį faile naudodami puslapių rūšiuotuvą. Galite rodyti kitą ar ankstesnį puslapį 

faile naudodami mygtukus ar gestus. 
 
 

Puslapio rodymas 
 

1.   Jei puslapių rūšiuotuvas nėra matomas, spauskite Page Sorter . 
 

2.   Spauskite norimo rodyti puslapio miniatiūrą. 
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Kito puslapio rodymas faile 
 

Spauskite Next Page  . ARBA 

Braukite pirštais per puslapį iš dešinės į kairę. 
 

 
 
 
 
 
 
 
 
 
 
 
 

Atsiras žinutė, rodanti dabartinio puslapio numerį. 
 

 
 

 
 

Ankstesnio puslapio rodymas faile 
 

Spauskite Previous Page  . ARBA 

 Braukite pirštais per puslapį iš kairės į dešinę. 
 

 
 
 
 
 
 
 
 
 
 
 
 

Atsiras žinutė, rodanti dabartinio puslapio numerį. 
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Puslapių kūrimas 
Galite pridėti tuščią puslapį į atidarytą failą naudodami puslapio pridėjimo mygtuką ar puslapių 

rūšiuotuvą. 
 
 

Puslapio pridėjimas naudojant puslapio pridėjimo mygtuką 
 

Spauskite Add Page  . 
 

Naujas puslapis atsiras po esamo puslapio. 
 
 

Puslapio pridėjimas naudojant puslapio rūšiuotuvą 
 

1.   Jei puslapių rūšiuotuvas nėra matomas, spauskite Page Sorter . 
 

2.   Pasirinkite puslapio, po kurio turėtų atsirasti naujas puslapis miniatiūrą.  
 

3.   Spauskite miniatiūros meniu rodyklę, tuomet pasirinkite Insert Blank Page. 
 

Naujas puslapis atsiras po pasirinkto puslapio. 
 

 
 
 

Puslapių klonavimas 
 

Kaip alternatyvą tuščio puslapio sukūrimui, galite sukurti esamo puslapio kopiją (arba kloną). 
 
 

PASTABA 
 

Galite klonuoti puslapį, tik jei jame yra koks nors turinys. 
 

 
 

Puslapio klonavimas 
 

1.   Jei puslapių rūšiuotuvas nėra matomas, spauskite Page Sorter . 
 

2.   Pasirinkite norimo klonuoti puslapio miniatiūrą. 
 

3.   Spauskite miniatiūros meniu rodyklę, tuomet pasirinkite Clone Page. 
 

Klonuotas puslapis atsiras po esamo puslapio. 

 
PASTABA 

 

Galite kartoti šį procesą tiek kartų, kiek norite. 
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Puslapių pervadinimas, pertvarkymas ir grupavimas 
Kai sukuriate puslapį, SMART Notebook programinė įranga automatiškai pavadiną puslapį jo sukūrimo data 

ir laiku. Taip pat galite pertvarkyti ir grupuoti puslapius. 

 
 

Puslapių pervadinimas 
 

1.  Jei puslapių rūšiuotuvas nėra matomas, spauskite Page Sorter . 
 

2.   Du kartus paspauskite ant puslapio pavadinimo. 
 

3.   Įrašykite naują puslapio pavadinimą. 
 

4.   Paspauskite bet kurioje kitoje vietoje. 
 
 

Puslapių pertvarkymas 
 

1.   Jei puslapių rūšiuotuvas nėra matomas, spauskite Page Sorter . 
 

2.   Spauskite faile norimo perkelti puslapio miniatiūrą. 
 

Miniatiūros kraštai taps mėlyni. 
 

3.   Vilkite miniatiūrą į jos naują vietą puslapių rūšiuotuve. 
 

Mėlyna linija parodo naują puslapio vietą. 
 

4.   Paleiskite miniatiūrą. 
 
 

Grupės kūrimas (Windows) 
 

1.   Jei puslapių rūšiuotuvas nėra matomas, spauskite Page Sorter .  
 

Numatyta, kad visi puslapiai Notebook faile jau yra „Group 1“ pavadintos grupės dalis. Galite 

pervadinti „Group 1“ įrašydami naują pavadinimą. 
 

2.   Norint pridėti antrą grupę, spauskite pirmos grupės meniu rodyklę, tuomet pasirinkite Add New 

Group. 
 

Antra grupė su nauju, tuščiu puslapiu atsiras po pirmąja. 
 

3.   Įrašykite antros grupės pavadinimą. 
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PASTABA (MAC) 

 

Jei naudojate SMART Notebook programinę įrangą Mac kompiuteryje, procedūra šiek tiek skiriasi. 

Vietoje Add New Group pasirinkimo iš numatytos grupės meniu rodyklės, pasirinkite Edit Page Groups. 

Bus rodomos esančios grupės puslapio srityje, kur jūs galėsite jas kurti, pervadinti, perkelti ar panaikinti. 

Kitos keturios procedūros taip pat yra veikiamos šio skirtumo. Naudojant Mac, jūs pasirenkate Edit 

Page Groups funkciją rodyti grupes puslapio srityje redagavimui, o ne jų redagavimui tiesiogiai 

puslapio rūšiuotuve. 
 

 
 

Puslapių perkėlimas grupėse ar tarp jų (Windows) 
 

 
Vilkite puslapio miniatiūrą į naują vietą grupėje ar į kitą grupę. 

 
 

Grupės perkėlimas (Windows) 
 

 
Vilkite grupės pavadinimo juostą į naują grupės vietą. 

 
 

PASTABOS 
 

l  Jūs taip pat galite pertvarkyti grupes paspaudę grupės meniu rodyklę ir pasirinkę Move Up arba Move 

Down. 
 

l  SMART Notebook programinė įranga numeruoja puslapius iš eilės visame faile. Jei pakeisite 

grupių tvarką, SMART Notebook programinė įranga atitinkamai iš naujo sunumeruos puslapius 

grupėse 
 

 
 

Grupės panaikinimas ir jos puslapių išsaugojimas (Windows) 

 

Perkelkite grupės puslapius į  kitą grupę. Kai grupėje nebeliks puslapių, SMART Notebook 

programinė įranga ištrins ją automatiškai. 
 
 

Grupės ir visų puslapių grupėje panaikinimas (Windows) 
 

 
Spauskite grupės meniu rodyklę ir pasirinkite Delete Group. 

http://www.smarttech.com/kb/171309


27 smarttech.com/kb/171309 

2 SKYRIUS 

FAILŲ IR PUSLAPIŲ KŪRIMAS IR DARBAS SU JAIS 

 

 

 

 
 
 

Puslapių panaikinimas 
Galite ištrinti puslapį iš esamo failo pasirinkę puslapio panaikinimo mygtuką ar puslapių rūšiuotuvą. 

 
 

PATARIMAS 
 

Kaip alternatyvą puslapių panaikinimui, galite išvalyti visus jo objektus (žiūrėkite „Puslapių 

išvalymas“ 167 puslapyje). 
 

 
 

Puslapio panaikinimas naudojant puslapio panaikinimo mygtuką 
 

1.   Jei to dar nepadarėte, pasirinkite rodyti norimą panaikinti puslapį. 
 

2.   Pasirinkite Delete Page  . 
 

 

Puslapio panaikinimas naudojant puslapių rūšiuotuvą 
 

1.   Jei puslapių rūšiuotuvas nėra matomas, spauskite Page Sorter . 
 

2.   Pasirinkite norimo panaikinti puslapio miniatiūrą. 
 

3.   Spauskite miniatiūros meniu rodyklę, tuomet pasirinkite Delete Page. 
 

 
 
 

Failų išsaugojimas 
SMART Notebook 18 atidaro ir išsaugo jūsų failus .notebook formatu, kuris taip pat yra numatytas failų 

SMART Notebook 9.5 - 16 formatas. 
 
 

Naujo failo išsaugojimas 
 

1.   Spauskite Save  . 
 

Atsiras Save As dialogo langelis. 
 

2.   Pasirinkite, kur norite išsaugoti naują failą. 
 

3.   Įrašykite failo pavadinimą File name langelyje. 
 

4.   Spauskite Save. 
 
 

Egzistuojančio failo išsaugojimas 
 

Spauskite Save  . 
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Egzistuojančio failo išsaugojimas nauju pavadinimu ar naujoje vietoje 
 

1.   Pasirinkite File > Save As. 
 

Atsiras Save As dialogo langelis. 
 

2.   Pasirinkite, kur norite išsaugoti naują failą. 
 

3.   Įrašykite failo pavadinimą File name langelyje. 
 

4.   Spauskite Save. 
 
 

Automatiškas failų išsaugojimas (Windows) 
 

1.   Pasirinkite File > Timed Saves. 
 

Atsiras Timed Save vedlys. 
 

2.   Pasirinkite Every time I move to a different page išsaugoti failą automatiškai  kiekvieną kartą 

pasirinkus kitą puslapį. 
 

ARBA 
 

Pasirinkite 1 minute, 5 minutes, 15 minutes arba 30 minutes išsaugoti failą automatiškai po 

nustatyto laiko tarpo. 
 

3.   Spauskite Next. 
 

4.   Pasirinkite Notebook Document. 
 

5.   Spauskite Next. 
 

Atsiras Save As dialogo langelis. 
 

6.   Pasirinkite, kur norite išsaugoti naują failą. 
 

7.  Įrašykite failo pavadinimą File name langelyje. SMART Notebook programinė įranga automatiškai 

išsaugos failą .notebook failo plėtiniu. 
 

8.   Spauskite Save. 
 

 
 
 

Failų spausdinimas 
Galite atspausdinti visus puslapius arba pasirinkti puslapius .notebook faile. Galite spausdinti failus kaip 

miniatiūras, dalomąją medžiagą ar pilnus puslapius. 
 
 

Failo spausdinimas naudojant Windows operacinę sistemą 
 

1.   Pasirinkite File > Print. 
 

Atsiras spausdinimo dialogo langelis. 
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2.   Spauskite Thumbnails, Handouts ar Full Page. 
 

3.   Pasirinktinai, įrašykite antraštę Header langelyje, poraštę Footer langelyje ir datą Date langelyje. 
 

4.   Pasirinktinai, pažymėkite Show page numbers langelį, kad būtų rodomas kiekvieno puslapio numeris. 
 

5.   Jei 2 žingsnyje paspaudėte Thumbnails ar Handouts, pasirinkite miniatiūros dydį Thumbnail size 

išplečiamame sąraše ir, pasirinktinai, pažymėkite Page borders langelį, kad būtų rodomi 

kiekvienos miniatiūros kraštai ir Thumbnail titles langelį, kad būtų rodomas pavadinimas po 

kiekviena miniatiūra. 
 

6.   Pasirinkite All, kad būtų įtraukti visi puslapiai. 
 

ARBA 
 

Pasirinkite Pages norint įtraukti pasirinktus puslapius, tuomet įrašykite puslapio numerį langelyje. 

Atskirkite individualius puslapių numerius kableliais, o atskirus puslapių intervalus brūkšniais 

(pavyzdžiui, 1,2,4-7). 

 

7.  Spauskite Printer Setup skirtuką. 
 

8.   Patikrinkite kitus spausdintuvo nustatymus, spausdintuvo pavadinimą ir kopijų skaičių. 
 

9.   Spauskite Print. 
 
 

Failo spausdinimas naudojant OS X operacinę sistemą 
 

1.   Pasirinkite File > Print. 
 

Atsiras dialogo langelis. 
 

2.   Spauskite Thumbnails, Handouts ar Full Page. 
 

3.   Pasirinktinai, įrašykite antraštę Header langelyje, poraštę Footer langelyje ir datą Date langelyje. 
 

4.   Pasirinktinai, pažymėkite Show page borders langelį, kad būtų rodomi kiekvieno spausdinamo 

puslapio kraštai. 
 

5.   Pasirinktinai, pažymėkite Show page numbers langelį, kad būtų rodomas kiekvieno puslapio numeris. 
 

6.   Jei 2 žingsnyje paspaudėte Thumbnails ar Handouts, pasirinkite miniatiūros dydį Thumbnail size 

išplečiamame sąraše ir, pasirinktinai, pažymėkite Thumbnail titles langelį, kad būtų rodomas 

pavadinimas po kiekviena miniatiūra. 
 

7.  Spauskite Continue. 
 

Atsiras dialogo langelis. 
 

8.   Jei visi spausdinimo pasirinkimai nėra matomi, spauskite trikampio mygtuką šalia spausdintuvo 

išplečiamo sąrašo. 
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9.   Pasirinkite All, kad būtų įtraukti visi puslapiai. 
 

ARBA 
 

Pasirinkite From norint įtraukti pasirinktus puslapius, tuomet įrašykite puslapių intervalą. 
 

10.   Patikrinkite kitus spausdintuvo nustatymus, spausdintuvo pavadinimą ir kopijų skaičių. 
 

11.   Spauskite Print. 
 

 
 
 

Failų eksportavimas 
Galite eksportuoti .notebook failus šiais formatais: 

 
l  Internetiniais puslapiais 

 

l  Paveiksliukų formatais 
 

o    BMP 
 

o    GIF (Windows operacinėms sistemoms) 
 

o    JPEG 
 

o    PNG 
 

o    TIFF (OS X operacinėms sistemoms) 
 

l  PowerPoint® (Windows operacinėms sistemoms) 
 

l  PDF 
 

l  Interaktyvios lentos bendrojo failo formatu (CFF) 
 
 

PASTABOS 
 

Naudojant OS X operacinę sistemą, atkreipkite dėmesį: 
 

l  SMART Notebook programinė įranga neįtraukia priedų, kai jūs eksportuojate failus kaip 

paveiksliukus (Windows operacinėse sistemose). Norint įtraukti priedus, jūs turite eksportuoti 

failą kaip internetinį puslapį arba PDF (Adobe® Reader® 8.0 ar naujesnį). 
 

l  SMART Notebook  programinė įranga neįtraukia nuorodų, kai jūs eksportuojate failus kaip 

internetinius puslapius, paveiksliukus ar PDF. SMART Notebook programinė įranga neįtraukia 

priedų, kai jūs eksportuojate failus kaip paveiksliukus ar PDF. Norint įtraukti priedus, jūs turite 

eksportuoti failą kaip internetinį puslapį. 
 

l  SMART Notebook  programinė įranga neeksportuoja failų, kuriuos pridedate prie .notebook failų 

kaip šaukinius. Jei norite įtraukti priedą, prikabinkite failo kopiją. 
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l  SMART Notebook  programinė įranga neeksportuoja failų, kuriuos pridedate prie .notebook failų 

alternatyviu pavadinimu. Jei norite įtraukti priedą, prikabinkite failo kopiją. 
 

l  SMART Notebook  programinė įranga neeksportuoja kai kurių gradientų, rašto ir paveiksliukų efektų. 

Šie efektai gali būti pakeisti į vientisą užpildą ar atrodyti neteisingai eksportuotame faile. 
 

 
 

Failo eksportavimas į internetinį puslapį 
 

1.   Pasirinkite File > Export As > Web Page. 
 

Atsiras dialogo langelis. 
 

2.   Pasirinkite, kur norite eksportuoti failą. 
 

3.   Įrašykite failo pavadinimą File name langelyje. 
 

4.   Įrašykite failo pavadinimą Save As langelyje. 
 

5.   Spauskite Save. 
 
 

Failo eksportavimas į paveiksliuką 
 

1.   Pasirinkite File > Export As > Image Files. 
 

Atsiras dialogo langelis. 
 

2.   Pasirinkite aplanką, į kurį norite eksportuoti failus. 
 

3.   Pasirinkite paveiksliuko formatą Image Type išplečiamame sąraše. 
 

4.   Pasirinkite paveiksliuko dydį Size išplečiamame sąraše. 
 

5.   Pasirinkite paveiksliuko formatą Image Format išplečiamame sąraše. 
 

6.   Pasirinkite paveiksliuko dydį Image Size išplečiamame sąraše. 
 

7.  Įrašykite failų pavadinimą Save As langelyje. 
 

8.   Spauskite OK. 
 

9.   Spauskite Save. 
 
 

Failo eksportavimas į PowerPoint failą 
 

1.   Pasirinkite File > Export As > PowerPoint. 
 

Atsiras Save As dialogo langelis. 
 

2.   Pasirinkite, kur norite eksportuoti failą. 
 

3.   Įrašykite failo pavadinimą File name langelyje. 
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4.   Pasirinkite PowerPoint 2007 Files (*.pptx) ar PowerPoint Files (*.ppt) Save as type 

išplečiamame sąraše. 
 

5.   Spauskite Save. 
 
 

PowerPoint failo importavimas 
 

1.   Pasirinkite File > Import. 
 

Atsiras Open dialogo langelis. 
 

2.   Pasirinkite All PowerPoint Files (*.ppt;*.pptx) Files of type išplečiamame sąraše. 
 

3.   Pasirinkite norimą importuoti PowerPoint failą. 
 

4.   Spauskite Open. 
 

SMART Notebook programinė įranga prideda PowerPoint failo turinį į .notebook failą. 
 
 

Failo eksportavimas į PDF failą 
 

1.   Pasirinkite File > Export As > PDF. 
 

Atsiras Export PDF dialogo langelis. 
 

2.   Spauskite Thumbnails, Handouts ar Full Page. 
 

3.   Pasirinktinai, įrašykite antraštę Header langelyje, poraštę Footer langelyje ir datą Date langelyje. 
 

4.   Pasirinktinai, pažymėkite Show page numbers langelį, kad būtų rodomas kiekvieno puslapio numeris. 
 

5.   Jei 2 žingsnyje paspaudėte Thumbnails ar Handouts, pasirinkite miniatiūros dydį Thumbnail size 

išplečiamame sąraše ir, pasirinktinai, pažymėkite Page borders langelį, kad būtų rodomi 

kiekvienos miniatiūros kraštai ir Thumbnail titles langelį, kad būtų rodomas pavadinimas po 

kiekviena miniatiūra. 
 

6.   Pasirinkite All, kad būtų įtraukti visi puslapiai. 
 

ARBA 
 

Pasirinkite Pages norint įtraukti pasirinktus puslapius, tuomet įrašykite puslapio numerį langelyje. 

Atskirkite individualius puslapių numerius kableliais, o atskirus puslapių intervalus brūkšniais 

(pavyzdžiui, 1,2,4-7). 
 

7.  Spauskite Save. 
 

Atsiras Save as PDF File dialogo langelis. 
 

8.   Pasirinkite, kur norite eksportuoti failą. 
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9.   Įrašykite failo pavadinimą File name langelyje. 
 

10.   Spauskite Save. 
 
 

Failo eksportavimas į PDF failą 
 

1.   Pasirinkite File > Export As > PDF. 
 

Atsiras dialogo langelis. 
 

2.   Spauskite Thumbnails, Handouts ar Full Page. 
 

3.   Pasirinktinai, įrašykite antraštę Header langelyje, poraštę Footer langelyje ir datą Date langelyje. 
 

4.   Pasirinktinai, pažymėkite Show page borders langelį, kad būtų rodomi kiekvieno spausdinamo 

puslapio kraštai. 
 

5.   Pasirinktinai, pažymėkite Show page numbers langelį, kad būtų rodomas kiekvieno puslapio numeris. 
 

6.   Jei 2 žingsnyje paspaudėte Thumbnails ar Handouts, pasirinkite miniatiūros dydį Thumbnail size 

išplečiamame sąraše ir, pasirinktinai, pažymėkite Thumbnail titles langelį, kad būtų rodomas 

pavadinimas po kiekviena miniatiūra. 
 

7.  Spauskite Continue. 
 

Atsiras Save dialogo langelis. 
 

8.   Pasirinkite, kur norite eksportuoti failą. 
 

9.   Įrašykite failo pavadinimą Save As langelyje. 
 

10.   Spauskite Save. 
 

Failo eksportavimas į CFF failą 
 

1.   Pasirinkite File > Export As > CFF. 
 

Atsiras dialogo langelis. 
 

2.   Pasirinkite, kur norite eksportuoti failą. 
 

3.   Įrašykite failo pavadinimą File name langelyje. 
 

4.   Įrašykite failo pavadinimą Save As langelyje. 
 

5.   Spauskite Save. 
 
 

CFF failo importavimas 
 

1.   Pasirinkite File > Import. 
 

Atsiras Open dialogo langelis. 
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2.   Pasirinkite All Common File Format Files (*.iwb) Files of type išplečiamame sąraše. 
 

3.   Pasirinkite File > Import > All Common File Format Files (.IWB). 
 

Atsiras dialogo langelis. 
 

4.   Pasirinkite norimą importuoti failą. 
 

5.   Spauskite Open. 
 

Failas atsidarys. 
 

 
 
 

Failų prisegimas prie elektroninio pašto žinučių 
Galite nusiųsti savo failą kitiems prisegdami failą ar failo PDF versiją prie elektroninio pašto žinutės. 

 
 
 

PASTABA 
 

Prisegti failus prie elektroninio pašto žinučių galima tik su Windows operacinėmis sistemomis. 
 

 
 

Failo prisegimas prie elektroninio pašto žinutės 
 

Pasirinkite File > Send To > Mail Recipient. 
 

Įsijungs numatyta elektroninio pašto programa, sukurs naują žinutę ir prisegs failą prie žinutės. 

Jei jūs neišsaugojote failo, SMART Notebook programinė įranga išsaugos jį kaip laikiną failą 

pavadinimu untitled.notebook ir jūsų elektroninio pašto programa prisegs šį laikiną failą prie 

elektroninio pašto žinutės. 
 
 

Failo kaip PDF failo prisegimas prie elektroninio pašto žinutės 
 

Pasirinkite File > Send To > Mail Recipient (as PDF). 
 

Įsijungs numatyta elektroninio pašto programa, sukurs naują žinutę ir prisegs failo PDF prie žinutės. 
 

Jei jūs neišsaugojote failo, SMART Notebook programinė įranga išsaugos PDF failą kaip laikiną failą 

pavadinimu untitled.pdf ir jūsų elektroninio pašto programa prisegs šį laikiną failą prie elektroninio 

pašto žinutės. 
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Lentelės langelių padalijimas arba sujungimas  60 

Lentelių ir lentelių turinio panaikinimas   61 
 

 
 
 

Objektai yra .notebook failų turinio sudedamosios dalys. Objektas yra tiesiog puslapio elementas, kurį jūs 

sukuriate, importuojate ir vėliau su juo dirbate. 
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Rašymas, piešimas skaitmeniniu rašalu ir jo 
ištrynimas 
Skaitmeninis rašalas yra ranka užrašytas tekstas ar nupiešti objektais, kuriuos jūs kuriate naudodami 

interaktyvius ekrano rašiklius ar SMART Notebook programinės įrangos rašiklio įrankį. Rašymas ar piešimas 

skaitmeniniu rašalu leidžia jums greitai pridėti turinį į jūsų SMART Notebook programinės įrangos failus, 

failo kūrimo ar pristatymo mokiniams metu. 

 
Po to, skaitmeninį rašalą galima ištrinti. 

 
 

Rašymas, piešimas skaitmeniniu rašalu ir jo ištrynimas 
Lengviausias būdas rašyti ar piešti skaitmeniniu rašalu yra naudotis interaktyviais ekrano rašikliais. 

 

Taip pat galite kurti objektus ranka naudodami rašiklio įrankį. Rašiklio įrankis leidžia jums rašyti ar 

piešti skaitmeniniu rašalu šiais rašiklio tipais: 
 

Rašiklio tipas  Tikslas ir pavyzdys  Pastabos 
 

 
Standartinis 

 

Rašykite ir pieškite skaitmeniniu rašalu 

įvairiomis spalvomis ir linijų stiliumi. 

 

Standartinis rašiklis gali būti 

naudojamas daugeliui rašymo 

formų. 
 
 
 
 
 
 
 

 
 

Kaligrafinis 

Rašykite ir pieškite skaitmeniniu rašalu, 

kaip ir su standartiniu, bet įvairaus storio 

linijomis. 

Kaligrafinis rašiklio tipas yra 

naudingas mokant mokinius 

rašyti ranka. 

 
 
 
 
 
 
 
 

Kreidelė 

Rašykite ir pieškite kreidelės tipo rašalu. Kreidelės tipo rašiklis yra skirtas 

meniniam darbui, piešiniams ir 

spalvinimui, o ne rašymui. 

 

 
 
 

 
Žymeklis 

Pažymėkite tekstą ir kitus objektus.  Naudokite žymeklį norėdami 

paryškinti tekstą 
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Rašiklio tipas  Tikslas ir pavyzdys  Pastabos 
 

Tekstas Rašykite pastabas, kurios automatiškai 

pavirs į redaguojamą tekstą. 

 

Galite redaguoti tekstą 

nepaliesdami klaviatūros. 

 
 
 
 
 

 
Kūrybiškas 

Papildykite pristatymą 

spalvingais elementais. 

Galite kurti kūrybiškus rašiklio 

stilius (žiūrėkite „Kūrybiškų 

rašiklio stilių kūrimas“ 108 

puslapyje). 

 
 
 
 

 
 

 
Teptukas 

Rašykite ir pieškite į dažus panašiu skaitmeniniu rašalu.  

Pieštuko tipo rašiklis yra skirtas 

kūrybiniam darbui, piešiniams ir 

spalvinimui, o ne rašymui. 
 

 
 
 

 
Magiškas 

Rašykite ir pieškite skaitmeniniu rašalu, 

kuris po kelių sekundžių išnyksta. 

Galite naudoti magišką rašiklį 

didinimo lango ar paieškos lango 

atidarymui (žiūrėkite „Magiško 

rašiklio naudojimas“ 159 puslapyje). 

 

 
Figūros 

atpažinimas 

 

Pieškite įvairias figūras skaitmeniniu rašalu. Galite piešti apskritimus, ovalus, 

kvadratus, stačiakampius, 

trikampius ir lankus (žiūrėkite 

„Figūrų kūrimas su figūrų 

atpažinimo rašikliu“ 41 puslapyje). 
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Rašymas ir piešimas skaitmeniniu rašalu 
 

1.   Spauskite ant Pens . 
 

Atsiras rašiklių mygtukai. 
 

 
 

2.   Spauskite Pen Types ir pasirinkite rašiklio tipą. 
 

3.   Pasirinkite linijos tipą. 
 

4.   Pasirinktinai, sukurkite linijos tipą naudodami pasirinktis. 

 
PASTABA 

 

Jūs taip pat galite kurti linijos tipus naudodami savybių juostą (žiūrėkite „Objektų savybių 

keitimas“ 66 puslapyje). 

 
5.   Rašymas ir piešimas skaitmeniniu rašalu puslapyje. 

 
PATARIMAI 

 
o    Nesiremkite alkūne ar delnu į interaktyvaus produkto paviršių rašydami ar piešdami. 

 

o    Jei rašysite ar piešite keliomis eilutėmis, SMART Notebook programinė įranga automatiškai 

sujungs  linijas į vieną objektą. Pavyzdžiui, jei rašysite raides, SMART Notebook programinė 

įranga sujungs atskiras raides ir leis valdyti visą žodį. Jei norite rašyti žodžius toje pačioje 

linijoje, bet nenorite jų sujungti, palikite tarp jų didelį tarpą, naudokite skirtingus rašiklius ar 

trumpai padėkite rašiklį į rašiklio dėklą prieš rašydami kitą žodį (tik interaktyvioms lentoms). 
 

o    Jei norite rašyti įstrižai, rašykite tiesia linija ir tuomet pasukite užrašytą tekstą. 
 

o    Jei norite rašyti mažomis raidėmis, rašykite didelėmis, o tuomet sumažinkite jų dydį. 
 

o    Galite užpildyti sritis, kurias apibrėžėte skaitmeniniu rašalu. 

http://www.smarttech.com/kb/171309


39 smarttech.com/kb/171309 

3 SKYRIUS 

PAGRINDINIŲ OBJEKTŲ KŪRIMAS 

 

 

 

 
 

Skaitmeninio rašalo ištrynimas 
Galite ištrinti skaitmeninį rašalą iš interaktyvaus ekrano naudodami trintuką ar trynimo gestą. Jei trinate 

skaitmeninį rašalą iš .notebook failo puslapio, taip pat galite ištrinti objektus naudodami trintuko įrankį. 

 
 

PASTABA 
 

Nors galite ištrinti skaitmeninį rašalą trintuku, taip negalima ištrinti kito tipo objektų, pavyzdžiui 

figūrų, linijų, teksto ir paveiksliukų. Norint ištrinti šio tipo objektus, reikia juos panaikinti. 
 

 
 

Skaitmeninio rašalo ištrynimas 
 

1.   Spauskite Eraser , tuomet pasirinkite trintuko tipą. 
 

2.   Ištrinkite skaitmeninį rašalą. 
 
 
 

Figūrų ir linijų kūrimas ir darbas su jomis 
Be figūrų ir linijų piešimo skaitmeniniu rašalu ranka, jūs galite kurti figūras ir linijas naudodami SMART 

Notebook programinės įrangos įrankius. Jei naudojate figūras mokydami geometrijos, galite rodyti ir 

redaguoti figūros šono ilgius ir viršūnes, taip pat rodyti vidaus kampus. 

 
 

PASTABA 
 

Trintuko įrankis neištrina figūrų. Figūrą ar liniją reikia panaikinti. 
 

 
 

Figūrų kūrimas su figūrų įrankiu 
Galite naudoti figūrų įrankį ir kurti įvairias figūras, įtraukiant tikslius apskritimus, kvadratus, 

trikampius, kitas geometrines figūras, širdutes, varneles ir iksus. 

 
Į puslapį galite įterpti figūrą ir tuomet redaguoti jo savybes. Taip pat galite pasirinkti figūros kontūro 

spalvą, užpildo spalvą ir linijos storį, tuomet galite pridėti į savo puslapį. 
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Figūros kūrimas 
 

1.   Spauskite Shapes . 
 

Atsiras figūrų įrankio mygtukai. 
 

 
 

2.   Juostoje pasirinkite figūrą. 
 

ARBA 

 
Spauskite  ir tuomet pasirinkite figūrą. 

 

3.   Pasirinktinai, tinkinkite figūrą naudodami savybių pasirinkimus. 

 
PASTABA 

 

Taip pat galite sukurti figūrą naudodami savybių kortelę (žiūrėkite „Objekto savybių keitimas“ 

 66 puslapyje). 

 
4.   Kurkite figūrą paspausdami vietoje, kurioje norėtumėte įterpti figūrą, ir vilkite, kol figūra taps tokio 

dydžio, kokio norite. 

 
PATARIMAI 

 
o    Galite kurti tikslius apskritimus, kvadratus, trikampius ir kitas figūras paspausdami ir laikydami 

SHIFT, kol piešite figūrą. 
 

o    Galite pasirinkti figūrą, kol Shapes įrankis  aktyvus neperjungdami į Select  įrankį . 

Vieną kartą paspauskite ant figūros, aplink figūrą atsiras pasirinkimų stačiakampis. 

 
 

 
 

Figūrų kūrimas su daugiakampių įrankiu 
Be figūrų kūrimo naudojant figūrų įrankį, galite kurti taisyklinguosius daugiakampius su 3 - 15 šonais 

naudojant taisyklingųjų daugiakampių įrankį. 
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Figūros kūrimas su taisyklingųjų daugiakampių įrankiu 

 

 

 

 

 

 

1.   Spauskite Regular Polygons  . 
 

Atsiras taisyklingųjų daugiakampių įrankio mygtukai. 
 

 
 

2.   Pasirinkite figūrą iš įrankių juostos. 
 

ARBA 

 
 Spauskite  ir tuomet pasirinkite figūrą. 

 
PASTABA 

 

Skaičius figūroje nurodo jos šonų skaičių. 

 
3.   Pasirinktinai, tinkinkite figūrą naudodami savybių pasirinkimus. 

 
PASTABA 

 

Taip pat galite sukurti figūrą naudodami savybių kortelę. 

 
4.   Kurkite figūrą paspausdami vietoje, kurioje norėtumėte įterpti figūrą, ir vilkite, kol figūra taps tokio 

dydžio, kokio norite. 

 

 

Figūrų kūrimas su figūros atpažinimo rašiklio įrankiu 
Galite naudoti figūros atpažinimo rašiklio įrankį apskritimų, ovalų, kvadratų, stačiakampių, trikampių ir 

lankų piešimui. 
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Figūros piešimas 

 

 

 
 

 

 

1.   Spauskite Pens  . 
 

Atsiras rašiklių mygtukai. 
 

 
 

2.   Spauskite Pen Types ir pasirinkite Shape Recognition Pen. 
 

3.   Pieškite figūrą puslapyje. 
 

Jei SMART Notebook programinė įranga atpažins jūsų piešinį kaip apskritimą, ovalą, kvadratą, 

stačiakampį, trikampį ar lanką, ji pridės šią figūrą į puslapį. 
 

 
 

 
Tiesių linijų ir lankų kūrimas 

 

 
Galite naudoti linijų įrankį tiesių linijų ir lankų kūrimui. 

 

 
Galite pridėti liniją į savo puslapį ir tuomet redaguoti jos savybes. Taip pat galite tinkinti liniją ir tuomet 

pridėti ją į savo puslapį. 
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Tiesios linijos ir lanko kūrimas 

 

 

 
 

 

1.   Spauskite Lines . 
 

Atsiras linijų įrankio mygtukai. 
 

 
 

2.   Pasirinkite linijos ar lanko tipą. 
 

3.   Pasirinktinai, tinkinkite liniją ar lanką naudodami savybių pasirinkimus. 

 
PASTABA 

 

 Taip pat galite sukurti figūrą naudodami savybių kortelę (žiūrėkite „Objekto savybių keitimas“ 

 66 puslapyje). 

 
4.   Kurkite liniją paspausdami vietoje, kurioje norėtumėte įterpti liniją, ir vilkite, kol norėsite užbaigti 

liniją. 
 

 

Figūros šonų ilgio rodymas ir redagavimas 
Jūs galite rodyti figūros šonų ilgius. Jei redaguosite rodomus ilgius, SMART Notebook 

perskaičiuos ir rodys kitų šonų ilgius. 
 
 

PASTABOS 
 

l  Jei rodysite šiuos ilgius ir vėliau redaguosite figūros viršūnes (žiūrėkite „Figūros viršūnių rodymas ir 

redagavimas“), SMART Notebook matematikos įrankis atnaujins žymas ir rodys naujus šonų ilgius. 
 

l  Taip pat galite rodyti vidaus kampus (žiūrėkite „Vidaus kampų rodymas“). 
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Šonų ilgių rodymas 

1.   Pasirinkite figūrą. 

 

 

 

2.   Spauskite figūros meniu rodyklę, tuomet pasirinkite Show/Hide Side Lengths. 
 

SMART Notebook matematikos įrankis apskaičiuoja ilgius remiantis numatytais liniuotės vienetais. 

 
PASTABA 

 

Norint paslėpti šoninius ilgius, spauskite figūros meniu rodyklę, tuomet vėl pasirinkite Show/Hide 

Side Lengths. 

 
 
 

Šonų ilgių redagavimas 
 

1.   Jei dar to nepadarėte, pasirinkite rodyti šonų ilgius. 
 

2.   Du kartus paspauskite ant šoninio ilgio, kurį norite keisti. 
 

3.   Įrašykite naują ilgį. 
 

4.   Spauskite, kurioje nors kitoje puslapio vietoje. 
 

SMART Notebook matematikos įrankis perskaičiuos ir rodys kitų šonų ilgius. 
 
 

Figūros viršūnių rodymas ir redagavimas 
Galite redaguoti figūros viršūnių padėtį. Jei rodomi figūros vidaus kampai ar šonų ilgiai, SMART Notebook 

matematikos įrankis automatiškai atnaujins žymes ir rodys vidaus kampus ar šonų 

ilgius. 
 
 

Figūros viršūnių rodymas 
 

1.   Pasirinkite figūrą. 
 

2.   Spauskite figūros meniu rodyklę, tuomet pasirinkite Show/Hide Side Lengths. 
 

Raudonas apskritimas pakeis kiekvieną figūros viršūnę. 
 
 

Figūros viršūnių redagavimas 
 

1.   Jei dar to nepadarėte, pasirinkite rodyti figūros viršūnes. 
 

2.   Vilkite raudoną apskritimą, kad judintumėte tą viršūnę. 
 

3.   Pabaigus redaguoti figūros viršūnes, spauskite, kurioje nors kitoje puslapio vietoje. 
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Figūros viršūnių paslėpimas 
 

1.   Pasirinkite figūrą. 
 

2.   Spauskite figūros meniu rodyklę, tuomet vėl pasirinkite Show/Hide Side Lengths. 
 
 

Vidaus kampų rodymas 
Galite rodyti the figūros vidaus kampus. 

 
 

PASTABOS 
 

l  Jei pasirinksite rodyti šiuos kampus ir tuomet redaguosite figūros viršūnes (žiūrėkite „Figūros 

viršūnių rodymas ir redagavimas“ ankstesniame puslapyje), SMART Notebook atnaujins žymas ir 

rodys naujus vidaus kampus. 
 

l  Taip pat galite rodyti šonų kampus (žiūrėkite „Šonų ilgių rodymas“ ankstesniame puslapyje). 
 

 
 

Vidaus kampų rodymas 
 

1.   Pasirinkite figūrą. 
 

2.   Spauskite figūros meniu rodyklę, tuomet vėl pasirinkite Show/Hide Side Lengths. 

 
PASTABA 

 

Norint paslėpti vidaus kampus, spauskite figūros meniu rodyklę, tuomet vėl pasirinkite Show/Hide 

Side Lengths. 

 
 

 

Teksto kūrimas ir darbas su juo 
Galite kurti tekstą SMART Notebook programinė įrangoje šiais būdais: 

 
l  Teksto įrašymas naudojant klaviatūrą, prijungtą prie kompiuterio 

 

l  Teksto įrašymas naudojant klaviatūrą ekrane 
 

l  Teksto įrašymas ir konvertavimas naudojant programinės įrangos rašto atpažinimo funkciją 

 
Sukūrę tekstą, galite jį redaguoti, patikrinti rašybos klaidas ir keisti jo savybes, įtraukiant šrifto tipą, dydį ir 

spalvą. 
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Teksto įrašymas 
Galite įrašyti naują tekstą ar redaguokite jau įrašytą. 

 
 

Naujo teksto įrašymas 
 

1.   Jei neturite klaviatūros, paspauskite ir palaikykite SMART Board Tools   pranešimų srityje 

(Windows operacinėse sistemose) arba apatinėje juostoje (OS X operacinėse sistemose), tuomet 

pasirinkite Keyboard. 
 

2.   Spauskite Text Properties  ir pasirinkite šrifto stilių. 
 

3.   Pasirinktinai, pritaikykite šrifto stilių (žiūrėkite „Teksto formatavimas“ žemiau). 
 

4.   Paspauskite vietoje, kurioje norite įrašyti tekstą. 
 

5.   Įrašykite tekstą. 
 

6.   Užbaigę, paspauskite už teksto ribų. 
 
 

Įrašyto teksto redagavimas 
 

1.   Du kartus paspauskite ant teksto. 
 

2.   Redaguokite tekstą. 
 

3.   Užbaigę, paspauskite už teksto ribų. 
 
 

Teksto formatavimas 
Jei norite formatuoti visą tekstą teksto langelyje, pasirinkite teksto langelį. 

ARBA 

Jei norite formatuoti tik dalį teksto, du kartus paspauskite ant teksto langelio ir pasirinkite tekstą. 

 
Galite formatuoti tekstą naudodami mygtukus įrankių juostoje arba pasirinktis savybių kortelėje, arba 

formato meniu. 
 
 

PASTABA 
 

Jei savybių kortelės nesimato, spauskite Properties  , o tuomet Text Style. 
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Daugiau teksto pasirinkčių 
 

47 smarttech.com/kb/171309 

 

 

 
 

 
 

 
 

 
 

 

 
 

Lentelėje žemiau pateikiami formatavimo pakeitimai, kuriuos galite atlikti su pirmiau minėtais įrankiais: 
 

Pakeitimas  Įrankių juosta Savybių 

kortelė 

Formato 

meniu 

Ženklų, pastraipos ar objekto lygis 
 

Šrifto stiliaus keitimas Taip Taip Ne 
 

Šrifto dydžio keitimas 
 

Taip Taip Ne

PATARIMAS 
 

Norint pasirinkti šrifto dydį, kurio nėra išplečiamame 

meniu (įtraukiant šrifto dydžius su dešimtainėmis 

vertėmis, pavyzdžiui 20.5), įrašykite šrifto dydį į Font 

Size langelį įrankių juostoje. 

 

Spalvos keitimas                                                                         Taip                   Taip                   Ne 

Teksto paryškinimas, išskyrimas kursyvu ar pabraukimas              Taip                      Taip                   Taip 

Teksto išbraukimas                                                                               Taip1                     Taip                   Taip 

Teksto paaukštinimas ir pažeminimas                                                Taip2                     Taip                   Taip 
 

Pastraipos ar objekto lygis 

Lygiuotės keitimas (kairėje, dešinėje ar centre)                              Taip                  Taip                   Taip 

Eilutės atitraukimo keitimas                                                              Taip3                    Taip                   Taip 

Suženklinto ar sunumeruoto teksto kūrimas                                      Taip4                    Taip                   Taip 
 

Inicialo įterpimas 
 

 Ne  Taip Taip 

PATARIMAS 
 

Norint įterpti inicialą pastraipos pradžioje, spauskite 

Drop Cap  savybių kortelėje 

po teksto stiliumi.  

ARBA 

Pasirinkite Format > Paragraph > Drop Cap. 
 
 
 
 
 
 
 
 

1 
Daugiau teksto pasirinkčių 

2 
Daugiau teksto pasirinkčių 

3 
Daugiau teksto pasirinkčių 
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Daugiau teksto pasirinkčių 
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Pakeitimas  Įrankių juosta Savybių 

kortelė 

Formato 

meniu 

Tarpų tarp eilučių pakeitimas  

Ne  Taip Taip 

PATARIMAS 
 

Norint pridėti tarpus tarp pastraipų, pažymėkite Add 

space after paragraphs langelį savybių kortelėje 

arba pasirinkite Format > Paragraph > Line 

Spacing > Add space after paragraphs. 

 

Kalbos krypties pakeitimas (iš kairės į dešinę ar iš 

dešinės į ranką) 

Ne  Ne  Taip 

PASTABA 
 

Pasirinkite Format > Paragraph > Direction > Left 

to Right kalboms, kurios skaitomos iš kairės į dešinę 

(pavyzdžiui, anglų ir prancūzų). 
 

ARBA 
 

Pasirinkite Format > Paragraph > Direction > Right 

to Left kalboms, kurios skaitomos iš dešinės į kairę 

(pavyzdžiui, arabų ir hebrajų). 

 

Objekto lygis 
 

Teksto krypties keitimas (horizontalus ar vertikalus) Taip5 Taip Taip 
 

Skaidrumo keitimas  Taip Taip Ne 
 

 
Teksto objektų dydžio keitimas 
Kai pakeičiate teksto langelio dydį, teksto dydis langelyje pasikeičia. 

 

Jei norite pakeisti teksto langelio dydį  nepakeitus teksto dydžio langelyje, atlikite žemiau pateiktą 

procedūrą. 
 
 

Teksto langelio dydžio keitimas 
 

1.   Du kartus paspauskite ant teksto langelio. 
 

2.   Paspauskite ant vieno iš dviejų baltų apskritimų bet kurioje teksto langelio pusėje, tuomet vilkite 

apskritimą, kad padidintumėte arba sumažintumėte teksto langelio dydį. 
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Teksto langelių iškirpimas, kopijavimas ir įklijavimas 
Galite iškirpti, kopijuoti ir įklijuoti teksto langelius kaip ir bet kuriuos kitus objektus. Taip pat galite iškirpti 

ir įklijuoti tekstą į teksto langelį. 
 
 

Teksto iškirpimas ir įklijavimas į kitą vietą tame pačiame puslapyje 
 

1.   Du kartus paspauskite ant teksto langelio. 
 

2.   Pasirinkite tekstą, kurį norite iškirpti. 

3.   Vilkite pasirinktą tekstą į kietą vietą tame pačiame puslapyje. 
 
 

Teksto iškirpimas ir įklijavimas į kitą puslapį 
 

1.   Jei puslapių rūšiuotuvas nėra matomas, pasirinkite Page Sorter . 
 

2.   Du kartus paspauskite ant teksto langelio. 
 

3.   Pasirinkite tekstą, kurį norite kopijuoti. 
 

4.   Vilkite pasirinktą tekstą ant kito puslapio piktogramos puslapių rūšiuotuvo kortelėje. 
 
 

Matematinių simbolių įterpimas 
Galite įterpti įvairius matematinius ir mokslinius simbolius į puslapį. 

 
 

PASTABA 
 

Matematiniai simboliai yra tik ženklai. Jie neatlieka matematinių funkcijų. 
 

 
 

Matematinio simbolio įterpimas 
 

1.   Įrašykite tekstą puslapyje. 
 

2.   Spauskite More Text Options  ir pasirinkite Insert Symbol  . 
 

Atsiras dialogo langelis. 
 

3.   Pasirinkite kategoriją. 
 

Atsiras simbolių sąrašas. 
 

4.   Paspauskite ant simbolio, kurį norite pridėti į tekstą. 
 

5.   Spauskite Insert. 
 

Simbolis atsiras teksto langelyje. 
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Teksto rašybos klaidų patikrinimas 
Kai įrašote tekstą, SMART Notebook programinė įranga tikrina rašybos klaidas. Jei parašysite žodį 

neteisingai, SMART Notebook programinė įranga pabrauks jį raudonai. Tuomet, galite dešiniu klavišu 

paspausti ant žodžio ir pasirinkti teisingą formą iš pasirinkimų sąrašo. 

 

Jei norite, galite išjungti šią funkciją ir patikrinti rašybą pasinaudoję rašybos tikrinimo dialogo langeliu. 
 
 

Automatinio rašybos tikrinimo išjungimas 
 

1.   Spauskite Text  . 
 

2.   Spauskite More Text Options   ir pasirinkite Check Spelling  . 
 

 

Rašybos tikrinimas teksto langelyje rankiniu būdu 
 

1.   Pasirinkite teksto langelį. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Check Spelling. 
 

Jei SMART Notebook programinė įranga randa neteisingai parašytą vardą, atsiranda rašybos tikrinimo 

langelis. OS X atveju, atsiranda rašybos ir gramatikos langelis. Šiame dialogo langelyje rodomas 

neteisingai parašytas žodis ir siūlomos alternatyvos. 
 

3.   Kiekvienam neteisingai parašytam žodžiui, atlikite šiuos veiksmus: 
 

o    Palikti esamą žodžio rašybą šiam atvejui, spauskite Ignore Once. 
 

o    Palikti esamą žodžio rašybą visiems atvejams faile, spauskite Ignore All. 
 

o    Palikti esamą žodžio rašybą visiems atvejams faile ir pridėti rašybą į žodyną, spauskite Add to 

Dictionary. 
 

o    Pakeisti žodžio rašybą šiam atvejui, pasirinkite teisingą žodį pasiūlymų sąraše, tuomet spauskite 

Change. 
 

o    Pakeisti žodžio rašybą visiems atvejams faile, pasirinkite teisingą žodį pasiūlymų sąraše, tuomet 

spauskite  Change All. 

 
PASTABA 

 

Jei atsitiktinai paspausite kokį nors mygtuką, spauskite Undo, kad panaikintumėte pakeitimą. 

 
Užbaigus šiuos žingsnius kiekvienam neteisingam parašytam žodžiui, atsiras dialogo langelis, 

klausiantis ar norite patikrinti likusio failo rašybą. 
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4.   Spauskite Yes, kad patikrintumėte likusį failą. 
 

ARBA 
 

Spauskite No, kad uždarytumėte rašybos tikrinimo dialogo langelį netikrinant likusio failo. 
 
 
 

Lentelių kūrimas ir darbas su jomis 
Jūs galite kurti lenteles SMART Notebook programinėje įrangoje arba įklijuoti jas iš kitų programų. Sukūrę 

lentelę, galite įterpti objektus į lentelės langelius. 

 
Jei norite tinkinti lentelę, galite pasirinkti visą lentelę, stulpelį, eilutę, langelį ar kelis langelius ir tuomet 

atlikti šiuos veiksmus: 

 

l  Perkelti lentelę 
 

l  Keisti linijos tipą, užpildą ir teksto savybes 
 

l  Pakeisti lentelės, stulpelio ar eilutės dydį 
 

l  Įterpti ar panaikinti stulpelius, eilutes ir langelius 
 

l  Padalinti ar sujungti langelius 
 

l  Panaikinti lentelę 
 
 

Lentelių kūrimas 
 
 

Lentelės įterpimas naudojant lentelės mygtuką 
 

1.   Spauskite Table  . 
 

Atsiras tinklelis. 
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2.   Nuveskite žymeklį virš tinklelio ir pasirinkite stulpelių bei eilučių skaičių, kurie turėtų sudaryti 

lentelę. 

 
PASTABA 

 

Langeliai tinklelyje atitinka langelius lentelėje. 
 

 

PATARIMAS 
 

Tinklelyje rodomos aštuonios eilutės ir aštuoni stulpeliai. Galite pridėti eilutes nuvesdami žymeklį po 

apatine eile. Panašiai, galite pridėti stulpelius nuvesdami žymeklį už eilutės dešinėje. 
 

jei naudojate pelytę, paspauskite ir laikykite kairį pelytės klavišą judindami žymeklį. 

 
3.   Paspauskite ant ekrano ir pelytę. 

 

Puslapyje atsiras lentelė. 
 
 

Lentelės įterpimas naudojant lentelės įterpimo dialogo langelį 
 

1.   Pasirinkite Insert > Table. 
 

Atsiras lentelės įterpimo dialogo langelis. 
 

2.   Įrašykite eilučių ir stulpelių skaičių į langelius. 
 

3.   Pasirinktinai, pasirinkite Make cells square, kad lentelės langeliai būtų kvadratiniai. 
 

4.   Pasirinktinai, pasirinkite Remember dimensions for new tables, kad galėtumėte naudoti dabartinės 

lentelės matmenis kitoms lentelėms, kurias kursite su SMART Notebook programine įranga. 
 

5.   Spauskite OK. 
 

Puslapyje atsiras lentelė. 
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Lentelės piešimas 
 

1.   Spauskite Pens . 
 

Atsiras rašiklio mygtukai. 
 

 
 

2.   Spauskite Pen Types, o tuomet pasirinkite Pen arba Calligraphic Pen. 
 

3.   Pasirinkite linijos tipą. 
 

4.   Ekrane nupieškite lentelę. 

 
PATARIMAS 

 

Brėžkite lentelės linijas kuo tiesesnes ir sujunkite kampus. 

 

5.   Spauskite Select  . 
 

6.   Pasirinkite savo piešinį. 
 

7.  Spauskite meniu rodyklę, tuomet pasirinkite Recognize Table. 
 

Jei SMART Notebook programinė įranga atpažins jūsų piešinį kaip lentelę, ji pašalins jūsų piešinį 

ir pridės lentelę į puslapį. 

 

 

Lentelių, stulpelių, eilučių ar langelių pasirinkimas 
Galite pasirinkti lentelę, stulpelį, eilutę, langelį ar kelis langelius. Pasirinkus lentelę ar dalį lentelės, 

galite atlikti šiuos veiksmus: 

 

l  Perkelti lentelę 
 

l  Keisti lentelės ar langelių savybes 
 

l  Pakeisti lentelės, stulpelio ar eilutės dydį 
 

l  Įterpti ar panaikinti stulpelius, eilutes ir langelius 
 

l  Padalinti ar sujungti langelius 
 

l  Panaikinti lentelę 
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Lentelės pasirinkimas 

 

 

 
 

 

1.   Spauskite Select  . 
 

2.   Spauskite šalia lentelės krašto, tuomet vilkite į priešingą kraštą. 

 
PASTABA 

 

Nepradėkite vilkti lentelės viduje. Jei taip padarysite, pasirinksite lentelės langelį, o ne lentelę. 
 

 
 

Stulpelio pasirinkimas 
 

1.   Spauskite Select . 
 

2.   Spauskite stulpelio viršutinio langelio viduje, tuomet vilkite link apatinio langelio. 
 
 

Eilutės pasirinkimas 
 

1.   Spauskite Select . 
 

2.   Spauskite eilutės kairiausio langelio viduje, tuomet vilkite link dešiniausio langelio. 
 
 

Langelio pasirinkimas 
 

1.   Spauskite Select . 
 

2.   Spauskite langelio viduje. 
 
 

Kelių langelių pasirinkimas 
 

1.   Spauskite Select . 
 

2.   Spauskite viršutinio ir kairiausio langelio viduje, tuomet vilkite link apatinio ir dešiniausio langelio. 

 

 
PASTABA 

 

Jei pasirinksite kelis langelius ir vilksite juos į kitą puslapio vietą, jūs sukursite naują lentelę, 

kurią sudarys pasirinkti langeliai ir jų turinys. 
 

 
 

Stulpelių, eilučių ar langelių pridėjimas arba panaikinimas 
Jei norite tinkinti lentelę, galite pridėti stulpelius ar eilutes. 
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Stulpelio pridėjimas 

 

 

 

1.   Pasirinkite stulpelį. 
 

2.   Spauskite stulpelio meniu rodyklę, tuomet pasirinkite Insert Column. 
 

Naujas stulpelis atsiras esančio stulpelio dešinėje. 
 
 

Stulpelio panaikinimas 
 

1.   Pasirinkite stulpelį. 
 

2.   Spauskite stulpelio meniu rodyklę, tuomet pasirinkite Delete Column. 
 
 

Eilutės pridėjimas 
 

1.   Pasirinkite eilutę. 
 

2.   Spauskite eilutės meniu rodyklę, tuomet pasirinkite Insert Row. 
 

Nauja eilutė atsiras po esančia eilute. 
 
 

Eilutės panaikinimas 
 

1.   Pasirinkite eilutę. 
 

2.   Spauskite eilutės meniu rodyklę, tuomet pasirinkite Delete Row. 
 
 

Langelio panaikinimas 
 

1.   Langelio pasirinkimas. 
 

2.   Spauskite langelio meniu rodyklę, tuomet pasirinkite Delete Cells. 

 
PASTABA 

 
o    Panaikinę langelį, ištrinsite langelio turinį. 

 

o    Jūs negalėsite panaikinti langelio, jei jis bus vienintelė jungtis tarp dviejų lentelių pusių. 
 

 
 

Lentelių, stulpelių ar eilučių dydžio keitimas 
Jei norite tinkinti lentelę, galite pakeisti lentelės, stulpelio ar eilutės dydį. 
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Lentelės dydžio keitimas 
 

1.   Pasirinkite lentelę. 
 

2.   Spauskite lentelės dydžio keitimo rankenėlę (pilką apskritimą), tuomet vilkite ją, kad padidintumėte 

arba sumažintumėte lentelės dydį. 
 
 

Stulpelio dydžio keitimas 
 

1.   Spauskite Select . 
 

2.   Spauskite ant vertikalaus dešinio stulpelio krašto. 
 

Atsiras dydžio keitimo žymeklis. 
 

3.   Vilkite vertikalų kraštą, kad pakeistumėte stulpelio dydį. 
 
 

Eilutės dydžio keitimas 
 

1.   Spauskite Select . 
 

2.   Spauskite ant horizontalaus apatinio eilutės krašto. 
 

Atsiras dydžio keitimo žymeklis. 
 

3.   Vilkite horizontalų kraštą, kad pakeistumėte eilutės dydį. 
 
 

Pakeisti visų lentelės langelių dydį 
 

1.   Pasirinkite lentelę. 
 

2.   Spauskite lentelės meniu rodyklę, tuomet pasirinkite Adjust size. 
 

3.   Pasirinkite vieną iš šių variantų: 
 

o    Make same height, kad visų lentelės langelių aukštis būtų vienodas. 
 

o    Make same width, kad visų lentelės langelių plotis būtų vienodas. 
 

o    Make same size, kad visų lentelės langelių aukštis ir plotis būtų vienodas. 
 

o    Make cells square, kad visi lentelės langeliai būtų kvadratiniai. 
 
 

Objektų pridėjimas į lenteles 
 

 
Įterpę lentelę į puslapį, galite įterpti objektus į lentelės langelius. 
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PASTABA 

 

Galite pridėti tik vieną objektą  į vieną langelį. Jei norite pridėti kelis objektus į langelį, atlikite vieną iš 

šių veiksmų: 

 

l  Sugrupuokite objektus prieš pridėdami juos  į lentelę (žiūrėkite „Objektų grupavimas“ 77 puslapyje). 
 

l  Pasirinkite visus objektus vienu metu, tuomet įterpkite juos į lentelę kaip aprašyta procedūroje 

žemiau. SMART Notebook programinė įranga automatiškai sugrupuos objektus lentelės 

langelyje. 
 
 

Objekto pridėjimas į lentelę 
 

1.   Pasirinkite objektą. 
 

2.   Vilkite objektą į lentelės langelį. 

 
PASTABA 

 

Negalėsite perkelti objekto,  jei jis bus užfiksuotas vietoje. 

 
Objektas atsiras lentelės langelyje. 

 
PASTABA 

 

Jei pridėsite tekstinius objektus į lentelę, langelio dydis pasikeis, kad į jį tilptų tekstinis objektas. 

Jei pridėsite kitokio tipo objektus į lentelę, objekto dydis pasikeis, kad tilptų į langelį. 
 

 
 

Objekto pašalinimas iš lentelės 
 

1.   Pasirinkite objektą. 
 

2.   Vilkite objektą iš lentelės. 
 
 

Lentelių perkėlimas 
Sukūrę lentelę, galite perkelti į ją bet kurią lapo dalį. 

 
 

Lentelių perkėlimas 
 

Pasirinkite lentelę, tuomet vilkite ją į kitą puslapio vietą.  

ARBA 

Pasirinkite visus lentelės langelius, tuomet vilkite langelius į kitą puslapio vietą. 
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Lentelės savybių keitimas 
Galite naudoti savybių kortelę ir pakeisti lentelės savybes, jos skaidrumą, langelių spalvą ir linijos 

spalvą. 
 
 

Lentelės užpildo keitimas 
 

1.   Pasirinkite lentelę, stulpelį, eilutę, langelį ar kelis langelius. 
 

2.   Spauskite lentelės, stulpelio, eilutės ir langelio meniu rodyklę, tuomet pasirinkite Properties. 
 

3.   Spauskite Fill Effects. 
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4.   Pasirinkite užpildo stilių: 
 

Užpildo stilius  Procedūra 
 

Jokio (permatomas) Pasirinkite No fill. 
 

Vientisa spalva  a.   Pasirinkite Solid fill. 
 

b.   Atlikite vieną iš šių veiksmų: 

o    Pasirinkite vieną iš 40 spalvų iš paletės. 
 

o    Spauskite More, tuomet pasirinkite spalvą dialogo langelyje. 
 

 
 

 
Dviejų spalvų 

perėjimas 

o    Spauskite pipetės įrankį , tuomet pasirinkite spalvą ekrane. 

 
 

a.   Pasirinkite Gradient fill. 
 

b.   Kiekvienai spalvai pasirinkite, vieną iš šių: 

o    Pasirinkite vieną iš 40 spalvų iš paletės. 
 

o    Spauskite More, tuomet pasirinkite spalvą dialogo langelyje. 
 

o    Spauskite pipetės įrankį , tuomet pasirinkite spalvą ekrane. 

c.   Pasirinkite variantą stiliaus išplečiamą sąrašą. 

 
 

Raštas   a.   Pasirinkite Pattern fill. 

b.   Pasirinkite raštą. 

c.   Spauskite Foreground color, pasirinkite spalvą dialogo langelyje 

ir spauskite OK. 

d.   Spauskite Background color, pasirinkite spalvą dialogo langelyje 

ir spauskite OK. 
 

Paveiksliukas   a.   Pasirinkite Image fill. 

b.   Spauskite Browse. 

Atsiras dialogo langelis. 

c.   Pasirinkite paveiksliuką, kurį norite naudoti kaip foną, tuomet 

spauskite Open. 

 

PASTABA 
 

Jei įterpsite didelį paveiksliuką, gali atsirasti dialogo langelis ir 

paprašyti jūsų sumažinti arba išlaikyti paveiksliuko failo dydį. 

Daugiau informacijos pateikta „Paveiksliuko optimizavimo 

pasirinkčių nustatymas“ 185 puslapyje. 
 

d.   Pasirinkite Keep image size, norėdami išlaikyti paveiksliuko dydį, 

nepaisant to, ar paveiksliukas yra didesnis ar mažesnis nei objektas. 

ARBA 

Pasirinkite Scale image to fit, norėdami pakeisti paveiksliuko dydį, 

kad jis tiktų į langelį. 
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5.   Pasirinktinai, vilkite Object transparency slankiklį į dešinę, kad lentelė taptų permatoma. 
 
 

Lentelės linijos stiliaus keitimas 
 

1.   Pasirinkite lentelę. 

 
PASTABA 

 

Galite pakeisti tik visos lentelės linijos stilių, o ne atskirų langelių, stulpelių ar eilučių. 

 
2.   Spauskite lentelės, stulpelio, eilutės ar langelio meniu rodyklę, tuomet pasirinkite Properties. 

 

3.   Spauskite Line Style. 
 

4.   Pakeiskite lentelės linijos stilių. 
 
 

Lentelės teksto stiliaus keitimas 
 

1.   Pasirinkite lentelę, stulpelį, eilutę, langelį ar kelis langelius. 
 

2.   Spauskite lentelės, stulpelio, eilutės ar langelio meniu rodyklę, tuomet pasirinkite Properties. 
 

3.   Spauskite Text Style. 
 

4.   Pakeiskite lentelės teksto stilių (žiūrėkite „Teksto formatavimas“ 46 puslapyje). 
 
 

Lentelės langelių padalijimas arba sujungimas 
Galite pridėti lenteles į puslapį ir įterpti objektus į lentelės langelius. Jei norite tinkinti lentelę, 

galite padalinti arba sujungti langelius. 
 
 

Padalinti langelį 
 

1.   Pasirinkite langelį. 
 

2.   Spauskite langelio meniu rodyklę, tuomet pasirinkite Split. 
 

3.   Pasirinkite pasirinktį padalinti langelį į kelias eilutes ir/ar stulpelius. 

 
PASTABA 

 

Jei padalinsite langelį su turiniu, turinys atsiras langelio viršuje kairėje po padalijimo. 
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Sujungti langelius 
 

1.   Pasirinkite langelius. 
 

2.   Spauskite langelio meniu rodyklę, tuomet pasirinkite Merge Cells. 

 
PASTABA 

 

Jei sujungsite langelius su turiniu, turinys atsiras sujungto langelio viršuje kairėje. Jei viršutinis 

kairys langelis yra tuščias, sujungtame langelyje atsiras turinys iš šalia esančio langelio su turiniu, 

judant iš kairės į dešinę, iš viršaus į apačią. 
 

 
 

Lentelių ir lentelių turinio panaikinimas 
Galite ištrinti lentelės turinį ir pačią lentelę. 

 
 

PASTABA 
 

Galite ištrinti visus objektus puslapyje, įtraukiant lenteles, išvalydami puslapį (žiūrėkite „Puslapių  

išvalymas“ 167 puslapyje). 
 

 
 

Lentelės turinio panaikinimas 
 

1.   Pasirinkite langelius su turiniu, kurį norite ištrinti. 
 

2.   Spauskite Delete   . 
 

 

Lentelės panaikinimas 
 

1.   Pasirinkite lentelę. 
 

2.   Spauskite lentelės meniu rodyklę, tuomet pasirinkite Delete. 
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Sukūrę objektą, galite jį pasirinkti ir dirbti su juo, kaip aprašyta šiame skyriuje. 
 
 

PASTABA 
 

Šiame skyriuje aprašytos užduotys yra skirtos visiems objektams, ne tik pagrindiniams. 
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Objektų pasirinkimas 
Prieš dirbant su objektu, turite jį pasirinkti. Galite pasirinkti vieną objektą, kelis objektus ar visus objektus 

puslapyje. Kai pasirenkate objektą, aplink jį atsiranda pasirinkimą nurodantis stačiakampis. 
 

 
 
 

Pilkas apskritimas objekto apatiniame dešiniame kampe yra dydžio keitimo rankena. Žalias 

apskritimas virš objekto yra sukimo rankena. 

Į apačią nukreipta rodyklė objekto viršutiniame dešiniame kampe yra meniu rodyklė. Paspauskite meniu 

rodyklę, kad būtų rodomas komandų meniu. 
 
 

PASTABA 
 

Paspaudę objekto meniu rodyklę, jūs galite patekti į tą patį meniu kaip ir dešiniu klavišu paspaudus ant objekto. 
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Objekto pasirinkimas 
 

1.   Spauskite Select  . 
 

2.   Paspauskite ant objekto, kurį norite pasirinkti. 
 

Pasirinkimo stačiakampis atsiras aplink objektą. 

 
PASTABA 

 

Jei paspausite ant objekto  ir vietoje meniu rodyklės atsiras užrakto simbolis, objektas yra užrakintas. 

Priklausomai nuo užrakto tipo, jums gali reikėti atrakinti objektą prieš dirbant su juo. 
 

 
 

Įvairių objektų pasirinkimas 
 

1.   Spauskite Select . 
 

2.   Paspauskite ant interaktyvaus ekrano ir vilkite, kol stačiakampis apsups objektus, kuriuos norite 

pasirinkti. 
 

ARBA 
 

Laikykite CTRL (Windows operacinėse sistemose) ar COMMAND (⌘ ) klavišą (OS X 

operacinėse sistemose), tuomet paspauskite ant objektų, kuriuos norite pasirinkti. 
 

 Pasirinkimo stačiakampis atsiras aplink pasirinktus objektus. 

 
PASTABA 

 

Jei nubrėšite stačiakampį aplink kelis objektus, o kai kurie objektai yra užrakinti, jūs pasirinksite 

tik neužrakintus objektus. 
 

 
 

Visų objektų puslapyje pasirinkimas 
 

Pasirinkite Edit > Select  All. 
 

 Pasirinkimo stačiakampis atsiras aplink visus objektus puslapyje. 

 
PASTABA 

 

Jei kai kurie objektai yra užrakinti, jūs pasirinksite tik neužrakintus objektus. 
 

 
 

Visų užrakintų objektų puslapyje pasirinkimas  
 

Pasirinkite Edit > Select  All Locked Notes. 
 

Pasirinkimo stačiakampis atsiras aplink visus užrakintus objektus puslapyje. 
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Objekto savybių keitimas 
Jūs galite pakeisti objekto savybes. Keičiamos savybės priklauso nuo pasirinkto objekto. Jūs taip pat galite 

pasirinkti kelis objektus ir pakeisti jų savybes tuo pačiu metu. 

 

 

Užpildo keitimas 
Jūs galite pakeisti objekto užpildą pasirinkdami objektą ir tuomet nustatydami užpildą savybių kortelėje 

arba paspaudę Fill  , nustatę užpildą ir tuomet pasirinkę objektą. 
 

 

Objekto užpildo pakeitimas pirma pasirinkus objektą 
 

1.   Pasirinkite objektą. 
 

2.   Jei savybių kortelė nėra matoma, spauskite ant Properties . 
 

3.   Spauskite Fill Effects. 
 

4.   Pasirinkite užpildo stilių: 
 

Užpildo stilius  Procedūra 
 

Jokio (permatomas) Pasirinkite No fill. 
 

Vientisa spalva a.   Pasirinkite Solid fill. 
 

b.   Atlikite vieną iš šių veiksmų: 

o    Pasirinkite vieną iš 40 spalvų iš paletės. 
 

o    Spauskite More, tuomet pasirinkite spalvą dialogo langelyje. 
 

 
 

 
Dviejų spalvų 

perėjimas 

o    Spauskite pipetės įrankį , tuomet pasirinkite spalvą ekrane. 

 
 

a.   Pasirinkite Gradient fill. 
 

b.   Kiekvienai spalvai pasirinkite, vieną iš šių: 

o    Pasirinkite vieną iš 40 spalvų iš paletės. 
 

o    Spauskite More, tuomet pasirinkite spalvą dialogo langelyje. 
 

o    Spauskite pipetės įrankį , tuomet pasirinkite spalvą ekrane. 

c.   Pasirinkite variantą stiliaus išplečiamą sąrašą. 
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Užpildo stilius  Procedūra 
 

Raštas  a.   Pasirinkite Pattern fill. 

b.   Pasirinkite raštą. 

c.   Spauskite Foreground color, pasirinkite spalvą dialogo langelyje 

ir spauskite OK. 

d.   Spauskite Background color, pasirinkite spalvą dialogo langelyje 

ir spauskite OK. 
 

Picture   a.   Pasirinkite Image fill. 

b.   Spauskite Browse. 

Atsiras dialogo langelis. 

c.   Pasirinkite paveiksliuką, kurį norite naudoti kaip foną, 

tuomet spauskite Open. 

 

PASTABA 
 

Jei įterpsite didelį paveiksliuką, gali atsirasti dialogo langelis ir 

paprašyti jūsų sumažinti arba išlaikyti paveiksliuko failo dydį. 

Daugiau informacijos pateikta „Paveiksliuko optimizavimo 

pasirinkčių nustatymas“ 185 puslapyje. 
 

d.   Pasirinkite Keep image size, norėdami išlaikyti paveiksliuko dydį, 

nepaisant to, ar paveiksliukas yra didesnis ar mažesnis nei objektas. 

 

Pasirinkite Scale image to fit, norėdami pakeisti paveiksliuko dydį, kad jis tiktų į langelį. 
 
 

5.   Pasirinktinai, vilkite Object transparency slankiklį į dešinę, kad objektas taptų permatomas. 

 
PATARIMAS 

 

Taip pat galite keisti objekto savybes naudodami savybių selektorius įrankių juostoje. 
 

 
 

Objekto užpildo keitimas pirma paspaudus užpildo mygtuką 
 

1.   Spauskite Fill  , tuomet pasirinkite spalvą. 
 

2.   Pasirinkite objektą. 
 

3.   Pakartokite 2 žingsnį su kiekvienu objektu,  kurį norite užpildyti. 
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Skaitmeninio rašalo piešinių užpildymas 
Be figūrų, taisyklingųjų daugiakampių ir netaisyklingųjų daugiakampių užpildymo, galite užpildyti sritis, 

kurios yra apvestos skaitmeniniu rašalu, naudojant užpildymo mygtuką. 
 

 
 

 
PASTABOS 

 
l  Norint užpildyti sritį, jūs turite apvesti skaitmeniniu rašalu be tarpų. 

 

l  Jūs negalėsite užpildyti apvestos srities, jei ta sritis yra grupės dalis (žiūrėkite „Objektų grupavimas“ 

77 puslapyje). 

l  Kai užpildote apvestą sritį, užpildas tampa atskiru objektu, kurį galite perkelti iš pradinės apvestos 

srities. Jūs galite užpildyti apvestą sritį ir perkelti gautą užpildytą objektą daug kartų. 
 
 
 
 

Kitų savybių keitimas 
Be užpildo, jūs taip pat galite keisti objektų linijų stilių ir teksto stilių. 

 
 

Objekto linijos stiliaus keitimas 
 

1.   Pasirinkite objektą. 
 

2.   Jei savybių kortelė nėra matoma, spauskite ant Properties . 
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3.   Spauskite Line Style. 
 

4.   Pakeiskite objekto linijos stilių. 
 
 

Objekto teksto stiliaus keitimas 
 

1.   Pasirinkite objektą. 
 

2.   Jei savybių kortelė nėra matoma, spauskite ant Properties . 
 

3.   Spauskite Text Style. 
 

4.   Pakeiskite objekto teksto stilių (žiūrėkite „Teksto formatavimas“ 46 puslapyje). 
 
 
 

Įrankio nustatymų išsaugojimas 
Kai pasirenkate įrankį įrankių juostoje, galite pakeisti jo numatytus nustatymus naudodami savybių 

kortelę ir tuomet išsaugodami pakeitimus paspausdami Save Tool Properties. 

 
Kai išsaugote savo įrankio numatytų nustatymų pakeitimus, įrankio mygtukas rodo šiuos pakeitimus: 

 

 
 
 

Norint atkurti numatytus nustatymus, žiūrėkite „Įrankių juostos tinkinimas“ 181 puslapyje. 
 
 
 

Objektų padėties keitimas 
Jūs galite keisti objekto padėtį  perkeldami jį į kitą sritį esančiame puslapyje ar į kitą puslapį. Taip pat 

galite sulygiuoti objektus ir pakeisti objektų tvarką. 
 

 
 

Objektų lygiavimas 
Jūs galite naudoti papildomus lygiavimo įrankius ir sulygiuoti bei paskirstyti objektus puslapyje. Galite 

sulygiuoti pasirinktus objektus apačioje, kairėje, dešinėje, viršuje, vertikaliai ar horizontaliai. Jūs taip pat 

galite sulygiuoti sukrautus objektus vertikaliai ar horizontaliai. 

 
Jei norite, galite rodyti puslapyje gaires, kurios padės jums rankiniu būdu suderinti objektus su kitais 

objektais, taip pat puslapio vertikaliu ir horizontaliu centru. Taip pat galite nustatyti automatišką 

objektų sulygiavimą  su šiomis gairėmis, kai perkeliate objektus puslapyje. 
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Objektų sulygiavimas puslapyje 
 

1.   Pasirinkite norimus sulygiuoti objektus. 
 

2.   Spauskite Add-ons  įrankių juostoje, kad rodytų lygiavimo įrankių mygtukus. 
 

3.   Spauskite lygiavimo mygtuką: 
 

Mygtukas   Pavadinimas  Pasirinkite mygtuką, jei norite: 
 

Lygiuoti apačioje  Sulygiuoti pasirinktus objektus palei apatinį kraštą. 

Lygiuoti kairėje  Sulygiuoti pasirinktus objektus palei kairį kraštą. 

Lygiuoti viduryje X Sulygiuoti pasirinktus objektus vertikaliai per objektų vidurį. 
 

Lygiuoti viduryje Y Sulygiuoti pasirinktus objektus horizontaliai per objektų vidurį. 
 

Lygiuoti dešinėje  Sulygiuoti pasirinktus objektus palei dešinį kraštą. 
 

Lygiuoti viršuje  Sulygiuoti pasirinktus objektus palei viršutinį kraštą. 
 

Krauti  

horizontaliai 

Sulygiuoti pasirinktus sukrautus objektus horizontaliai. 

 

Krauti vertikaliai  Sulygiuoti pasirinktus sukrautus objektus vertikaliai. 
 

 
Gairių rodymas 

 
1.   Pasirinkite View > Alignment. 

 

Atsiras dialogo langelis. 
 

2.   Pažymėkite langelius, nurodydami, kurias gaires norite rodyti: 
 

Langelis  Pasirinkite langelį, jei norite: 
 

Rodyti gaires 

aktyviems objektams 
 

Rodyti vertikalų 

puslapio centrą 
 

Rodyti horizontalų 

puslapio centrą 
 

Pritraukti objektus 

prie gairių 

 

Rodyti gaires, kai lygiuojate objektą su kitu objektu. 

 
 

Rodyti gaires, kai lygiuojate objektą su puslapio vertikaliu centru. 

 
 

Rodyti gaires, kai lygiuojate objektą su puslapio horizontaliu centru. 

 
 

Automatiškai sulygiuoti objektus su gairėmis, kai perkeliate 

objektus puslapyje. 
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3.   Jei norite pakeisti gairių spalvą, spauskite spalvų juostą, esančią gairių spalvų kairėje, tuomet 

pasirinkite spalvą. 
 

4.   Spauskite OK. 
 

 
 
 

Objektų pertvarkymas 
Jei objektai persidengia puslapyje, jūs galite pakeisti jų tvarką (tai yra, jūs galite valdyti, kurie objektai 

atsiras prieš kitus). 
 
 

PASTABA 
 

Jūs negalėsite perkelti objekto, jei jis užrakintas vietoje. 
 

 
 

Objekto perkėlimas į krūvos priekį 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Order > Bring to Front. 
 
 

Objekto perkėlimas į krūvos galą 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Order > Send to Back. 
 
 

Objekto perkėlimas per vieną į krūvos priekį 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Order > Bring Forward. 
 
 

Objekto perkėlimas per vieną į krūvos galą 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Order > Send Backward. 
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Objektų iškirpimas, kopijavimas ir įklijavimas 
Jūs galite iškirpti, kopijuoti ir įklijuoti objektus—įtraukiant tekstą, paveiksliukus, tiesias linijas, lankus ir 

formas —.notebook faile. 
 
 

PATARIMAI 
 

l  Galite įklijuoti tekstą iš kitų programų į SMART Notebook programinę įrangą ir iškirpti tekstą iš 

SMART Notebook programinės įrangos bei įklijuoti į kitas programas. 
 

l  Galite sukurti tikslią objekto kopiją klonuodami. 
 

 
 

Objekto iškirpimas ir įklijavimas 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Cut. 

 
PATARIMAS 

 
Taip pat galite spausti Cut , jei pridėjote šį mygtuką į įrankių juostą. 

 
3.   Jei norite įklijuoti objektą į kitą puslapį, pasirinkę rodyti tą puslapį. 

 

4.   Spauskite Paste  . 
 

 

Objekto kopijavimas ir įklijavimas 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Copy. 

 
PATARIMAS 

 

Taip pat galite spausti Copy  , jei pridėjote šį mygtuką į įrankių juostą (žiūrėkite 

„Įrankių juostos tinkinimas“ 181 puslapyje). 

 
3.   Jei norite įklijuoti objektus į kitą puslapį, pasirinkę rodyti tą puslapį. 

 

4.   Spauskite Paste  . 
 

 
 
 

Paveiksliukų apkirpimas su kauke 
Galite naudoti kaukę paveiksliukams apkirpti. Kaukė uždengia paveiksliuko dalį, bet jo neištrina. Tai leidžia 

jums redaguoti kaukę, jei norite nukirpti kitą paveiksliuko dalį. Taip pat galite nuimti kaukę nuo  

paveiksliuko ir atkurti pradinį paveiksliuką. 
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PASTABA 

 

Galite apkirpti tik rastrinės grafikos paveiksliukus. Pavyzdžiui, jūs galite apkirpti rastrinės grafikos 

paveiksliukus įkeltus iš kompiuterio galerijos. Negalima apkirpti kito tipo objektų. 

 
 
 

Paveiksliuko apkirpimas su kauke 
 

1.   Pasirinkite paveiksliuką. 
 

2.   Spauskite paveiksliuko meniu rodyklę, tuomet pasirinkite Mask. 
 

Apkarpymo kaukė atsiranda ant paveiksliuko. Nukirptos paveiksliuko dalys užtamsinamos pilku fonu. 
 

 
 

3.   Vilkite paveiksliuką, kol paveiksliuko dalis, kurią norite išsaugoti, atsiras apkarpymo kaukėje. 
 

4.   Pasirinktinai, spauskite vieną iš aštuonių apkarpymo kaukės dydžio keitimo rankenėlių (balti 

apskritimai), tuomet tempkite ją, kad padidintumėte arba sumažintumėte apkarpymo kaukės dydį. 
 

5.   Paspauskite kur nors kitur už paveiksliuko ribų, kad jų apkirptumėte. 
 
 

Kaukės redagavimas 
 

1.   Pasirinkite paveiksliuką. 
 

2.   Spauskite paveiksliuko meniu rodyklę, tuomet pasirinkite Edit Mask. 
 

Apkarpymo kaukė atsiranda ant paveiksliuko. Nukirptos paveiksliuko dalys užtamsinamos pilku fonu. 
 

3.   Vilkite paveiksliuką, kol paveiksliuko dalis, kurią norite išsaugoti, atsiras apkarpymo kaukėje. 
 

4.   Pasirinktinai, spauskite vieną iš aštuonių apkarpymo kaukės dydžio keitimo rankenėlių (balti 

apskritimai), tuomet tempkite ją, kad padidintumėte arba sumažintumėte apkarpymo kaukės dydį. 
 

5.   Paspauskite kur nors kitur už paveiksliuko ribų, kad jų apkirptumėte. 
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Paveiksliuko atkūrimas 
 

1.   Pasirinkite paveiksliuką. 
 

2.   Spauskite paveiksliuko meniu rodyklę, tuomet pasirinkite Unmask. 
 

Atkuriamas pradinis paveiksliukas. 
 

 
 
 

Objektų klonavimas 
Galite sukurti objekto kopiją naudodami klonavimo komandą arba galite sukurti kelias objekto kopijas 

naudodami neriboto klonavimo komandą. 
 
 

PASTABA 
 

Jūs taip pat galite kopijuoti ir įklijuoti objektus, įtraukiant tekstus, paveiksliukus, tiesias linijas, lankus ir 

figūras (žiūrėkite „Objektų iškirpimas, kopijavimas ir įklijavimas“ 72 puslapyje). 

 
 

 
 

Objekto klonavimas 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Clone. 
 

Puslapyje atsiras objekto kopija. 
 
 

Objekto klonavimas naudojant neriboto klonavimo komandą 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Infinite Cloner. 
 

3.   Dar kartą pasirinkite objektą. 
 

Atsiras begalybės simbolis, o ne objekto meniu rodyklė. 
 

4.   Vilkite objektą į kitą vietą puslapyje. 
 

5.   Pakartokite 4 žingsnį tiek kartu, kiek norite. 
 

6.   Kai užbaigiate objekto klonavimą, pasirinkite pradinį objektą. 
 

7.  Spauskite ant begalybės simbolio, tuomet išvalykite neriboto klonavimo pasirinkimą. 
 

 
 
 

Objektų dydžio keitimas 
Jūs galite pakeisti objektų puslapyje dydį naudojant dydžio keitimo rankenėlę ar skalės gestą (jei  
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su interaktyviu produktu galima naudoti įvairius lietimo gestus). 
 
 

PASTABA 
 

Negalėsite pakeisti objekto dydžio,  jei jis yra užrakintas vietoje. 
 

 
 

Objekto dydžio keitimas naudojant dydžio keitimo rankenėlę 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto dydžio keitimo rankenėlę (pilkas apskritimas), tuomet vilkite ją, kad 

padidintumėte arba sumažintumėte objekto dydį. 

 
PASTABA 

 

Norint išsaugoti figūros originalų aukščio ir pločio santykį, palaikykite SHIFT, kol vilksite 

dydžio keitimo rankenėlę (tik Windows operacinėje sistemoje). 
 

 
 

To Kelių objektų dydžių keitimas naudojant dydžio keitimo rankenėlę 
 

1.   Sugrupuokite objektus (žiūrėkite „Objektų grupavimas“ 77 puslapyje), tuomet pasirinkite grupę. 
 

Pasirinkimo stačiakampis atsiras aplink grupę. 
 

2.   Spauskite dydžio keitimo rankenėlę apatiniame dešiniame pasirinkimo stačiakampio kampe. 
 

3.   Vilkite dydžio keitimo rankenėlę, kad padidintumėte arba sumažintumėte objekto dydį. 
 
 

Objekto dydžio keitimas arba kėlimas nuo jo centras naudojant gestus 
 

1.   Pasirinkite objektą. 
 

2.   Dviem pirštais paspauskite ekraną skirtinguose objekto kraštuose. 
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3.   Vilkite pirštus skirtingomis kryptimis, kad padidintumėte objekto dydį. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

ARBA 
 

Vilkite pirštus vieną link kito, kad sumažintumėte objekto dydį. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Objekto dydžio keitimas nuo jo krašto ar šono naudojant gestus 
 

1.   Pasirinkite objektą. 
 

2.   Dviem pirštais paspauskite ekraną skirtinguose objekto kraštus ar šonus, iš kurių norite sumažinti 

objekto dydį.  
 

3.   Vilkite pirštus skirtingomis kryptimis, kad padidintumėte objekto dydį. 
 

ARBA 
 

Vilkite pirštus vieną link kito, kad sumažintumėte objekto dydį. 
 
 

Kelių objektų dydžių keitimas naudojant gestus 
 

1.   Pasirinkite objektą. 
 

2.   Dviem pirštais paspauskite ekraną skirtinguose objektų kraštuose. 
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3.   Vilkite pirštus skirtingomis kryptimis, kad padidintumėte objektų dydžius. 
 

ARBA 
 

 Vilkite pirštus vieną link kito, kad sumažintumėte objektų dydžius. 

 
PASTABA 

 

Objektų dydis keičiasi iš jų centro nepaisant to, kurioje ekrano vietoje paspausite. 
 
 
 

 

Objektų apvertimas 
 

 
Galite apversti objektą puslapyje. 

 
 

PASTABA 
 

Negalėsite apversti objekto,  jei jis užrakintas vietoje. 
 

 
 

Objekto apvertimas 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Flip > Up/Down ar Flip > Left/Right. 
 
 

Kelių objektų apvertimas 
 

1.   Pasirinkite objektus. 
 

2.   Spauskite bet kurio iš pasirinktų objektų meniu rodyklę, tuomet pasirinkite Flip > Up/Down ar 

Flip > Left/Right. 
 

 
 
 

Objektų grupavimas 
Galite kurti objektų grupes, kurios leis jums sąveikauti su visais objektais grupėje vienu metu. Kai sukuriate 

grupę, galite pasirinkti, perkelti, pasukti ar pakeisti grupės dydį,  tarsi ji būtų atskiras objektas. Tačiau, jei 

norite sąveikauti su vienu objektu grupėje, pirma turite išgrupuoti objektus. 
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Galite sugrupuoti ir išgrupuoti objektus rankiniu būdu naudojant meniu arba perbraukimo gestą. 
 
 

PASTABOS 
 

l  Negalima naudoti perbraukimo gesto su pelyte. 
 

l  Perbraukimo gestas veiks, jei iš pradžių paliesite interaktyvaus produkto paviršių. 
 

 
 

Objektų grupavimas naudojant meniu 
 

1.   Pasirinkite objektus. 
 

2.   Spauskite bet kurio iš pasirinktų objektų meniu rodyklę, tuomet pasirinkite Group > Group. 
 
 

Objektų išgrupavimas naudojant meniu 
 

1.   Pasirinkite grupę. 
 

2.   Spauskite grupės meniu rodyklę, tuomet pasirinkite Group > Ungroup. 
 
 

Objektų grupavimas perbraukimo gestu 
 

Greitai perbraukite pirštu per objektus tris kartus. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Objektų išgrupavimas naudojant perbraukimo gestą 
 

 Greitai perbraukite pirštu per grupę tris kartus. 
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Automatiškas objektų grupavimas 
Jei užrašysite ar nupiešite kelias linijas, SMART Notebook programinė įranga automatiškai sujungs linijas 

į vieną objektą. Pavyzdžiui, jei užrašysite raides, SMART Notebook programinė įranga sujungs atskiras 

raides ir leis jums sąveikauti su visu žodžiu. Jei norite užrašyti žodžius toje pačioje linijoje, bet nenorite 

jų sujungti, palikite tarp jų didelį tarpą, naudokite skirtingus rašiklius ar trumpai padėkite rašiklį į rašiklio 

dėklą prieš rašant kitą žodį (tik interaktyvioms lentoms). 

 
Jei SMART Notebook programinė įranga sujungė linijas, kurias norėjote valdyti atskirai, išgrupuokite linijas 

kaip aprašyta aukščiau. 
 

 
 

Objektų panaikinimas 
Nors galite ištrinti skaitmeninį rašalą, jūs negalėsite ištrinti tam tikro tipo objektų, įtraukiant tekstą, 

figūras, tiesias linijas, lankus ir paveiksliukus. Norėdami pašalinti šiuos objektus iš puslapio, turite juos 

panaikinti. 

 
 

PASTABA 
 

Negalėsite ištrinti objekto,  jei jis užrakintas vietoje. Norint panaikinti užrakintus objektus, pirma reikia 

juos atrakinti. 
 

 
 

Objekto panaikinimas 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Delete. 
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Galite importuoti paveiksliukus, multimedijos failus ir kitą turinį į savo .notebook failus iš įvairių šaltinių. 

Šie šaltiniai gali būti galerija, SMART Exchange® tinklapis ir internetas. 

 
Importavę turinį, galite jį sisteminti naudodami galeriją ir dalintis juo su kitais mokytojais per galeriją ar 

SMART Exchange tinklapį. 
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SMART Notebook 18 galerijos naudojimas 
Naudokite galerijos kortelę SMART Notebook programinės įrangos naudotojo sąsajoje ieškoti veiklos ir 

turinio pamokoms. Tuomet galėsite importuoti tą turinį į .notebook failus. 

 
Galite sisteminti turinį naudodami galeriją ir dalintis juo su kitais mokytojais. 

 
 

Turinio importavimas iš galerijos 
Galerijoje yra pamokų veiklų pavyzdžių, kurie apima veiklos kūrimo pavyzdžių (žiūrėkite „Atitinkančios 

pamokos veiklos kūrimas“ 103 puslapyje), interaktyvių technikų ir 3D modelių, skirtų padėti jums kurti 

pamokų planus. 

 
Kai jūsų sistemos administratorius įdiegia SMART Notebook programinę įrangą, jis ar ji gali įdiegti 

iš šiuos papildomus elementus: 

 

l  Gallery Essentials yra tūkstančio paveiksliukų, multimedijos objektų ir daugiau rinkinys, 

suskirstytas į kategorijas pagal temas. 

l  Lesson Activity Toolkit yra tinkinamų įrankių ir šablonų rinkinys, kurį galite naudoti profesionalių ir 

interaktyvių pamokų kūrimui. Įrankių rinkinys padės jums kurti įdomaus turinio žodžių žaidimus, 

viktorinas ir atrinkimo veiklas. 
 
 

SVARBU 
 

Kadangi Adobe nutraukia Adobe Flash grotuvą, SMART Notebook 18 nepalaiko Adobe Flash turinio. 

Jus apie tai įspės, kai bandysite atidaryti Flash turinį SMART Notebook 18 tiek Windows, tiek OS X 

operacinėse sistemose. Sužinokite daugiau apie Adobe sprendimą ir kaip konvertuoti Flash turinį 

SMART Notebook programinėje įrangoje. 
 
 

Galerija yra padalinta į dvi dalis. Viršutinė galerijos dalis yra kategorijų sąrašas. Kai pasirenkate 

kategoriją ar subkategoriją sąraše, jos turinys atsiranda apatinėje galerijos dalyje. 

 
 

PATARIMAS 
 

Galite keisti kategorijos sąrašo ir turinio sąrašo dydį paspaudę ant ribos tarp jų, tuomet vilkdami ją 

aukštyn ar žemyn. 
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Galite peržiūrėti kategorijos sąrašą ir kiekvienos kategorijos turinį. Miniatiūros kategorijose 

leidžia peržvelgti turinio paveiksliukus. 

 

l  Paveiksliukuose, paveiksliukai rodomi kaip miniatiūros. 
 

l  Interaktyviuose objektuose ir multimedijoje, vaizdo objektai rodomi kaip atskiri rėmai nuo vaizdo 

įrašų, garso objektai rodomi su garsiakalbio piktograma apatiniame kairiame kampe. 
 

l  Adobe Flash turinio nepalaiko Windows ar OS X operacinės sistemos. Tačiau, tam tikras Flash 

turinys gali būti prieinamas per interneto naršyklę. Jūs pamatysite įspėjimą, kai bandysite 

atidaryti Flash turinį SMART Notebook 18 dirbant su OS X operacine sistema. 
 

l  3D objektuose,  3D modeliai bus rodomi kaip miniatiūros. 
 

l  Notebook failuose ir puslapiuose, failai rodomi kaip aplankai, o puslapiai bus rodomi su užlenktu 

viršutiniu dešiniu kampu. 
 

l  Fonuose ir temose, fonai rodomi kaip puslapiai su užlenktu apatiniu dešiniu kampu, o temos rodomos 

kaip miniatiūros. 

 
Galite ieškoti objekto galerijoje naudodami raktinių žodžių paiešką. 

 

 
Suradę objektą galerijoje, galite importuoti jį į .notebook failą. 

 
 

Galerijos naršymas 
 

1.   Jei galerija nėra matoma, spauskite Gallery . 

2.   Spauskite kategorijos pliuso ženklą, kad pamatytumėte jos subkategorijas (Windows operacinėse 

sistemose) arba spauskite kategorijos atskleidimo trikampį, kad būtų rodomos jos subkategorijos (OS 

X operacinėse sistemose). 

 
PASTABA 

 

Galite uždaryti kategoriją paspaudę kategorijos minuso ženklą (Windows operacinėse sistemose). 

OS X operacinėse sistemose, galite uždaryti kategoriją paspaudę kategorijos atskleidimo trikampį 

antrą kartą. 

 
3.   Pasirinkite kategoriją ar subkategoriją, kad būtų rodomas turinys. 

 
 

Ieškojimas galerijoje 
 

1.   Jei galerija nėra matoma, spauskite Gallery . 
 

2.   Įrašykite raktinį žodį į paieškos langelį, tuomet spauskite Search . 
 

Galerijoje bus rodomas visas turinys, kuriame yra raktinis žodis. 
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Galerijos objekto importavimas į .notebook failą 
 

1.   Jei galerija nėra matoma, spauskite Gallery  . 
 

2.   Galerijoje pasirinkite objektą, kurį norite importuoti. 
 

3.   Du kartus paspauskite ant galerijos objekto miniatiūros. 
 

o    Jei pridėsite foną, jis pakeis esantį puslapio foną. 
 

o    Jei pridėsite puslapį iš .notebook failo, SMART Notebook programinė įranga įterps jį prieš esantį 

puslapį. 
 

o    Jei pridėsite .notebook failą, SMART Notebook programinės įranga įterps failo puslapį prieš esantį 

puslapį. 

 

 

Turinio įterpimas į galeriją 
Galite pridėti SMART Notebook programinės įrangos objektus ir puslapius, taip pat palaikomus failus, į My 

Content kategoriją galerijoje. 
 
 

Objektų įterpimas į galeriją 
 

1.   Jei galerija nėra matoma, spauskite Gallery  . 
 

2.   Pasirinkite objektą,  kurį norite įterpti į galeriją. 
 

3.   Vilkite objektą  iš puslapio į galerijos My Content kategoriją ar vieną iš jos subkategorijų. 

 

 
PASTABOS 

 
o    Jūs negalėsite nuvilkti objekto,  jei jis užrakintas vietoje. 

 

o    Jei norite pakeisti galerijos objekto pavadinimą, pasirinkite objektą, spauskite jo meniu 

rodyklę, tuomet pasirinkite Rename. 
 

 
 

Puslapio įterpimas į galeriją 
 

1.   Kurkite ir redaguokite objektus puslapyje, kol puslapis atrodys taip, kaip norite. 
 

2.   Pasirinkite File > Export Page as Gallery Item. Atsiras Save Page as Gallery Item dialogo langelis. 
 

3.   Pasirinkite aplanką, kuriame norite išsaugoti puslapį. 
 

4.   Įrašykite pavadinimą File name langelyje (Windows operacinėse sistemose) arba Save 

As langelyje (OS X operacinėse sistemose). 
 

5.   Spauskite Save. 
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6.   Jei galerija nėra matoma, spauskite Gallery . 
 

7.  Pasirinkite My Content (ar vieną iš subkategorijų) galerijos kategorijų sąraše, spauskite jos meniu 

rodyklę, tuomet pasirinkite Add to My Content. 
 

Atsiras Add to My Content dialogo langelis (Windows operacinėse sistemose) arba Open dialogo 

langelis (OS X operacinėse sistemose). 
 

8.   Pasirinkite objektą, kurį išsaugojote 5 žingsnyje. 
 

9.   Spauskite Open. 
 
 

Palaikomo failo įterpimas į galeriją 
 

1.   Jei galerija nėra matoma, spauskite Gallery  . 
 

2.   Pasirinkite My Content (ar vieną iš subkategorijų) galerijos kategorijų sąraše, spauskite jos meniu 

rodyklę, tuomet pasirinkite Add to My Content. 
 

Atsiras Add to My Content dialogo langelis (Windows operacinėse sistemose) arba Open dialogo 

langelis (OS X operacinėse sistemose). 
 

3.   Pasirinkite objektą, kurį norite įterpti į galeriją. 
 

4.   Spauskite Open. 

 
PASTABA 

 

Numatyta, kad SMART Notebook programinė įranga pavadins naujus galerijos objektus pagal jų 

pradinio failo pavadinimą. Jei norite pakeisti objekto pavadinimą, pasirinkite galerijos objekto 

miniatiūrą, spauskite jos meniu rodyklę, tuomet pasirinkite Rename. 
 

 
 

Turinio sisteminimas galerijoje 
Kai pridedate objektus, puslapius ir palaikomus failus į My Content kategoriją galerijoje, galite pertvarkyti 

kategorijos struktūrą. Galite sukurti kategorijas ir perkelti galerijos objektus tarp subkategorijų. 

 
 

Subkategorijos kūrimas 
 

1.   Jei galerija nėra matoma, spauskite Gallery . 
 

2.   Pasirinkite My Content (ar vieną iš subkategorijų) galerijos kategorijų sąraše, spauskite jos meniu 

rodyklę, tuomet pasirinkite New Folder. 
 

Atsiras nauja subkategorija. 
 

3.   Įrašykite naujos subkategorijos pavadinimą, tuomet spauskite ENTER (ar RETURN). 
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Subkategorijos pervadinimas 
 

1.   Jei galerija nėra matoma, spauskite Gallery . 
 

2.   Pasirinkite My Content galerijos kategorijų sąraše, tuomet pasirinkite subkategoriją, kurią norite 

pervadinti.  
 

3.   Pasirinktie subkategoriją, spauskite jos meniu rodyklę, tuomet pasirinkite Rename. 
 

4.   Įrašykite naują subkategorijos pavadinimą, tuomet spauskite ENTER (ar RETURN). 
 
 

Galerijos objekto perkėlimas į kitą subkategoriją 
 

1.   Jei galerija nėra matoma, spauskite Gallery  . 
 

2.   Pasirinktie kategoriją, kurioje yra galerijos objektas, kurį norite perkelti. 
 

Galerijoje bus rodomas kategorijos turinys. 
 

3.   Vilkite objektą į kitą subkategoriją. 
 
 

Dalinimasis turiniu su kitais mokytojais 
Failų rinkinio importavimas ir eksportavimas yra puikus būdas pasidalinti pagrindinėmis kategorijomis 

su kitais mokytojais ir panaudoti kategorijas, kurias sukūrė kiti mokytojai. Galite naudoti failų rinkinį 

objektų pridėjimui į My Content kategoriją galerijoje. Po failų rinkinio importavimo, visi jo 

objektai atsiras galerijoje kaip nauja subkategorija. 
 
 

Failų rinkinio importavimas iš kito mokytojo 
 

1.   Jei galerija nėra matoma, spauskite Gallery  . 
 

2.   Pasirinkite My Content (ar vieną iš subkategorijų) galerijos kategorijų sąraše, spauskite jos meniu 

rodyklę, tuomet pasirinkite Add to My Content. 
 

Atsiras Add to My Content dialogo langelis (Windows operacinėse sistemose) arba Open dialogo 

langelis (OS X operacinėse sistemose). 
 

3.   Pasirinkite aplanką, kuriame yra failų rinkinys, kurį norite importuoti. 

 
PASTABA 

 

Failų rinkinys turi .gallery plėtinį. 

 
4.   Pasirinkite failų rinkinį, tuomet spauskite Open. 

 

Rinkinys atsiras kaip nauja subkategorija. 
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Failų rinkinio eksportavimas dalinimuisi su kitais mokytojais 
 

1.   Pasirinkite kategoriją, kurioje yra objektai, kuriuos norite išsaugoti rinkinyje. 

 
PASTABA 

 

SMART Notebook programinė įranga eksportuos pasirinktą kategoriją, bet neeksportuos jos 

subkategorijų. Daugiau informacijos pateikta Knowledge Base straipsnyje 171128 . 

 
2.   Spauskite kategorijos meniu rodyklę, tuomet pasirinkite Export as Collection File. 

 

Atsiras Save As dialogo langelis (Windows operacinėse sistemose) arba Save dialogo langelis 

(OS X operacinėse sistemose). 
 

3.   Pasirinkite aplanką, kuriame norite išsaugoti failų rinkinį. 
 

4.   Įrašykite failo pavadinimą File name langelyje (Windows operacinėse sistemose) ar Save As 

langelyje (OS X operacinėse sistemose). 
 

5.   Spauskite Save. 
 
 
 

SMART Exchange tinklapio naudojimas 
SMART Exchange tinklapyje (exchange.smarttech.com) yra tūkstančiai pamokų planų, klausimų 

rinkinių, valdiklių ir kitų turinių, kuriuos galite atsisiųsti ir atidaryti SMART Notebook programinėje 

įrangoje. 

 
 

Turinio importavimas iš SMART Exchange tinklapio 
 
 

Turinio įterpimas iš SMART Exchange tinklapio 
 

1.   Spauskite Gallery   . 
 

Atsidarys galerijos langas. 
 

2.   Spauskite SMART Exchange. 
 

SMART Exchange langas atsidarys po galerijos langu. 
 

3.   Spauskite exchange.smarttech.com nuorodą. SMART Exchange tinklapis atsidarys jūsų interneto 

naršyklėje. 
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4.   Jei pirmą kartą lankotės SMART Exchange tinklapyje, spauskite Join for free, tuomet sekite 

ekrane pateikiamas instrukcijas ir susikurkite paskyrą. 
 

ARBA 
 

Jei turite paskyrą, spauskite Sign In, tuomet sekite ekrane pateikiamas instrukcijas, kad 

prisijungtumėte prie SMART Exchange tinklapio savo paskyra. 
 

5.   Pasirinkite turinį ir atsisiųskite į savo kompiuterį. 
 

6.   Turinio importavimas į galeriją. 
 
 

PASTABOS 
 

l  Jūs taip pat galite pasidalinti savo pamokų planais su kitais mokytojais per SMART Exchange 

tinklapį. 
 

 
 

Dalinimasis turiniu naudojant SMART Exchange tinklapį 
Naudokite SMART Exchange tinklapį dalintis .notebook failais su mokytojais visame pasaulyje. 

 
 

.notebook failo pasidalinimas SMART Exchange tinklapyje 
 

1.   Atidarykite .notebook failą, kuriuo norite pasidalinti. 
 

2.   Spauskite Gallery   ir pasirinkite SMART Exchange iš galerijos turinio sąrašo. 
 

Atsiras dialogo langelis po sąrašu su nuoroda į exchange.smarttech.com. 
 

3.   Spauskite exchange.smarttech.com. 
 

Jūsų interneto naršyklėje atsidarys SMART Exchange tinklapis. 
 

4.   Jei pirmą kartą lankotės SMART Exchange tinklapyje, spauskite Join for free, tuomet sekite 

ekrane pateikiamas instrukcijas ir susikurkite paskyrą. 
 

ARBA 
 

Jei turite paskyrą, pasirinkite Sign In, tuomet įrašykite elektroninio pašto adresą Email Address 

langelyje ir slaptažodį į Password langelį, tuomet spauskite Sign In. 

 
PATARIMAI 

 
o    Jei pamiršote slaptažodį, spauskite Forgot your password, tuomet sekite ekrane 

pateikiamas instrukcijas ir atkurkite slaptažodį. 
 

o    Jei nenorite prisijungti prie SMART Exchange tinklapio kiekvieną kartą pasidalinant 

turiniu, pažymėkite Keep me signed in langelį. 
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5.   Įrašykite šią informaciją: 
 

Valdymas Instrukcijos 
 

Įveskite šaltinių informaciją Įrašykite .notebook failo pavadinimą. 
 

Aprašymas Įrašykite .notebook failo aprašymą. 

Tema (-os) Pasirinkite temas, tinkančias .notebook failui.                          

Klasė (-s) Pasirinkite klases, tinkančias .notebook failui.                        

Paieškos terminai Įrašykite žodžius ir frazes, kuriuos SMART Exchange naudotojai 

Galėtų įvesti ieškodami .notebook failo. Atskirkite žodžius ar frazes 

kableliais. 
 

 
6.   Perskaitykite dalinimosi sutartį. 

 

7.  Jei sutinkate su dalinimosi sutartimi, spauskite Agree and Submit. 
 
 
 

Notebook matematinių lygčių redaktoriaus naudojimas 
Naudokite matematinių lygčių redaktorių ir lengvai pridėkite lygtis į SMART Notebook puslapius. Taip 

pat galite naudoti the lygčių redaktorių su GeoGebra. 

 

 

Matematinių lygčių redaktoriaus atidarymas 
 

1.   Meniu juostoje, spauskite papildomų įrankių mygtuką  , tuomet spauskite Insert Equation  

. 
 

Atsidarys matematinių lygčių redaktorius. 
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2.   Įrašykite norimus skaičius ir pasinaudokite matematinių lygčių redaktoriumi, kad būtų pridėti 

matematinių veiksmų simboliai. 
 

Pavyzdžiui, norint įvesti , įrašykite „a“, tuomet pasirinkite  simbolį iš lygčių redaktoriaus. 

Žymeklis pajudės į aukštesnę padėtį po „a“. Tuomet įrašykite „2“. 
 

 
 

3.   Kai lygtis bus užbaigta, spauskite Insert Equation. 
 

Lygtis bus įterpta į Notebook puslapį. 
 

 
 

 
Matematinių lygčių redaktoriaus naudojimas su GeoGebra 
Galite pridėti lygtis į GeoGebra naudodami matematinių lygčių redaktoriumi. 

 
1.   Norint atidaryti GeoGebra, spauskite Add-Ons ir GeoGebra. 

 

2.   Pasirinkite Insert GeoGebra Widget. 
 

Esamame puslapyje atsidarys GeoGebra darbalapis. 
 

3.   Atidarykite matematinių lygčių redaktorių ir įrašykite lygtį, kurią norite nubrėžti, pavyzdžiui y = x2 + 

3. 
 

4.   Užbaigus lygtį, spauskite Insert Equation. 
 

Lygtis bus įterpta į Notebook puslapį. 
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5.   Vilkite lygtį į GeoGebra darbalapį. 
 

Lygtis atsiras darbalapio įvesties srityje. Darbalapio lape atsiras lygties grafikas. 
 

 
 
 

 

Turinio importavimas iš GeoGebra 
GeoGebra interaktyvi matematinė programinė įranga, tinkanti visiems mokymo lygiams. Kai įterpiate 

GeoGebra valdiklį į SMART Notebook programinę įrangą, su mokiniais galite nagrinėti geometriją, 

algebrą, lenteles, diagramas, statistiką ir skaičiavimus. 

 

Taip pat galite rasti darbalapių GeoGebraTube naudodami raktinių žodžių paiešką. Pasirinkus 

darbalapį, galite įterpti jį į .notebook failą. GeoGebraTube (geogebratube.org) yra tūkstančiai 

darbalapių, kuriuos sukūrė ir kuriais pasidalino kiti mokytojai. 

 
 
 

PASTABA 
 

Daugiau informacijos, kaip naudoti GeoGebra programinę įrangą, pateikta GeoGebra Wiki 

(wiki.geogebra.org). 
 
 
 
 

GeoGebra valdiklio naudojimas 
 

Spauskite Add-ons  , o tuomet GeoGebra. 
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GeoGebra valdiklio įterpimas 
 

1.   Jei GeoGebra valdiklis nėra matomas, spauskite Add-ons  , tuomet spauskite GeoGebra. 
 

2.   Pasirinkite Insert GeoGebra Widget. 
 
 

GeoGebraTube paieška 
 

1.   Jei GeoGebra valdiklis nėra matomas, spauskite Add-ons   , tuomet spauskite GeoGebra. 
 

2.   Įrašykite raktinį žodį į Free Materials paieškos langelį, tuomet spauskite Search. 
 

GeoGebra vedlyje bus rodomi darbalapių, kuriuose yra raktinių žodžių, miniatiūrų paveiksliukai. 
 
 

GeoGebraTube darbalapio pridėjimas į .notebook failą 
 

1.   Jei GeoGebra valdiklis nėra matomas, spauskite Add-ons , tuomet spauskite GeoGebra. 
 

2.   Pasirinkite GeoGebraTube darbalapį, kurį norite pridėti. 
 

3.   Spauskite darbalapio miniatiūrą, o tuomet pasirinkite Insert GeoGebra Widget. 
 

Esamame puslapyje atsidarys darbalapis. 
 
 
 

Lygčių rašymas ranka ir įterpimas 
Galite naudoti SMART Notebook matematinių lygčių įrankį ir įterpti ranka įrašytas lygtis į puslapį įskaitomu 

formatu. Matematinių lygčių įrankis atpažins jūsų raštą  ir automatiškai konvertuos į tipografinį formatą. 

Taip pat galima pridėti atpažintą lygtį į GeoGebra darbalapį, jei lygties formatas yra palaikomas. 
 

1.   Spauskite Add-ons  , tuomet pasirinkite Insert Equation . 
 

Atsiras matematinių lygčių įrankis. 
 

2.   Pasirinkite rašiklio įrankį ir spalvą (žiūrėkite 36 puslapį). 
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3.   Užrašykite matematinę lygtį grafiko srityje redaktoriuje. 
 

Ranka užrašyta lygtis bus konvertuota į spausdintą lygtį, kuri atsiras po grafiko sritimi. 

Patvirtinimo ir atmetimo piktogramos atsiras šalia atpažintos lygties. 
 

 
 

4.   Spauskite , kad patvirtintumėte atpažintą lygtį. 
 

Puslapyje atsiras spausdinta lygtis.  

ARBA 

Spauskite , jei norite atmesti atpažintą lygtį ir uždaryti matematinių lygčių įrankį. 
 

 

Pridėtos, ranka užrašytos lygties redagavimas 
 

1.   Spauskite Select  , tuomet du kartus paspauskite ant atpažintos lygties puslapyje. 
 

Ranka užrašyta lygtis atsiras matematinių lygčių įrankyje. 
 

2.   Redaguokite ranka užrašytą lygtį su trintuko įrankiu ir rašiklio įrankiu. 
 

Redaguota lygtis yra atpažįstama ir atsiranda grafiko srities apačioje. Patvirtinimo ir atmetimo 

piktogramos atsiras šalia atpažintos lygties. 
 

3.   Spauskite , kad patvirtintumėte atpažintą lygtį. 
 

Lygtis atsinaujins jums redaguojant.  

ARBA 

Spauskite , jei norite atmesti atpažintą lygtį ir uždaryti matematinių lygčių įrankį. 
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Lygties įkėlimas į GeoGebra darbalapį 
 

1.   Įkelkite savo lygtį. 
 

2.   Įkelkite į puslapį GeoGebra darbalapį (žiūrėkite „Turinio importavimas iš GeoGebra“ 91 puslapyje). 
 

3.   Vilkite lygtį iš puslapio į GeoGebra valdiklį. 
 

Lygtis yra automatiškai nubraižoma darbalapyje. 
 

 
 
 

 

SMART spausdintuvo tvarkyklių naudojimas 

konvertuoti ir dalintis failais 
SMART spausdintuvo tvarkyklės leis jums konvertuoti dokumentus, sukurtus Windows programa,  

pavyzdžiui Adobe PDF ar Microsoft PowerPoint failas, į SMART Notebook failą. Jos taip pat leis joms 

konvertuoti ir dalintis failais, sukurtais Windows programa, Notebook grotuvo programoje ar sukurti failo 

nuorodą. 

 
 

PASTABA 
 

Naudodami tvarkyklę konvertuoti dokumentą į Notebook failą. 
 

 
 

Dokumentų konvertavimas į SMART Notebook failą 
 
 

Dokumento konvertavimas į SMART Notebook failą 
 

1.   Atidarykite dokumentą, kurį norite konvertuoti į šią programą.  Pavyzdžiui, jei norite konvertuoti 

Adobe PDF failą į Notebook failą, atidarykite failą Adobe PDF programoje. 
 

2.   Pagrindiniame programos meniu, pasirinkite File > Print. 
 

Atsiras programos spausdinimo dialogo langelis. 
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3.   Spausdintuvo išplečiamame meniu pasirinkite Send to SMART Notebook. 
 

4.   Pasirinkite Print. 
 

Dokumentas atsidarys SMART Notebook programinėje įrangoje. 
 

5.   Peržiūrėkite, spausdinkite ar redaguokite SMART Notebook failą. 
 

6.   Pagrindiniame SMART Notebook meniu pasirinkite File > Save ir išsaugokite Notebook failą. 
 
 

Ne Notebook failų dalinimasis SMART debesyje 
Kai naudojate spausdintuvo tvarkyklę dalintis ne Notebook failais SMART debesyje, ji konvertuoja failą į 

Notebook failą ir jį galima naudoti SMART Learning Suite internetinėje pamokų bibliotekoje. 

 
Į SMART debesį galima nusiųsti dviem būdais: 

 
l  Pasidalinti į Notebook grotuvo programą: naudokite šį būdą failų siuntimui į SMART Board su iQ 

ir pradėkite pristatinėti savo turinį. 
 

l  Sukurti nuorodą į šį dokumentą: naudokite šį būdą turinio nuorodos sukūrimui. Galite įklijuoti šią 

nuorodą į bet kurią naršyklę ir peržiūrėti failą. Jei norite nusiųsti savo turinį į SMART Learning 

Suite internetinę pamokų biblioteką, o ne pristatyti lentoje, naudokite šį būdą. 

 

 

Dalinimasis Notebook grotuvo programoje 
 
 

Dalinimasis Notebook grotuvo programoje 
 

1.   Atidarykite dokumentą šioje programoje. Pavyzdžiui, jei norimas failas yra Adobe PDF failas, 

atidarykite failą Adobe PDF programoje. 
 

2.   Pagrindiniame programos meniu, pasirinkite File > Print. 
 

Atsiras programos spausdinimo dialogo langelis. 
 

3.   Spausdintuvo išplečiamame meniu pasirinkite Send to SMART Cloud. 
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4.   Pasirinkite Print. 
 

Atsiras Send to SMART Cloud dialogo langelis. 
 

 
 

5.   Pasirinkite Share to the Notebook Player app. 
 

6.   Įrašykite SMART Board, prie kurios norite prisijungti, kodą arba pasirinkite kodą iš išplečiamo meniu. 
 

 
 

7.  Pasirinkite Share Now. 
 

Atsidarys pamokų biblioteka. 
 

8.   Pasirinkite bibliotekoje failą, kurį norite pasirinkti. Failas atsiras lentoje,  kurią anksčiau 

pasirinkote. 

 

 

Nuorodos, skirtos dalintis dokumentais, kūrimas 
 
 

Nuorodos kūrimas ir dalinimasis naudojant Create a link to this document. 
 

1.   Atidarykite dokumentą šioje programoje. Pavyzdžiui, jei norimas failas yra Adobe PDF failas, 

atidarykite failą Adobe PDF programoje. 
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2.   Pagrindiniame programos meniu, pasirinkite File > Print. 
 

Atsiras spausdinimo dialogo langelis. 
 

3.   Spausdintuvo išplečiamame meniu pasirinkite Send to SMART Cloud. 
 

4.   Pasirinkite Print. 
 

Atsiras Send to SMART Cloud dialogo langelis. 
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5.   Pasirinkite Create a link to this document. 
 

Atsiras Share dialogo langelis su nukopijuota nuoroda. 
 

 
 

 
PASTABA 

 

Atsiras Share dialogo langelis, kaip parodyta aukščiau. Teksto laukelyje esanti nuoroda bus 

automatiškai nukopijuota į jūsų iškarpinę. 

 
6.   Dešiniu klavišu paspauskite ir pasirinkite Paste, kad įklijuotumėte nuorodą ir pasidalintumėte su 

kitais. 
 

7.  Pasirinkite  mygtuką ir uždarykite Share dialogo langelį. 
 
 
 

Dalinimasis 
Pasinaudokite Notebook Share funkcija ir pasidalinkite Notebook failais ir jų nuorodomis savo SMART 

Board. 
 
 

PASTABA 
 

Jei jūsų prašoma prisijungti, prisijungimo variantai  atsidarys atskiroje naršyklėje. 
 

 
 

Dalinimasis 
 

1.   Atidarykite SMART Notebook. 
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2.   SMART Notebook meniu pasirinkite Share. 
 

Atsiras Share dialogo langelis. 
 

 
 

3.   Spauskite Share with a SMART Board. 
 

4.   Įrašykite SMART Board, prie kurios norite prisijungti, kodą arba pasirinkite kodą iš išplečiamo meniu. 
 

 
 

5.   Spauskite Share Now. 
 

Atsidarys pamokų biblioteka. 
 

6.   Pasirinkite bibliotekoje failą, kurį norite pasirinkti. Failas atsiras lentoje,  kurią anksčiau 

pasirinkote. 
 
 

PASTABA 
 

Naudokite SMART Notebook grotuvą ekrane ir atidarykite, peržiūrėkite bei sąveikaukite su atsisiųstu 

ar paskirtu SMART Notebook turiniu. Grotuvas padeda pristatyti failus ir paleisti SMART lab veiklas 

SMART Boards su iQ technologija. 

 
 

Daugiau informacijos pateikta Using SMART Notebook Player on your SMART Board 6000 with iQ . 
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Dalinimasis per nuorodą 
Jūs taip pat galite pasidalinti failu nusiųsdami failo nuorodą į SMART Board su iQ technologija. Tai yra 

labai naudinga, norint pasidalinti didesniais failais. 

 

1.   Share dialogo langelyje spauskite Share using a link. 
 

 
 

Atsiras Share nuorodos dialogo langelis. 
 

 
 

2.   Įklijuokite nuorodą į elektroninį paštą ir tuomet išsiųskite elektroninį laišką tiems, su kuriais norite 

pasidalinti failu. 
 

Gavėjai paspaus elektroniniu paštu gautą nuorodą ir atsisiųs failą. 
 

3.   Spauskite  ir uždarykite dialogo langelį. 
 
 
 

Turinio importavimas iš kitų šaltinių 
Jei jūs ar kiti mokytojai sukūrėte turinį ne SMART Notebook programinėje įrangoje, galite įtraukti šį 

turinį į .notebook failus. 
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Konkrečiai, galite atlikti šiuos veiksmus: 
 

l  Iškirpkite, kopijuokite ir įklijuokite turinį iš kitų programų 
 

l  Importuokite turinį iš kitų programų, tokių kaip YouTube™ naudodami SMART Notebook YouTube 

papildomą įrankį. 
 

l  Importuokite turinį į .notebook failą iš įvairių šaltinių, įtraukiant PowerPoint failus. 
 
 

Paveiksliukų importavimas 
Galite įterpti paveiksliukus į puslapius iš failų, skenerio ar SMART dokumentų kameros. Tiesiog vilkite ir 

įmeskite paveiksliuko failą į Notebook puslapį. Taip pat žiūrėkite SMART dokumentų kameros naudojimas. 
 
 

PASTABA 
 

Taip pat galite įterpti paveiksliukus iš galerijos. Daugiau informacijos pateikta „Turinio 

importavimas iš galerijos“ 82 puslapyje. 
 

 
 

Multimedijos failų importavimas 
Galite įterpti multimedijos failus, įtraukiant vaizdo įrašų failus ir garso įrašų failus, į puslapius. Tiesiog 

vilkite ir įmeskite failus į Notebook puslapį. Taip pat žiūrėkite Garsų pridėjimas prie objektų. 

 

 

PowerPoint failų importavimas (Windows) 
 

1.   Pasirinkite File > Import. 
 

Atsiras Open dialogo langelis. 
 

2.   Pasirinkite All PowerPoint Files (*.ppt;*.pptx) Files of type išplečiamame sąraše. 
 

3.   Pasirinkite PowerPoint failą, kurį norite importuoti. 
 

4.   Spauskite Open. 
 

SMART Notebook programinė įranga pridės PowerPoint failo turinį į .notebook failą. 
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6 skyrius 

Pamokos veiklos kūrimas 
 
 
 

Pagrindinių pamokos veiklų kūrimas    103 

Atitinkančios pamokos veiklos kūrimas    103 

Slėpimo ir rodymo pamokos veiklos kūrimas    105 

Sudėtingesnių objekto savybių naudojimas    107 

Kūrybiško rašiklio stilių kūrimas    108 

Nuorodų pridėjimas prie objektų   110 

Garsų pridėjimas prie objektų   112 

Objektų animacijų kūrimas   113 

Objektų užrakinimas   113 
 

 
 
 

Naudodami SMART Notebook programinę įrangą, jūs galite ne tik pristatyti informaciją mokiniams, 

bet taip pat įtraukti juos į interaktyvias pamokų veiklas. 

 
Galite kurti pamokų veiklas įterpdami objektus, tokius kaip figūros, paveiksliukai ir lentelės, ir naudodami 

funkcijas, tokias kaip veiklos kūrimo įrankis ir mastelio keitimo gestas. 

 
Šiame skyriuje apžvelgiamos sudėtingesnės funkcijas, kurias galite naudoti pamokų veiklų kūrimui ir 

parodyti, kaip kuriate pamokos veiklos pavyzdžių rinkinius. Galite naudoti esančius pamokos veiklos 

pavyzdžius arba sukurti savo. Taip pat galite naudoti galerijoje ir SMART Exchange tinklapyje esančius 

išteklius. 

 
 
 

Pagrindinių pamokos veiklų kūrimas 
Veiklos kūrimo įrankis leis jums kurti atitinkančias veiklas, atrinkimo veiklas, žymėjimo veiklas, žaidimus 

ir daugiau naudodami savo turinį. 

 

 

Atitinkančios pamokos veiklos kūrimas 
Naudodami veiklos kūrimo įrankį, nustatysite vieną objektą puslapyje kaip veiklos objektą. Tuomet 

nustatysite, kurie objektai puslapyje bus įtraukti, o kurie bus atmesti, kai vilksite objektus virš veiklos objekto. 
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PASTABA 

 

Užbaigsite žemiau pateiktas užduotis, kai kursite atitinkančias pamokos veiklas: 
 

l  Veiklos kūrimo įrankio naudojimas 
 

l  Garsų pridėjimas prie objektų (žiūrėkite „Garsų pridėjimas prie objektų“ 112 puslapyje) 
 

 
 

Atitinkančios pamokos veiklos kūrimas 
 

1.   Sukurkite objektą, kurį norite naudoti kaip veiklos objektą, ir objektus, kuriuos norite įtraukti arba 

atmesti, kai vilksite objektus virš veiklos objekto. 
 

2.   Spauskite Add-ons  , tuomet pasirinkite Activity Builder. 
 

3.   Pasirinkite objektą, kurį norite naudoti kaip veiklos objektą, tuomet spauskite Edit. 
 

4.   Vilkite objektus, kuriuos norite įtraukti, į Accept these objects sąrašą. 
 

Žalia varnelė  atsiras šalia objektų, kuriuos pasirinkote įtraukti. 
 

5.   Vilkite objektus, kuriuos norite atmesti į Reject these objects sąrašą. 
 

Raudonas X  atsiras šalia objektų, kuriuos pasirinkote atmesti. 

 
PASTABOS 

 
o    Norint greitai įtraukti ar atmesti likusius objektus puslapyje, spauskite Add All 

Remaining atitinkamame sąraše. 

 
o    Norint pašalinti objektus iš sąrašo, vilkite jį į šiukšlinės piktogramą  . 

 
6.   Spauskite Done. 

 
 

Atitinkančios veiklos nustatymų keitimas 
 

1.   Spauskite Add-ons  , tuomet pasirinkite Activity Builder. 
 

2.   Pasirinkite veiklos objektą, tuomet spauskite Edit. 

 
PATARIMAS 

 

Jei nežinote, kuris objektas puslapyje yra veiklos objektas, spauskite Identify. Mėlynos 

įstrižos linijos atsiras trims sekundėms virš veiklos objekto puslapyje. 

 
3.   Spauskite Settings. 

 

4.   Pasirinkite norimą animaciją pasirinktiems objektams pirmame Animation išplečiamame sąraše. 

http://www.smarttech.com/kb/171309


105 smarttech.com/kb/171309 

6 SKYRIUS 

PAMOKOS VEIKLOS KŪRIMAS 

 

 

 

 
 

5.   Pasirinktinai, pažymėkite Also play the object’s sound langelį norint paleisti garsą, pridėtą prie 

pasirinktų objektų, kai jie yra velkami per veiklos objektą  (žiūrėkite „Garsų pridėjimas prie 

objekto“ 112 puslapyje). 
 

6.   Pasirinkite norimas animacijas atmestiems objektams pirmame Animation išplečiamame sąraše. 
 

7.  Pasirinktinai, pažymėkite Also play the object’s sound langelį norint paleisti garsą, pridėtą prie 

atmestų objektų, kai jie yra velkami per veiklos objektą  (žiūrėkite „Garsų pridėjimas prie 

objekto“ 112 puslapyje). 
 

8.   Spauskite Done. 
 
 

Atitinkančios pamokos veiklos pristatymas 
 

1.   Vilkite objektus (arba paprašykite mokinių vilkti objektus) virš veiklos objekto. 
 

o    Jei objektas yra įtrauktas, bus rodoma įtraukto objekto animacija (pagal nustatymus išnyks). 
 

o    Jei objektas yra atmestas, bus rodoma atmesto objekto animacija (pagal nustatymus atšoks atgal). 
 

2.   Spauskite Add-ons  , tuomet pasirinkite Activity Builder ir Reset All, kai užbaigsite. 
 

 

Atitinkančios pamokos veiklos panaikinimas 
 

1.   Spauskite Add-ons  , tuomet pasirinkite Activity Builder. 
 

2.   Pasirinktie veiklos objektą, tuomet spauskite Clear Properties. 
 
 

Slėpimo ir rodymo pamokos veiklos kūrimas 
 
 

PASTABA 
 

Užbaigsite žemiau pateiktas užduotis, kai kursite slėpimo ir rodymo pamokos veiklos: 
 

l  Objektų perkėlimas 
 

l  Objektų užrakinimas 
 

l  Objektų dydžio keitimas naudojant mastelio keitimo gestą. 
 
 

Jūs galite paslėpti objektą  ir tuomet atskleisti jį naudodami kelias technikas: 
 

l  Pridėkite ekrano šešėlį į puslapį. Pristatymo metu, po truputį pašalinkite šešėlį ir atskleiskite paslėptą 

tekstą ir grafikos elementus, kai būsite pasiruošę juos aptarti (žiūrėkite „Ekrano šešėlio naudojimas“ 

157 puslapyje). 
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l  Uždenkite objektą  skaitmeniniu rašalu ir tuomet ištrinkite skaitmeninį rašalą (žiūrėkite 

„Rašymas, piešimas skaitmeniniu rašalu ir jo ištrynimas“ 36 puslapyje). 
 

l  Uždenkite objektą kitu objektu ir tuomet pakeiskite sukrautų objektų tvarką. 
 

l  Naudokite objektų animacijos funkciją (žiūrėkite „Objektų animacijų kūrimas“ 113 puslapyje). 

 

Taip pat jūs galite paslėpti objektą  už užrakinto objekto ir tuomet, naudodami mastelio didinimo gestą,  

padidinti ir atskleisti paslėptą objektą,  jei naudojate SMART interaktyvų produktą, kuris palaiko lietimo 

gestus. 
 
 

Slėpimo ir rodymo pamokos veiklos kūrimas 
 

1.   Sukurkite ar įterpkite objektą, kurį norite paslėpti. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2.   Sukurkite ar įterpkite objektą, kurį norite užrakinti. 
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3.   Perkelkite objektą, kurį norite užrakinti, kad jis uždengtų objektą, kurį norite paslėpti. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4.   Pasirinkite objektą,  kurį norite užrakinti, paspauskite jo meniu rodyklę, tuomet pasirinkite Locking > 

Lock in Place. 
 

5.   Panaudokite mastelio keitimo gestą, kad padidintumėte ir atskleistumėte paslėptą objektą laikant 

užrakintą objektą  vietoje (žiūrėkite „Objektų dydžio keitimas“ 74 puslapyje). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Sudėtingesnių objekto savybių naudojimas 
Naudodami SMART Notebook programinę įrangą, jūs galite ne tik pristatyti informaciją 

mokiniams, bet taip pat įtraukti juos į interaktyvias pamokų veiklas. 

 
Galite kurti pamokų veiklas įterpdami objektus, tokius kaip figūros, paveiksliukai ir lentelės, ir naudodami 

funkcijas, tokias kaip veiklos kūrimo įrankis ir mastelio keitimo gestas. 
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Kūrybiško rašiklio stilių kūrimas  

SMART Notebook programinėje įrangoje yra aštuoni kūrybiško rašiklio stiliai (žiūrėkite „Rašymas, 

piešimas skaitmeniniu rašalu ir jo ištrynimas“ 36 puslapyje). Be šių stilių, galite sukurti savo stilius 

naudodami paveiksliukus ar objektus pasirinktame puslapyje. 
 

 
 

 
 

Kūrybiško rašiklio kūrimas naudojant paveiksliuką 
 

1.   Spauskite ant Pens . 
 

Atsiras rašiklių mygtukai. 
 

 
 

2.   Spauskite Pen Types ir pasirinkite Creative Pen. 
 

3.   Pasirinkite linijos tipą. 
 

4.   Jei savybių kortelė nėra matoma, spauskite Properties . 
 

5.   Spauskite Line Style. 
 

6.   Pasirinkite Use a custom stamp image. 
 

7.  Spauskite Browse. 
 

Atsiras Insert Image File dialogo langelis. 
 

8.   Pasirinktie paveiksliuką, kurį norite naudoti su kūrybiško rašiklio stiliumi. 
 

9.   Spauskite Open. 

http://www.smarttech.com/kb/171309


109 smarttech.com/kb/171309 

6 SKYRIUS 

PAMOKOS VEIKLOS KŪRIMAS 

 

 

 

 
 

10.   Rašykite ar pieškite skaitmeniniu rašalu puslapyje. 

 
PASTABA 

 
o    Norint vėl naudoti numatytą linijos tipą, pasirinkite Use the default pattern. 

 

o    Jei norite išsaugoti sukurtą kūrybiško rašiklio stilių ateičiai, spauskite Save Tool Properties. 

Vėliau galėsite iš naujo nustatyti kūrybiško rašiklio stilių (žiūrėkite „Įrankių juostos 

tinkinimas“ 181 puslapyje). 
 

 
 

Kūrybiško rašiklio kūrimas naudojant objektą 

 
 

1.   Spauskite ant Pens . 
 

Atsiras rašiklių mygtukai. 
 

 
 

2.   Spauskite Pen Types ir pasirinkite Creative Pen. 
 

3.   Jei savybių kortelė nėra matoma, spauskite Properties . 
 

4.   Spauskite Line Style. 
 

5.   Pasirinkite Use a custom stamp image. 
 

6.   Spauskite Select object, tuomet pasirinkite objektą puslapyje. 
 

7.  Rašykite ar pieškite skaitmeniniu rašalu puslapyje. 

 
PATARIMAS 

 
o    Norint vėl naudoti numatytą linijos tipą, pasirinkite Use the default pattern. 

 
o    Jei norite išsaugoti sukurtą kūrybiško rašiklio stilių ateičiai, spauskite Save Tool Properties. 

Vėliau galėsite iš naujo nustatyti kūrybiško rašiklio stilių (žiūrėkite „Įrankių juostos 

tinkinimas“ 181 puslapyje). 
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Nuorodų pridėjimas prie objektų 

Galite pridėti puslapyje esantį objektą prie tinklapio, kito puslapio faile, failo jūsų kompiuteryje ar priedo. 

Priedas yra failo kopija, failo šaukinys ar nuorodą į tinklapį, kurį pridedate priedų kortelėje. 

 
 

PASTABA 
 

Galite rodyti animacinius nuorodos indikatorius aplinks visas nuorodas puslapyje (žiūrėkite 

„Nuorodų rodymas puslapyje“ 156 puslapyje). 
 

 
 

Nuorodos pridėjimas į tinklapį 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Link. 
 

Atsiras Insert Link dialogo langelis. 
 

3.   Spauskite Web Page, tuomet įrašykite tinklapio adresą adresų langelyje. 
 

4.   Jei norite atidaryti nuorodą paspaudę piktogramą, pasirinkite Corner icon. 
 

ARBA 
 

Jei norite atidaryti nuorodą paspaudę bet kur ant objekto, pasirinkite Object. 
 

5.   Spauskite OK. 
 

Jei pasirinkote Corner icon, atsiras  piktograma apatiniame kairiame objekto kampe. 
 

 

Nuorodos pridėjimas į kitą puslapį faile 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Link. 
 

Atsiras Insert Link dialogo langelis. 
 

3.   Spauskite Page in this File, tuomet pasirinkite variantą Select a page srityje. 
 

4.   Jei norite atidaryti nuorodą paspaudę piktogramą, pasirinkite Corner icon. 
 

ARBA 
 

Jei norite atidaryti nuorodą paspaudę bet kur ant objekto, pasirinkite Object. 
 

5.   Spauskite OK. 
 

Jei pasirinkote Corner icon, atsiras  piktograma apatiniame kairiame objekto kampe. 
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Nuorodos pridėjimas į failą kompiuteryje 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Link. 
 

Atsiras Insert Link dialogo langelis. 
 

3.   Spauskite File on this Computer, tuomet įrašykite failo vietą ir pavadinimą File langelyje. 
 

4.   Jei norite pridėti failo kopiją, pasirinkite Copy of file. 
 

ARBA 
 

Jei norite prie failo pridėti šaukinį, pasirinkite Shortcut to file. 
 

5.   Jei norite atidaryti nuorodą paspaudę piktogramą, pasirinkite Corner icon. 
 

ARBA 
 

Jei norite atidaryti nuorodą paspaudę bet kur ant objekto, pasirinkite Object. 
 

6.   Spauskite OK. 
 

Jei pasirinkote Corner icon, atsiras  piktograma apatiniame kairiame objekto kampe. 
 

 

Nuorodos pridėjimas į priedą 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Link. 
 

Atsiras Insert Link dialogo langelis. 
 

3.   Spauskite Current Attachments,  tuomet pasirinkite priedą iš sąrašo. 
 

4.   Jei norite atidaryti nuorodą paspaudę piktogramą, pasirinkite Corner icon. 
 

ARBA 
 

Jei norite atidaryti nuorodą paspaudę bet kur ant objekto, pasirinkite Object. 
 

5.   Spauskite OK. 
 

Jei pasirinkote Corner icon, atsiras  piktograma apatiniame kairiame objekto kampe. 
 

 

Nuorodos pašalinimas 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Link. 
 

Atsiras Insert Link dialogo langelis. 
 

3.   Spauskite Remove Link. 
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Garsų pridėjimas prie objektų 
Galite pridėti garsą prie bet kokio objekto  (išskyrus Adobe Flash grotuvo failus ir valdiklius) pridėdami 

garso failą arba įrašydami garsą kompiuterio mikrofonu. Jūs galite paleisti garsą pamokos metu paspaudę 

piktogramą objekto kampe ar ant pačio objekto. 

 
 

PASTABA 
 

SMART Notebook programinė įranga palaiko MP3 garso formatą. 
 

 
 

Garso failo pridėjimas prie objekto 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Sound. 
 

Atsiras dialogo langelis. 
 

3.   Spauskite Browse (Windows operacinėse sistemose). Atsiras Insert File dialogo langelis. OS X 

operacinių sistemų atveju, spauskite Choose File. Atsiras Open dialogo langelis. 
 

4.   Pasirinkite garso failą, tuomet spauskite Open. 
 

5.   Pasirinkite Corner Icon, jei norite paleisti garso failą paspaudus piktogramą apatiniame kairiame 

objekto kampe. 
 

ARBA 
 

Pasirinkite Object, jei norite paleisti garso failą paspaudus bet kur ant objekto. 
 

6.   Spauskite Attach Sound. 
 
 

Įrašyto garso pridėjimas prie objekto 
 

1.   Prijunkite mikrofoną prie kompiuterio ir įjunkite. 
 

2.   Pasirinkite objektą. 
 

3.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Sound. 
 

Atsiras dialogo langelis. 
 

4.   Spauskite Start Recording. 
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5.   Įrašykite garsą mikrofonu. 

 
SVARBU 

 

SMART Notebook programinė įranga sustabdo įrašymą po vienos minutės. Taigi, įsitikinkite, kad 

garsas nėra ilgesnis nei minutė. 

 
6.   Spauskite Stop Recording. 

 

7.  Įrašykite garso pavadinimą Recording name langelyje. 
 

8.   Pasirinktinai, spauskite Preview Recording, kad perklausytumėte garsą prieš pridėdami jį prie objekto. 
 

9.   Pasirinkite Corner Icon, jei norite paleisti garso failą paspaudus piktogramą apatiniame kairiame 

objekto kampe. 
 

ARBA 
 

Pasirinkite Object, jei norite paleisti garso failą paspaudus bet kur ant objekto. 
 

10.   Spauskite Attach Recording. 
 
 

Garso pašalinimas nuo objekto 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Sound. 
 

Atsiras dialogo langelis. 
 

3.   Spauskite Remove Sound. 
 
 

Objektų animacijų kūrimas 
Galite sukurti objektų animacijas,  kurios galėtų nuskristi iš vienos puslapio pusės į kitą, suktis, išblėsti, 

sumažėti ir daugiau. Galite nustatyti, kad animacija prasidėtų jums atidarius puslapį arba paspaudus objektą. 
 
 

Objekto animacijos kūrimas 
 

1.   Pasirinkite objektą. 
 

2.   Jei savybių kortelė nėra matoma, spauskite Properties . 
 

3.   Spauskite Object Animation. 
 

4.   Pasirinkite versijas Type, Direction, Speed, Occurs ir Repeats išplečiamame sąraše. 
 
 

Objektų užrakinimas 
Jūs galite užrakinti objektą užkirsdami kelią jo pasikeitimui, judėjimui ar sukimuisi. Taip pat galite apriboti 

objektą, kad jis judėtų vertikaliai ar horizontaliai, leisti judėti ar suktis daugiau. 
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Šį užraktą pašalinti galite bet kuriuo metu. 

 
 

Objekto užrakinimas 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Lock > Lock in Place. 
 

Negalėsite objekto judinti, sukti ar keisti, kol neatrakinsite. 

 
PASTABA 

 

Jei paspausite užrakintą objektą, vietoje meniu rodyklės atsiras užrakto piktograma . 
 

 
 

Objekto užrakinimas leidžiant jam judėti 

 
1.   Pasirinkite objektą. 

 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Lock > Allow Move. 
 

Jūs galėsite judinti objektą, bet negalėsite jo sukti ar keisti, kol neatrakinsite. 

 
PASTABA 

 

 Jei paspausite užrakintą objektą, vietoje meniu rodyklės atsiras užrakto piktograma . 
 

 
 

Objekto užrakinimas leidžiant jam judėti vertikaliai 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Lock > Allow Vertical Move. 
 

Jūs galėsite judinti objektą vertikaliai, bet negalėsite jo sukti ar keisti, kol neatrakinsite. 

 
PASTABA 

 

 Jei paspausite užrakintą objektą, vietoje meniu rodyklės atsiras užrakto piktograma . 

http://www.smarttech.com/kb/171309


6 SKYRIUS 

PAMOKOS VEIKLOS KŪRIMAS 

115 smarttech.com/kb/171309 

 

 

 
 
 

Objekto užrakinimas leidžiant jam judėti horizontaliai 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Lock > Allow Horizontal Move. 
 

 Jūs galėsite judinti objektą horizontaliai, bet negalėsite jo sukti ar keisti, kol neatrakinsite. 

 

 
PASTABA 

 

 Jei paspausite užrakintą objektą, vietoje meniu rodyklės atsiras užrakto piktograma . 
 

 
 

To Objekto užrakinimas leidžiant judėti ir suktis 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto meniu rodyklę, tuomet pasirinkite Lock > Allow Move and Rotate. 
 

 Jūs galėsite judinti ir sukti objektą, bet negalėsite jo keisti, kol neatrakinsite. 

 
PASTABA 

 

 Jei paspausite užrakintą objektą, vietoje meniu rodyklės atsiras užrakto piktograma . 
 

 
 

Objekto atrakinimas 
 

1.   Pasirinkite objektą. 
 

2.   Spauskite objekto užrakto piktogramą  , tuomet pasirinkite Unlock.
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Apžvalga  
Naudokite SMART lab pagyvinti savo pamokoms kuriant ir pridedant  interaktyvias veiklas. Šios 

veiklos padeda mokiniams įsiminti sąvokas ir faktus, nustatyti objektus, išmokti žodyno apibrėžimus 

ir daugiau. 
 
 

PASTABOS 
 

l  Būtina prisijungti norint kurti ir žaisti su kai kuriomis SMART lab veiklomis, o SMART Notebook 18 

programinė įranga leidžia jums prisijungti su Google™ ar Microsoft paskyra. Jei prisijungsite su 

viena iš šių paskyrų, jums nereikės prisijungti kitą kartą norint naudoti SMART response 2, Shout It 

Out! ar Monster Quiz. Daugiau informacijos pateikta Paskyros prisijungimas. 
 

l  Mokiniai gali būti pašalinti iš veiklos su SMART lab mokinių pašalinimo funkcija. 
 
 

Vaizdo įrašai apie veiklos nustatymą ar naudojimą pateikta default.htm. 
 
 

Naršyklės, įrenginio, operacinės sistemos ir tinklo rekomendacijos 
 
 

PASTABA 
 

Mokiniai gali pasitikrinti svetainės prieigą http://classlab.com/connection/check.html. 
 

 
Naršyklės 

rekomendacijos 

l  Google  Chrome™ 33 ar naujesnės 
 

l  Firefox® 38 ar naujesnės 
 

l  Microsoft Internet Explorer® 11 
 

l  Microsoft Edge 
 

Įrenginio 

operacinės sistemos 

rekomendacijos 

l  Windows® 7 ar naujesnė operacinė sistema 
 

l  iOS 8 ar naujesnė operacinė sistema 
 

l  Android™ 4.2 ar naujesnė operacinė sistema 
 

l  Naujausia Chrome OS™ operacinė sistema 

 
SVARBU 

 

Veiklų, kurių metu naudojami mobilieji įrenginiai, šiuo metu pirmoji iPad 

ar Samsung Galaxy Tab 3 karta palaikyti negali. 

http://www.smarttech.com/kb/171309
http://classlab.com/connection/check.html


119 smarttech.com/kb/171309 

7 SKYRIUS 

SMART LAB NAUDOJIMAS 

 

 

 
 
 

Tinklo 

rekomendacijos 

SMART lab veiklos, esančios classlab.com, yra skirtos išlaikyti tinklo reikalavimus 

kuo mažesnius, tuo pačiu palaikant vertingą sąveiką. Tinklo rekomendacijos Shout 

It Out! yra 0.3 Mbps vienam įrenginiui. Mokykla, kuri dažniausiai naudoja kitus 

Web 2.0 įrenginius, turėtų turėti tinkamą tinklą SMART lab veiklų veikimui 

classlab.com. Jei SMART lab veiklos, esančios classlab.com, yra naudojamos kartu 

su kitais internetiniais ištekliais, pavyzdžiui leidžiamos medijos, būtinas didesnis 

tinklo pajėgumas, priklausomai nuo kitų naudojamų išteklių. 
 

 
 
 

Svetainės prieigos reikalavimai 
Norint užtikrinti, kad visiems mokiniams SMART lab veiklos veiks tinkamai, pridėkite šiuos URL į 

tinklo baltąjį sąrašą. 

 

l  https://www.classlab.com 
 

l  http://id.smarttech-prod.com 
 

l  https://content.smarttech-prod.com 
 

l  https://metric.smarttech-prod.com 
 

l  https://google.com 
 

l  http://google-analytics.com 
 

l  https://www.gstatic.com (naudojamas Google įkelti reCAPTCHA) 
 

l  https://*.firebaseio.com 
 

l  https://*.cloudfront.com 
 

l  https://entitlement.smarttech-prod.com 
 

 
 
 

Žaidimo elementų ir įjungto įrenginio 

pridėjimas prie SMART lab veiklos 
Mokytojai ir mokiniai gali pridėti žaidimų elementus ir papildymus iš įrenginių į beveik visas 

SMART lab veiklas. Daugiau informacijos pateikta Žaidimo elemento pridėjimas prie veiklos ir Mokinių 

papildymų iš įrenginio pridėjimas prie veiklos. 
 

 
 

Flip Out veiklos kūrimas ir pridėjimas 
Flip Out kortelės moko bendravimo vienas su kitu, lavina atmintį ir žodyną. Kai kuriate Flip Out atverčiamų 

kortelių veiklą, galite naudoti kiek norite kortelių ir rinktis iš įvairių temų, tokių kaip kosmosas, džiunglės ar 

pabaisos. 

http://www.smarttech.com/kb/171309
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PATARIMAS 

 

l  Garso mygtuku  įjunkite ir išjunkite veiklos garsą. 
 

l  Naudokite veiklos perkrovimo  mygtuką iš naujo paleisti įjungtą veiklą. Šis mygtukas yra 

SMART lab veiklos puslapio viršuje dešinėje. 
 

l  Naudokite veiklos redagavimo  mygtuką atidaryti Add Activity dialogo langelį. Šis mygtukas yra 

SMART lab veiklos puslapio viršuje dešinėje. 
 

 
 

Flip Out atverčiamų kortelių veiklos pridėjimas 
 

1.   Atidarykite SMART lab paspaudę piktogramą  SMART Notebook įrankių juostoje. 
 

Atsidarys Select an Activity kūrimo vedlys. 
 

2.   Suraskite Flip Out veiklą ir spauskite veiklos piktogramą. 
 

3.   Įveskite tekstą ir paspauskite ant paveiksliuko piktogramos , kad pridėtumėte paveiksliuką 

Facing Up ir Facing Down laukuose. 

Galite sukurti kiek norite kortelių. Jei sukursite daugiau nei 12 kortelių, papildomos kortelės bus 

SMART Notebook darbalaukio viduryje, kartu su išmetimo krūva. Kortelių išdėstymas yra atsitiktinis. 

 

 
PATARIMAS 

 

Norint naudoti paveiksliuką atverčiamų kortelių veikloje, spauskite paveiksliuko piktogramą  

Add Content dialogo langelyje. Pasirinkite paveiksliuką iš atitinkamo Windows Explorer (Windows 

operacinėse sistemose) ar Finder (OS X operacinėse sistemose) aplanko paspaudę Open. 

Paveiksliukas atsiras Card back arba Card face sąraše ir ant atverčiamų kortelių. 

 

 

4.   Spauskite Next. 
 

Atsidarys Select a Theme dialogo langelis. 
 

5.   Pasirinkite temą, tuomet spauskite Finish. 
 

SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. 
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6.   Norėdami prie veiklos pridėti garsinį mygtuką, laikmatį ar atsitiktinį žaidimo elementą, spauskite . 
 

Daugiau informacijos pateikta „Žaidimo elemento pridėjimas prie veiklos“. 
 

Mokiniai taip pat gali naudoti savo įrenginius ir dalyvauti Super Sort veiklose. Daugiau 

informacijos pateikta „Mokinių papildymų iš įrenginio pridėjimas prie veiklos“. 
 

7.  Paprašykite mokinių atversti korteles ir atskleisti, kas yra kitoje jų pusėje. Pavyzdžiui, ant kortelės 

nugarėlės gali būti parašyta bėgti, o kitoje kortelės pusėje gali būti parašyta veiksmažodis. Atvertus 

kortelę ir aptarus turinį, galite nuvilkti kortelę į išmetimo krūvą. 

 
 

 

Super Sort veiklos kūrimas ir pridėjimas 
Super Sort moko klasifikuoti ir grupuoti.  Super Sort veiklos metu, mokiniai rūšiuoja objektus į dvi 

kategorijas. Objektas išnyksta, jei mokinys pasirenka teisingą kategoriją, objektas yra grąžinamas atgal, jei 

mokinys pasirenka neteisingą kategoriją. Pridėkite papildomų žaidimų elementų, kad veikla taptų dar 

įdomesnė. 

 

Norint užtikrinti vertingiausią galimą patirtį naudojant Super Sort, žiūrėkite „Įrenginio ir 

tinklo reikalavimai“. 
 
 

Super Sort grupavimo veiklos pridėjimas 
 

1.   Atidarykite SMART lab paspaudę piktogramą  SMART Notebook įrankių juostoje. 
 

Atsidarys Select an Activity kūrimo vedlys. 
 

2.   Suraskite Super Sort veiklą ir spauskite veiklos piktogramą. 
 

Atsidarys Super Sort Add Content dialogo langelis. 
 

3.   Required Category Name laukuose įrašykite pavadinimą, kurį norite naudoti kiekvienai kategorijai. 
 

4.   Įrašykite tekstą ar paspauskite paveiksliuko piktogramą , kad pridėtumėte paveiksliuką į kiekvieną 

kategoriją. Galite įvesti iki 10 porų. 
 

5.   Enter text or add image, įrašykite kategorijos turinį, pasirinkite paveiksliuką arba spauskite turinio 

valdymo piktogramą , kad pridėtumėte kategorijos turinį iš anksčiau išsaugoto sąrašo. 
 

6.   Spauskite Next. 
 

Atsidarys Select a Theme dialogo langelis. 
 

7.  Pasirinkite Super Sort temą. Pasirinkta veikla bus paryškinta mėlyna juosta. 
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8.   Spauskite Finish. 
 

SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. 
 

9.   Norėdami prie veiklos pridėti garsinį mygtuką, laikmatį ar atsitiktinį žaidimo elementą, spauskite . 
 

Atsidarys Game element selektorius. 
 

10.   Jei norite, pasirinkite žaidimo elementą. Žaidimo elementas atsiras veikloje. Daugiau informacijos 

pateikta „Žaidimo elemento pridėjimas prie veiklos“. 

Mokiniai gali dirbti po vieną arba komandomis ir paskirstyti turinį pagal skirtingas kategorijas. 

Mokiniai taip pat gali naudoti savo įrenginius ir dalyvauti Super Sort veiklose. Daugiau 

informacijos pateikta „Mokinių papildymų iš įrenginio pridėjimas prie veiklos“. 
 

 
 
 

Match ‘Em Up! veiklos kūrimas ir pridėjimas 
Match ‘Em Up! yra derinimo veikla, kuri lavina atmintį ir skatina rasti ryšį tarp objektų. Pridėkite papildomų 

žaidimų elementų, kad veikla taptų dar įdomesnė. 
 
 

Match ‘Em Up! veiklos pridėjimas 
 

1.   Atidarykite SMART lab paspaudę piktogramą  SMART Notebook įrankių juostoje. 
 

Atsidarys Select an Activity kūrimo vedlys. 
 

2.   Suraskite Match ‘Em Up veiklą ir spauskite veiklos piktogramą. 
 

Atsidarys Match ‘Em Up Add Content dialogo langelis. 
 

3.   Optional Category Name laukuose įrašykite pavadinimą, kurį norite naudoti kiekvienai kategorijos 

porai. 
 

4.   Įrašykite tekstą ar paspauskite paveiksliuko piktogramą , kad pridėtumėte paveiksliuką į kiekvieną 

kategoriją. Galite įvesti iki 10 porų. 
 

5.   Check Answers dalyje, prasirinkite Instantly, kad iš karto būtų rodoma, ar atsakymai yra teisingi. 
 

ARBA 
 

6.   Pasirinkite When Prompted, kad patikrintumėte atsakymus, kai norėsite. Kadangi atsakymai yra 

įvedami į veiklą, Check Matches mygtukas atsiranda veikloje. Spauskite mygtuką, kai norėsite 

patikrinti atsakymą. 
 

Jei atsakymas teisingas,  atsiras šalia jo. Jei atsakymas neteisingas, atsiras .. 
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7.  Spauskite Next. 
 

Atsidarys Match ‘Em Up! Select a Theme dialogo langelis. 
 

8.   Pasirinktie temą, tuomet spauskite Finish. 
 

SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. 
 

9.   Norėdami prie veiklos pridėti garsinį mygtuką, laikmatį ar atsitiktinį žaidimo elementą, spauskite . 
 

Atsidarys Game element selektorius. 
 

10.   Jei norite, pasirinkite žaidimo elementą. Žaidimo elementas atsiras veikloje. Daugiau informacijos 

pateikta „Žaidimo elemento pridėjimas prie veiklos“. 
 

Mokiniai taip pat gali naudoti savo įrenginius ir dalyvauti Super Sort veiklose. Daugiau 

informacijos pateikta „Mokinių papildymų iš įrenginio pridėjimas prie veiklos“. 
 

Mokiniai gali dirbti po vieną arba komandomis ir paskirstyti turinį pagal skirtingas kategorijas. 

 
PATARIMAS 

 

Norint naudoti paveiksliuką veiklos metu, paspauskite paveiksliukų aplanko piktogramą   bet 

kuriame turinio sąraše. Pasirinkite paveiksliuką, tuomet spauskite Open. Paveiksliukas atsiras 

turinio sąraše. Nors galite sukurti kiek norite objektų, tik pirmi 10 bus naudojami veiklos metu. 

Sukurkite bent du atitikmenis, kad galėtumėte tęsti. 
 
 
 

 

Fill In the Blanks veiklos kūrimas ir pridėjimas 
Fill In the Blanks yra linksma veikla, kurios metu mokiniai velka žodžius ar skaičius į tarpus. Parašykite 

sakinį su daugiausia dešimt tuščių tarpų, tuomet paprašykite mokinių vilkti žodžius per lentą ir užpildyti 

trūkstamą informaciją, kuri tinka tuose tarpuose. 

 
 

Fill In the Blanks veiklos pridėjimas 
 

1.   Atidarykite SMART lab paspaudę piktogramą  SMART Notebook įrankių juostoje. 
 

Atsidarys Select an Activity kūrimo vedlys. 
 

2.   Suraskite Fill in the Blanks veiklą ir spauskite veiklos piktogramą. 
 

Atsidarys Fill in the Blanks Add Content dialogo langelis. 
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3.   Edit text srityje įrašykite norimą tekstą. Galite naudoti iki 300 ženklų. 

Ženklų skaičiuotuvas parodys, kiek ženklų jums liko. Tarpus nustatysite kitame žingsnyje. 
 

4.   Check Answers dalyje, prasirinkite Instantly, kad iš karto būtų rodoma, ar atsakymai yra teisingi. 
 

ARBA 
 

Pasirinkite When Prompted, kad patikrintumėte atsakymus, kai norėsite. Kadangi atsakymai yra 

įvedami į veiklą, Check Matches mygtukas atsiranda veikloje. Spauskite mygtuką, kai norėsite 

patikrinti atsakymą. 
 

ARBA 
 

Pasirinkite Don’t check. Atsakymai nebus tikrinami. 
 

5.   Spauskite Define Blanks. 
 

Atsidarys Define Blanks dialogo langelis su jūsų tekstu. 
 

6.   Pasirinkite, kur turi būti tarpai, paspausdami ant žodžio. Naudokite dydžio keitimo rankenėles tarpams 

padidinti arba sumažinti. 

 
 

Norėdami pašalinti tarpą, dar kartą jį paspauskite. 
 

7.  Spauskite Next. 
 

Atsidarys Fill in the Blanks Select a Theme dialogo langelis. 
 

8.   Pasirinktie temą, tuomet spauskite Finish. 
 

SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. Atsiras sakinys ir žodžių 

tarpai. 
 

9.   Norėdami prie veiklos pridėti garsinį mygtuką, laikmatį ar atsitiktinį žaidimo elementą, spauskite . 
 

Atsidarys Game element selektorius. 
 

10.   Jei norite, pasirinkite žaidimo elementą. Žaidimo elementas atsiras veikloje. Daugiau informacijos 

pateikta „Žaidimo elemento pridėjimas prie veiklos“. 
 

Mokiniai gali dirbti po vieną arba komandomis ir nuvilkti teisingus žodžius ar skaičius į 

atitinkamus tarpus. 
 

Mokiniai taip pat gali naudoti savo įrenginius ir dalyvauti Super Sort veiklose. Daugiau 

informacijos pateikta „Mokinių papildymų iš įrenginio pridėjimas prie veiklos“. 
 

11.   Spauskite atsakymų patikrinimo mygtuką, kuris atsiras užbaigus veiklą. 
 

Jei atsakymas teisingas,  atsiras šalia jo. Jei atsakymas neteisingas, atsiras .. 
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Label Reveal veiklos kūrimas ir pridėjimas 
Label Reveal veikla yra puikus būdas mokiniams geriau suprasti sistemą ir jos sudedamąsias dalis. Label 

Reveal sutelkia dėmesį į atmintį ir atskaitymą. 
 
 

Label reveal veiklos pridėjimas 
 

1.   Atidarykite SMART lab paspaudę piktogramą  SMART Notebook įrankių juostoje. 
 

Atsidarys Select an Activity kūrimo vedlys. 
 

2.   Suraskite Label Reveal veiklą ir spauskite veiklos piktogramą. 
 

Atsidarys Label Reveal Add Content dialogo langelis. 
 

3.   Vilkite paveiksliuką iš darbalaukio į kvadratinį langą veikos dialogo lange. 
 

ARBA 
 

Spauskite  piktogramą ir pasirinkite paveiksliuką. Kurį išsaugojote kompiuteryje. 

Paveiksliukas atsiras Label Reveal Add Content dialogo langelyje. 

4.   Paspauskite ant paveiksliuko, kad pridėtumėte žymas. 
 

Atsidarys žymų langelis ir žymų redagavimo įrankis . 
 

5.   Perkelkite žymą į paveiksliuką dalį, kurią norite pažymėti. 
 

Spauskite Change Style ir pakeiskite žymų rodyklių tipą ir spalvą. 
 

6.   Įrašykite trumpą žymos aprašymą. Spauskite žemyn nukreiptą rodyklę po žyma ir įrašykite 

pastabą iki 150 ženklų. 
 

Spauskite Done, kai norėsite uždaryti pastabų langą. 
 

7.  Pridėkite kiek norite žymų, tuomet spauskite Finish. 
 

SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. Kiekviena žyma bus rodoma 

kaip klaustuko piktograma , kol jos nepaspausite. Tuomet bus rodomas žymos pavadinimas. 

 
 

 
Daugiau informacijos pateikta „SMART lab veiklos nustatymas“. 
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8.   Norėdami prie veiklos pridėti garsinį mygtuką, laikmatį ar atsitiktinį žaidimo elementą, spauskite . 
 

Atsidarys Game element selektorius. 
 

9.   Pasirinkite žaidimo elementą. Žaidimo elementas atsiras veikloje. Daugiau informacijos pateikta 

„Žaidimo elemento pridėjimas prie veiklos“. 
 

Mokiniai taip pat gali naudoti savo įrenginius ir dalyvauti Super Sort veiklose. Daugiau 

informacijos pateikta „Mokinių papildymų iš įrenginio pridėjimas prie veiklos“. 
 

10.   Paprašykite mokinių nustatyti ir atskleisti žymų dalis, kai jas aptariate. 
 

 
 
 

Rank Order veiklos kūrimas ir pridėjimas 
Rank Order veiklos metu, mokiniai išdėsto objektus pagal tvarką ir mokosi apie palyginimus, 

atskaitymus, seką ir išdėstymą. Pabandykite išdėstyti skaičius nuo mažiausio iki didžiausio, 

mokslinės procedūros žingsnius ar kitus norimus objektus pagal seką. 
 
 

Rank Order veiklos pridėjimas 
 

1.   Atidarykite SMART lab paspaudę piktogramą  SMART Notebook įrankių juostoje. 
 

Atsidarys Select an Activity kūrimo vedlys. 
 

2.   Suraskite Rank Order veiklą ir spauskite veiklos piktogramą. 
 

Atsidarys Rank Order Add Content dialogo langelis. 
 

3.   Įrašykite tekstą ar paspauskite paveiksliuko piktogramą , kad pridėtumėte paveiksliuką. Galite 

pridėti dešimt objektų. 
 

4.   Spauskite  , kad apsuktumėte teksto objektų tvarką. 
 

5.   Check Answers dalyje, prasirinkite Instantly, kad iš karto būtų rodoma, ar atsakymai yra teisingi. 
 

ARBA 
 

Pasirinkite When Prompted, kad patikrintumėte atsakymus, kai norėsite. Kadangi atsakymai yra 

įvedami į veiklą, Check Matches mygtukas atsiranda veikloje. Spauskite mygtuką, kai norėsite 

patikrinti atsakymą. 
 

ARBA 
 

Pasirinkite Don’t check. Atsakymai nebus tikrinami. 

6.   Ranking Labels dalyje įveskite terminus, kuriuos norėtumėte naudoti tvarkos nurodymui, 

pavyzdžiui pirmas ir paskutinis. 
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7.  Spauskite Next. 
 

Atsidarys Rank Order Select a Theme dialogo langelis. 
 

8.   Pasirinktie temą, tuomet spauskite Finish. 
 

SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. 
 

9.   Norėdami prie veiklos pridėti garsinį mygtuką, laikmatį ar atsitiktinį žaidimo elementą, spauskite . 
 

Atsidarys Game element selektorius. 
 

10.   Jei norite, pasirinkite žaidimo elementą. Žaidimo elementas atsiras veikloje. Daugiau informacijos 

pateikta „Žaidimo elemento pridėjimas prie veiklos“. 
 

Mokiniai taip pat gali naudoti savo įrenginius ir dalyvauti Super Sort veiklose. Daugiau 

informacijos pateikta „Mokinių papildymų iš įrenginio pridėjimas prie veiklos“. 
 

 Nors galite sukurti kiek norite objektų, tik pirmi 10 bus naudojami veiklos metu. 

 
PATARIMAS 

 

Norint naudoti paveiksliuką veiklos metu, grįžkite į Rank Order Add Content dialogo langelį ir 

paspauskite paveiksliukų aplanko piktogramą  turinio sąraše. Pasirinkite paveiksliuką, tuomet 

spauskite Open. Paveiksliukas atsiras turinio sąraše. 

 
11.   Paprašykite mokinių išdėstyti objektus teisinga tvarka iš viršaus į apačią. Kai objektai bus išdėstyti 

teisingai, jie šiek tiek pajuda, nurodydami užbaigimą. 
 
 

PATARIMAI 
 

l  Žalia varnelė  arba raudonas iksas  atsiras šalia kiekvieno atsakomo nurodant, kuris yra 

teisingas ir kuris neteisingas. Tvarką galimą keisti, kol visi atsakymai taps teisingi. 
 

l  Jei pasirinkote Check answers right away, atsakymai bus patikrinti iškarto pateikus. Teisingi 

atsakymai bus priimti, o neteisingi atsakymai bus atmesti. 

l  Jei pasirinkote Check answers after students have finished, atsakymai bus patikrinti visiems 

mokiniams atsakius į klausimus, suteikiant laiko diskusijai. 
 

 
 
 
 

Speedup veiklos kūrimas ir pridėjimas 
Speedup yra lenktyniavimo viktorina su keliais atsakymų pasirinkimais ir teisingais arba neteisingais 

klausimais. Mokiniams patiks konkuruoti ir pasižiūrėti, kas greičiau atsakys į klausimus naudojant 

Speedup veiklą. Speedup skatina konkurenciją ir greitą mąstymą. 
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Speedup veiklos pridėjimas 
 

1.   Atidarykite SMART lab paspaudę piktogramą  SMART Notebook įrankių juostoje. 
 

Atsidarys Select an Activity kūrimo vedlys. 
 

2.   Suraskite Speedup veiklą ir spauskite veiklos piktogramą. 
 

Atsidarys Add Content dialogo langelis. 
 

3.   Pasirinkite tarp Multiple Choice ir True or False norimos sukurti viktorinos tipą. 
 
 

Kelių variantų formatas 
 

4.   Pasirinkus Multiple Choice formatą, įrašykite klausimą. Galite naudoti iki 150 ženklų vienam 

klausimui. 
 

5.   Įrašykite bent du atsakymus į klausimą, kurį įrašėte 4 žingsnyje, ir paspauskite mygtuką šalia teisingo 

atsakymo. Varnelė  rodo atsakymą. 
 

6.   Spauskite Add Question  ir įrašykite daugiau klausimų ir atsakymų. 
 

7.  Užbaigę klausimų ir atsakymų įrašymą, spauskite Next. 
 

Atsidarys Review Content dialogo langelis. Galėsite redaguoti klausimus ir atsakymus, nustatyti 

laiko terminą, per kurį reikia atsakyti į klausimą. 
 

Paspauskite ant klausimų ar atsakymų, jei norite juos redaguoti. 
 

Jei norite nustatyti laiko terminą klausimo atsakymui, paspauskite Time limit mygtuką ir nustatykite 

sekundžių skaičių, skirtą atsakyti kiekvienam klausimui. 
 

8.   Spauskite Finish. 
 

SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. 
 
 

 True or False formatas 
 

9.   Pasirinkę Tiesa ar melas formatą, įrašykite klausimą. Galite naudoti iki 150 ženklų vienam 

klausimui. 
 

10.   Spauskite mygtuką šalia True or False ir nurodykite teisingą atsakymą į klausimą. Varnelė  

rodo atsakymą. 
 

11.   Spauskite Add Question  ir įrašykite daugiau klausimų ir atsakymų. 
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12.   Užbaigę klausimų ir atsakymų įrašymą, spauskite Next. 
 

Atsidarys Review Content dialogo langelis. Galėsite redaguoti klausimus ir atsakymus, nustatyti 

laiko terminą, per kurį reikia atsakyti į klausimą. 
 

Paspauskite ant klausimų ar atsakymų, jei norite juos redaguoti. 
 

Jei norite nustatyti laiko terminą klausimo atsakymui, paspauskite Time limit mygtuką ir nustatykite 

sekundžių skaičių, skirtą atsakyti kiekvienam klausimui. 
 

13.   Spauskite Finish. 
 

SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. 
 
 

PASTABA 
 

Žaidimo elementų negalima pridėti į Speedup veiklą. 
 

 
 

Speedup veiklos žaidimas 
 

1.   Atidarę veiklą, spauskite Start. 
 

2.   Pasirinkite lenktynininkų skaičių nuo vieno iki keturių. Daugiausia gali lenktyniauti keturi 

lenktynininkai, bet dalyvauti gali ir kiti mokiniai. 
 

3.   Pasirinkite lenktynininko pseudoportretą   ir spauskite varnelę, patvirtindami savo 

pasirinkimą. Jūs turėsite 15 sekundžių pseudoportreto pasirinkimui. Nepasirinkus jokio 

pseudoportreto, jie bus parinkti automatiškai ir lenktynės prasidės. 
 

4.   Kai lenktynės prasidės, greitai spauskite Racer control arrow, kad padidintumėte greitį  . 

5.   Įvairiuose lenktynės trasos taškuose bus užduodami klausimai. Lenktynininkai pasirenka raidę, kuri 

atitinka teisingą atsakymą su savo valdikliais. 
 

6.   Užbaigus lenktynes, laimėjusio lenktynininko pseudoportretas  bus rodomas rezultatų lange, laiko 

rezultatai bus rodomi sekundėmis prie kiekvieno lenktynininko pseudoportreto. Spauskite Review 

answers, kad matytumėte visus atsakymus. Press Show Players peržiūrėti kiekvieno lenktynininko 

pseudoportretą. 

 
 

 

Shout It Out! veiklos kūrimas ir pridėjimas  
Mokiniai naudoja Shout It Out! greitai sukurti ir papildyti tekstą bei paveiksliukus SMART lab turinio 

kūrimo veiklų metu naudodami savo įrenginių interneto naršykles, o mokytojai gali lengvai tvarkyti 

turinį. Naudokite kaip smegenų šturmo veiklą idėjoms generuoti. 
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Norint užtikrinti vertingiausią galimą patirtį naudojant Super Sort, žiūrėkite „Įrenginio ir tinklo 

reikalavimai“. 
 
 

SVARBU 
 

Jei naudojate bandomąją SMART Notebook programinės įrangos versiją, galite gauti reCaptcha 

įspėjimą. Patvirtinkite bandomąją versiją, kad galėtumėte naudoti Shout It Out!. Daugiau informacijos 

pateikta „Shout It Out! naudotojo patvirtinimas“. 
 

 
 

Shout It Out! veiklos pridėjimas 
 

1.   Atidarykite SMART lab paspaudę piktogramą   SMART Notebook įrankių juostoje. 
 

Atsidarys Select an Activity kūrimo vedlys. 
 

2.   Suraskite Shout It Out! veiklą ir spauskite veiklos piktogramą. 
 

Atsidarys Shout It Out! Add Content langas. Pasirinkite norimą naudoti papildymų formatą. Galite 

pasirinkti tarp Randomized arba Categories. 
 

Jei pasirinkote Categories mokinių papildymų paskirstymui, šiai veiklai reikia bent dviejų 

kategorijų. Pavadinkite kategorijas, kuriose bus mokinių turinys. 
 

3.   Contributions dalyje pasirinkite Text ar Images pagal mokinių papildymų tipą; tuomet įrašykite 

didžiausią galimą papildymų skaičių vienam įrenginiui. 
 

4.   Student Names dalyje pasirinkite, ar norėtumėte rodyti arba slėpti mokinių vardus. 
 

5.   Spauskite Finish. 
 

SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. Norint pradėti veiklą ir leisti 

mokiniams papildyti, žiūrėkite „Mokinių teksto pridėjimas“ ir „Mokinių paveiksliukų pridėjimas“. 
 

6.   Norėdami prie veiklos pridėti garsinį mygtuką, laikmatį ar atsitiktinį žaidimo elementą, spauskite . 
 

Atsidarys Game element selektorius. 
 

7.  Jei norite, pasirinkite žaidimo elementą. Žaidimo elementas atsiras veikloje. Daugiau informacijos 

pateikta „Žaidimo elemento pridėjimas prie veiklos“. 
 
 

Shout It Out! veiklos pradėjimas naudojant mokinių įrenginius 
 

1.   Sukūrę Shout It Out! veiklą, patvirtinkite, kad papildymų ir mokinių vardų nustatymai yra teisingi. 
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2.   Spauskite Finish. 
 

Atsiras SMART lab mokinių papildymų veiklos dialogo langelis. Jame yra classlab.com URL, kurį 

mokiniai įves į savo įrenginių naršykles, o suteiktą veiklos ID numerį mokiniai įrašys classlab.com 

tinklapyje. 
 

Veiklos piktograma taps mėlyna  , parodant, kad vyksta prisijungimo procesas. 
 

Daugiau informacijos pateikta „Mokinių įrenginių pridėjimas prie veiklos“. 
 

3.   Paprašykite mokinių eiti į classlab.com ir įvesti veiklos ID numerį bei savo vardus. 

Mokiniai bus prisijungę prie veiklos. 
 

Mokinių papildymai atsiras SMART Notebook SMART lab puslapyje. 
 
 

PASTABA 
 

Norint ištrinti papildymą, vilkite jį į šiukšlinę SMART lab veiklos puslapio viršuje kairėje. Ištrynus 

papildymą, jo atkurti nebegalima. 
 
 
 
 

Shout It Out! naudotojo patvirtinimas 
Jei jūs naudojate bandomąją SMART Notebook mokymosi bendradarbiaujant programinės įrangos 

versiją, jūs galite gauti reCaptcha įspėjimą, atidarę SMART lab Shout It Out! Pirmą kartą. 
 

 
 
 

Jei gausite šį įspėjimą, turėsite patvirtinti bandomąją versiją, tuomet Shout It Out! Funkcijos veiks. 

Užsiregistravus bandomajai versijai, nebegausite reCaptcha įspėjimų. 
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Bandomosios versijos naudotojo patvirtinimas 
 

1.   Jei gavote reCaptcha įspėjimą SMART lab mokinių papildymų veiklos dialogo langelyje, 

pažymėkite I’m not a robot langelį. 
 

Atsiras paveiksliukų klausimynas. 
 

 
 

2.   Užbaikite klausimyną ir spauskite Verify. 
 

Jei atsakysite į klausimus teisingai, žalia varnelė atsiras I’m not a robot langelyje. 
 

3.   Spauskite Start Activity norėdami pradėti Shout It Out! veiklą. 
 

 
 

Interneto naršyklės, įrenginio operacinės sistemos rekomendacijos ir tinklo 

rekomendacijos 
 
 

PASTABA 
 

Naudojant SMART lab veiklas classlab.com, mokiniai gali pasitikrinti svetainės prieigą 

http://classlab.com/connection/check.html. 
 

 
Naršyklės 

rekomendacijos 

l  Google  Chrome 33 ar tolesnės 
 

l  Firefox 38 ar tolesnės 
 

l  Internet Explorer11 
 

l Edge 
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Įrenginio 

operacinės sistemos 

rekomendacijos 

l  Windows 7 operacinė sistema ar naujesnė 
 

l  iOS 8 operacinės sistemos ar naujesnės 
 

l  Android 4.4.2 operacinė sistema ar naujesnė 

 

Tinklo 

rekomendacijos 

SMART lab veiklos, esančios classlab.com, yra skirtos išlaikyti tinklo reikalavimus 

kuo mažesnius, tuo pačiu palaikant vertingą sąveiką. Tinklo rekomendacijos Shout 

It Out! yra 0.3 Mbps vienam įrenginiui. Mokykla, kuri dažniausiai naudoja kitus 

Web 2.0 įrenginius, turėtų turėti tinkamą tinklą SMART lab veiklų veikimui 

classlab.com. Jei SMART lab veiklos, esančios classlab.com, yra naudojamos kartu 

su kitais internetiniais ištekliais, pavyzdžiui leidžiamos medijos, būtinas didesnis 

tinklo pajėgumas, priklausomai nuo kitų naudojamų išteklių. 
 

 
 
 

Svetainės prieigos reikalavimai 
Norint užtikrinti, kad visiems mokiniams Shout It Out! veiks tinkamai, pridėkite šiuos URL į tinklo baltąjį 

sąrašą. 
 

l  https://www.classlab.com 
 

l  http://id.smarttech.com 
 

l  https://content.smarttech-prod.com 
 

l  https://metric.smarttech-prod.com 
 

l  https://google.com 
 

l  http://google-analytics.com 
 

l  https://www.gstatic.com (naudojamas Google įkelti reCAPTCHA) 
 

l  https://*.firebaseio.com 
 

l  https://*.cloudfront.com 
 

 
 
 

Mokinio teksto pridėjimas per įjungtą įrenginį prie 

Shout It Out! veiklos 
Mokiniams patiks prisidėti prie SMART lab veiklų. Mokiniai gali pridėti tekstą ar paveiksliukus, 

priklausomai nuo veiklos reikalavimų. Paprašykite kitų mokinių įrašyti komentarus į kategorijas ar 

naudoti šiuos papildymus diskusijoms. 

 
Mokiniams prisijungus prie veiklos naudojant SMART lab mokinių papildymų veiklos dialogo langelį 

kompiuterio ar mobilaus įrenginio naršyklėje, atsidarys veiklos atsakymų langas. 
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1.   Mokiniai įrašo savo papildymus į teksto langą. Mokiniai gali įrašyti 150 ženklų su tarpais, o papildyti 

gali tiek kartų, kiek nurodys mokytojas. 
 

 
 

Jei anksčiau pasirinkote Categorized papildymus, teksto langelyje bus kategorijos meniu. 
 

 
 

Pateikę papildymus, mokiniai turi pasirinkti kategoriją, kurią nori papildyti, iš Select  a category 

išplečiamo meniu. 
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2.   Mokiniai paspaus Send Response ir išsiųs savo papildymus į SMART Notebook SMART 

lab veiklos puslapį. 
 

Mokinių papildymai atsiras SMART Notebook SMART lab veiklos puslapyje. Daugiau 

informacijos pateikta „Mokinių teksto pridėjimas“ ir „Mokinių paveiksliukų pridėjimas“. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Categorized lange, spauskite  , kad sumažintumėte veiklos ID langą ir matytumėte atsiradusius 

papildymus veiklos puslapio lango dešinėje. Spauskite , kad atidarytumėte langą iš naujo. 
 
 

PATARIMAS 
 

Galite perkelti mokinių papildymus iš vienos kategorijos į kitą apspaudę ant mokinio papildymo ir 

nuvilkę ją į kitą kategoriją. 
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 Mokinio paveiksliuko pridėjimas 
 

1.   Mokiniams prisijungus prie veiklos naudojant SMART lab mokinių papildymų veiklos dialogo langelį, 

atsidarys veiklos atsakymų langas. 
 

 
 

2.   Mokiniai turi spausti Select  an image. 
 

Atsidarys įrenginio failų paieška. 
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3.   Mokiniai pasirinks paveiksliuką ir spaus Open. 
 

Kaip ir teksto papildymai, paveiksliukai atsiras SMART Notebook SMART lab puslapyje. 
 

Norint padidinti paveiksliuką, mokytojas turi paspausti ant paveiksliuko SMART Notebook puslapyje, 

ir paveiksliukas padidės. 

Norint grąžinti paveiksliuką į jo normalų dydį, spauskite už padidinto paveiksliuko ribų arba X 

viršutiniame dešiniame padidinto paveiksliuko kampe. 

 
SVARBU 

 

Mokinys gali pateikti 50 paveiksliukų vienos veiklos metu. Jei mokinys viršija šį kiekį, atsiras 

įspėjimas, ir papildomi mokinio pridėti paveiksliukai nebus rodomi naudojamoje veikloje. 

 
 

 

PASTABA 
 

 Norint ištrinti papildymą, vilkite jį į šiukšlinę SMART lab veiklos puslapio viršuje kairėje. 

Ištrynus papildymą, jo atkurti nebegalima. 

 
4.   Norint išeiti iš veiklos, mokiniai turi apspausti programos išjungimo simbolį įrenginių naršyklėse 

 
. 

 

 

Mokinio papildymų pridėjimas per įrenginį į veiklą 
 

1.   Norint pridėti mokinio papildymą per įrenginį naudojant classlab.com, spauskite  ar . 
 

Atsiras veiklos per įrenginį dialogo langelis. 
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2.   Spauskite Start for Students 
 

Atsidarys Activity running dialogo langelis. 
 

 
 

3.   Paprašykite mokinių eiti į classlab.com savo įrenginiuose. 
 

Atsidarys classlab.com veiklos dialogo langelis. 
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4.   Mokiniai turi įvesti veiklos kodą ir spausti Enter. 
 

Mokinių bus paprašyta įrašyti savo vardus ir spausti Join the Activity. Atsidarys 

veiklos dialogo langelis. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mokiniai atliks savo pasirinkimus ir užbaigę paspaus Send response. 
 

Daugiau informacijos apie classlab.com naudojimą pateikta „Mokinių teksto pridėjimas“ ir 

„Mokinių paveiksliukų pridėjimas“. 
 

 
 
 

Mokinių pašalinimas iš veiklos 
Jūs galite pašalinti mokinius iš Shout It Out! veiklos ir užbaigti veiklą. 
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1.   Veiklos ekrano apačioje, spauskite Remove Students. 
 

 

 
Atsiras mokinių pašalinimo patvirtinimo dialogo langelis. 

 

2.   Spauskite Remove Students.  Veikla pasibaigs ir visi mokiniai bus pašalinti iš veikos, Remove 

Student mygtukas bus išjungtas. 
 

 
 
 
 
 

Žaidimo elemento pridėjimas prie veiklos  

Galite padaryti SMART lab veiklą įdomesne ir labiau įtraukiančia mokinius pridėdami žaidimų elementus. 

Galimi trys žaidimų elementai. 
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Žaidimo elemento pridėjimas prie veiklos 
 

1.   Norėdami prie veiklos pridėti garsinį mygtuką, laikmatį ar atsitiktinį žaidimo elementą, spauskite . 
 

Atsidarys Game element selektorius. 
 

 
 

2.   Pasirinkite žaidimo elementą. Žaidimo elementas atsiras veikloje šalia nustatymų 

mygtuko. 

3.   Spauskite nustatymų mygtuką ir pakeiskite galimas žaidimo elementų savybes. 
 
 
 

Laikmatis 
 

 
 
 

Naudokite laikmatį susekti, per kiek laiko mokiniai užbaigia veiklą. Laikmačio dialogo langelyje galite 

pasirinkti 15 sekundžių, 30 sekundžių ar vieną minutę atgalinio laiko skaičiavimo arba laiko skaičiavimo, 

taip pat galite nustatyti numatytą laiką minutėmis ir sekundėmis. 

 

 

Atsitiktinio parinkimo įrankis 
 

 
 
 

Galite naudoti atsitiktinio parinkimo įrankį, kuris atsitiktinai parinks mokinius ar veiklos turinį. Galite 

atsitiktinai pasirinkti atverčiamų kortelių nugarėles, skaičius ar mokinių sąrašus. Randomizer dialogo 

langelyje, galite atsitiktinai pasirinkti atverčiamų kortelių nugarėles ar skaičius nuo 1 iki 30. Taip pat 

galite atsitiktinai pasirinkti mokinių vardus pridėdami juos į mokinių sąrašo langelį ar pridėdami mokinių 

vardus iš jau išsaugoto mokinių sąrašo. Vienas objektas gali būti pasirinktas vieną kartą. 
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Garsinis mygtukas 
 

 
 
 

Mokiniai gali konkuruoti ir pasižiūrėti, kieno kito bus eilė. Galite pasirinkti ir naudoti daugiausia keturis 

garsinius mygtukus iš Buzzer dialogo langelio naudodami žaidimo elemento nustatymus. 
 

 
 

Monster Quiz naudojimas 
Monster Quiz yra progreso viktorina su keliais variantų pasirinkimais ir tiesa ar melas klausimas, veikianti 

mobiliame įrenginyje. Mokiniai mokosi komandose ir konkuruodami. Naudodami savo mobilius įrenginius, 

mokiniai padeda savo komandai auginti jiems patinkančias pabaisas teisingai atsakydami jūsų paruoštus 

klausimus. 

 
 
 
 

Daugiau vaizdo įrašų apie veiklos nustatymą ir naudojimą pateikta default.htm. 
 
 

Monster Quiz naudojimas 
 

1.   Atidarykite SMART lab paspaudę piktogramą  SMART Notebook įrankių juostoje. 
 

Atsidarys Select an Activity kūrimo vedlys. 
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2.   Suraskite Monster Quiz veiklą ir spauskite veiklos piktogramą. 
 

Atsidarys Monster Quiz Add Content dialogo langelis. 
 

3.   Pasirinktie Multiple Choice ar True or False kaip norimos sukurti viktorinos tipą. 
 

4.   Pasirinkę Multiple Choice formatą, įrašykite klausimą. Galite panaudoti 150 ženklų vienam 

klausimui. 
 

5.   Įrašykite bent du atsakymus į klausimą, kurį įrašėte 4 žingsnyje, ir paspauskite mygtuką šalia teisingo 

atsakymo. Varnelė  rodo atsakymą. 
 

6.   Spauskite Add Question  ir įrašykite daugiau klausimų ir atsakymų. Taip pat galite pridėti klausimus 

iš anksčiau išsaugoto sąrašo arba išsaugoti naujus klausimus į sąrašą. Daugiau informacijos apie  

turinio pridėjimą pateikta „Monster Quiz naudojimas“ ankstesniame puslapyje. 
 

Tik pirmi dešimt klausimų yra įtraukiami į veiklą. 
 

7.  Užbaigę klausimų įrašymą, spauskite Next. 
 

Atsidarys Review Content dialogo langelis. 
 

8.   Pasirinkite Time Limit Per Question  mygtuką  ir nustatykite sekundžių skaičių, skirtą atsakyti 

kiekvienam klausimui. 
 

9.   Spauskite Finish. SMART lab paruoš veiklą ir jūs galėsite ją naudoti po kelių sekundžių. 
 

Atsidarys Add game components dialogo langelis kartu su priminimu, kad žaidimų elementai 

nėra galimi Monster Quiz veiklai. 
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10.   Spauskite raudoną veiklos piktogramą .  
 

11.   Atsiras classlab.com mokinių papildymų veiklos dialogo langelis. Jame yra classlab.com URL, kurį 

mokiniai įves į savo įrenginių naršykles, o suteiktą veiklos ID numerį mokiniai įrašys į SMART 

Notebook pamokos veiklos kūrimo įrankio tinklapyje. Paprašykite mokinių eiti į classlab.com savo 

mobilių įrenginių naršyklėse. Veiklos piktograma taps mėlyna , parodant, kad vyksta prisijungimo 

procesas. 
 

12.   Mokiniai įves veiklos ID kodą ir savo vardus dialogo langelyje, kuris atsiras jų mobiliuose 

įrenginiuose. 
 

 
 

13.   Mokiniai turi spausti Join the activity savo įrenginiuose. 
 

14.   Spauskite Start the Activity Monster Quiz veiklos lange. 
 

Mokiniai gaus patvirtinimą, kad jie yra žaidime. 
 

15.   Mokytas spaudžia Set teams ir įrašo dalyvaujančių komandų skaičių. 
 

SMART lab paskirs dalyvius į komandas ir paruoš veiklą, kurią galėsite naudoti po kelių sekundžių. 

Norėdami pradėti veiklą ir leisti mokiniams pateikti papildymus, žiūrėkite „Monster Quiz naudojimas“ 

142 puslapyje. 
 

16.   Spauskite Start Quiz. 
 

Viktorina bus pradėta. 
 

Mokiniai atsakys į viktorinos klausimus savo mobiliuose įrenginiuose. Pateikus teisingus atsakymus, 

pabaisos išsiris, o žaidimas bus baigtas, kai visos pabaisos bus išsiritusios. 

17.   Spauskite Review ir peržiūrėkite mokinių atsakymus. Galite peržiūrėti komandų rezultatų lenteles ir 
klasės apžvalgas. 
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Hand out veiklos naudojimas 
Kaip mokytojas, jūs galite sukurti Hand out veiklą beveik su visomis SMART lab veiklomis. Naudokite 

Hand out nusiųsti mokiniams SMART veiklą, kad jie galėtų dalyvauti pamokoje per savo mobilius 

įrenginius realiu laiku. 

 

 

Hand out veiklos kūrimas 
 
 

Hand out veiklos kūrimas 
 

1.   Pasirinkite bet kurią SMART lab veiklą, įtraukiant Super Sort, Rank Order, Flip Out, Fill in the 

Blanks, Match ‘Em Up ir Label Reveal. 
 

2.   Parenkite veiklą kaip paprastai, bet užbaigus parengimą, matysite veiklos piktogramą . 

3.   Spauskite veiklos piktogramą, kad pradėtumėte. Piktograma taps mėlyna , parodant, kad vyksta 

prisijungimo procesas. 
 

Atsidarys Ready to start activity dialogo langelis, nurodantis classlab.com veiklos ID. 
 

4.   Paprašykite mokinių eiti į classlab.com savo mobilių įrenginių naršyklėse. 
 

5.   Spauskite Start for Students.  Mokiniai matys classlab.com tinklapį. 
 

 

 
6.   Paprašykite mokinių įrašyti veiklos ID ir savo vardus, tuomet paspausti Join the activity savo 

įrenginiuose. 
 

7.  Hand out veikla atsiras mokinių mobiliuose įrenginiuose. Kai visi mokiniai užbaigs veiklą, spauskite 

End Ready to start activity dialogo langelyje. Mokiniai gaus įspėjimą į savo įrenginius, kad veikla 

pasibaigė. 
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SMART response 2 naudojimas 
 
 

Įvertinimų kūrimas su SMART response 2 
Esanti SMART Notebook programinėje įrangoje, response 2 yra itin intuityvus ir paprastas įvertinimų 

įrankis, palengvinantis, pagreitinantis ir supaprastinantis klausimų kūrimą. Sutelkiant dėmesį į sudedamą 

įvertinimą, naujasis įrankis patenkina mokytojų poreikį efektyviai įvertinti mokinius ir mokymosi 

pažangą. Mokiniai gali apsiekti įvertinimo įrankį naršydami classlab.com savo mobiliuose įrenginiuose. 

 
 

PASTABA 
 

Norint pradėti naudoti response 2 įvertinimo įrankį, atidarykite jį Notebook paspaudę response 2 

piktogramą  . Atsidarys response 2 parengimo dialogo langelis. Tuomet galėsite pradėti kurti ir 

išsaugoti klausimus. Kiekvienas klausimui būtina pateikti bent du atsakymus. Klausimai turi būti 

trumpesni nei 150 ženklų. 

 

 
SVARBU 

 
1.     Ankstesnės SMART Response versijos failai bus konvertuoti, kad atsidarytų SMART response 2. 

Atsiras dialogo langelis, kai bandysite atidaryti failą iš ankstesnės SMART Response versijos: 

 
 

2.   Spauskite Convert ir konvertuokite senus SMART Response klausimus. Kiekvienas sekantis 

klausimas bus sugrupuotas į naują SMART response 2 veiklą. 
 

3.   Jei nenorite grupuoti sekančių klausimų, pažymėkite Don’t group consecutive questions 

langelį. 
 

Jei pasirinksite Don’t group consecutive questions langelį, prieš kiekvieną SMART Response failo 

puslapį bus įterptas naujas puslapis su vieno klausimo response 2 veikla. Matysite du puslapius 

vietoje vieno SMART Response puslapio. 
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4.   Spauskite Convert ir patvirtinkite failo konvertavimą. 

 

5.   Atsidarys konvertuotas Notebook failas. 

 

Atsiras juosta, nurodanti, kad failas buvo konvertuotas. Jei norite gauti papildomos informacijos, juostoje 

pasirinkite Learn More. 

 

Konvertavimo procesas nefiksuoja tam tikrų SMART Response informacijos dalių: nuotraukų, anotacijų ir 

kryžminės nuorodos nėra išsaugomos; 
 

l  Bus rodomos neišverstos Yes/No ir True/False žymos kaip teksto klausimai A) Ture ir B) False. Jei 

failas buvo išverstas, parinktys vis tiek bus Yes/No ir True/False. 
 

l  Laipsniai ir indeksai bus suformatuoti, bet kitas teksto formatavimas nebus konvertuojamas 
 

l  Skaičių pasirinkti formatai nebus išsaugoti 
 

l  Matematinių klausimų tipai nėra palaikomi 
 

l  Tuščiose klausimo antraštėse bus rodomas toks numatytasis tekstas: Incomplete question. Edit 

activity to complete 

 
 

SMART response 2 klausimų kūrimas 

1.   Atidarykite response 2vNotebook paspaudę response 2 piktogramą . 
 

Atsidarys response 2 Add Content dialogo langelis. 
 

2.   Add Content dialogo langelyje pasirinkite norimos sukurti viktorinos tipą. Galite sukurti klausimus 

su keliais atsakymų pasirinkimais, tiesa ar melas, apklausos/nuomonės ar trumpais atsakymai. 
 

Viktorinos klausimų pasirinkimas nustato atsakymo formatą. Pavyzdžiui, viktorina su keliais 

pasirinkimais pateiks galimus atsakymus nuo A iki D, tuo tarpu tiesa ar melas viktorina pateiks tik 

teisingą ir neteisingą atsakymus. 
 

3.   Kiekvienam klausimui parinkite teisingą atsakymą. 
 

4.   Norėdami pridėti kitą klausimą, spauskite Add Question. 
 

5.   Spauskite išsaugoti . Galėsite vėliau panaudoti kitoms pamokoms. 
 

6.   Užbaigus, spauskite Next. 
 

ARBA 
 

Spauskite Previous, jei norite grįžti į ankstesnį puslapį ir pataisyti klausimus ar pridėti 

daugiau klausimų. 
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7.  Spauskite Finish. 
 

Po kelių sekundžių veikla bus paruošta naudojimui. 
 
 

SMART response 2 klausimų kūrimas iš anksčiau išsaugoto failo 
 

1.   Notebook meniu, spauskite Add Page. Atsidarys naujas Notebook puslapis. 
 

2.   Atidarykite response 2vNotebook paspaudę response 2 piktogramą . Atsidarys response 2 Add 

Content dialogo langelis. 
 

Taip pat galite pasirinkti response 2 iš SMART lab kūrimo vedlio. 
 

3.   Spauskite įkelti  , kad atsidarytų anksčiau išsaugotas failas. 
 

Atsidarys Load Content selection dialogo langelis. 
 

4.   Pasirinkite failą ir spauskite Load. 
 

Klausimai bus įkelti ir atsiras Review Content dialogo langelyje. Šiame dialogo langelyje jūs taip pat 

galite ištrinti klausimus iš savo viktorinos. 
 

Norint ištrinti klausimą, spauskite . 
 

5.   Pasirinkite Finish. 
 

Po kelių sekundžių veikla bus paruošta naudojimui. 
 
 

Klausimų pridėjimas 
 

1.   response 2 Add Content dialogo langelyje spauskite Add Question. Atsidarys Questions dialogo 

langelis. 
 

2.   Pridėkite kiek norite klausimų. 
 

Spauskite išsaugoti , kad išsaugotumėte savo klausimus. Galėsite juos panaudoti vėliau. 
 

3.   Spauskite Next. 
 

Klausimai bus įkelti ir atsiras Review Content dialogo langelyje. ARBA 

Spauskite Previous, jei norite grįžti į ankstesnį puslapį ir pataisyti klausimus. 
 

4.   Spauskite Finish. 
 

Po kelių sekundžių veikla bus paruošta naudojimui. 
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Paveiksliukų pridėjimas prie SMART response 2 klausimų 
 

1.   Spauskite paveiksliuko pridėjimo piktogramą . 
 

Atsidarys Open dialogo langelis. 
 

2.   Pasirinkite paveiksliuką, kurį norite pridėti prie sąrašo, ir spauskite Open. 
 

Paveiksliukas atsiras Add Content dialogo langelyje. Taip pat galite vilkti paveiksliuką į 

mėlyną langelį. 
 

3.   Įrašę visus atsakymus, spauskite Add Question, jei norite pridėti kitą klausimą. 
 

4.   Spauskite Done. Atsidarys Add Content dialogo langelis. Redaguokite, pašalinkite ar pridėkite 

klausimus pagal poreikį. 

Žiūrėkite 7 skyrius: „SMART lab naudojimas“ 117 puslapyje, kur pateikta daugiau informacijos  apie 

turinio valdymą. 
 

5.   Spauskite Finish. Po kelių sekundžių klausimai bus paruošti naudojimui. 

Mokiniai matys veiklą ir veiklos identifikavimo numerį ant SMART Board. 
 

6.   Spauskite Start for Students.  Dabar mokiniai galės prisijungti prie response 2 veiklos per savo 

mobilius įrenginius. 
 
 

Prisijungimas prie SMART response 2 naudojant mobilųjį įrenginį 
Kai  veikla yra paruošta, prie jos galima prisijungti mobiliuoju įrenginiu, jei įrenginys atitinka 

būtinus naršyklės ir ryšio reikalavimus. 

 
Mokiniai naudos naršykles mobiliuose įrenginiuose prisijungimui prie classlab.com. 

 
1.   Nuėjus į classlab.com tinklapį, mokiniai įves veiklos identifikavimo numerį. 

 

Atsidarys instrukcijų dialogo langelis. 
 

 
 

2.   Spauskite OK. Atsidarys pirmas viktorinos klausimas. 
 

3.   Pasirinktie atsakymą į klausimą ir spauskite rodyklę pereiti prie kito klausimo. 
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4.   Kai visi klausimai bus atsakyti, dar kartą paspauskite rodyklę ir pateikite klausimus. Šiame puslapyje 

gausite informaciją apie viktoriną arba galėsite išeiti iš viktorinos. 
 

5.   Spauskite Submit All Answers. 
 

 
 

6.   Atsidarys patvirtinimo langas. 
 

 
 

7.  Spauskite Submit. Mokytojas peržiūrės rezultatus su klase. 
 
 

Rezultatų peržiūrėjimas įrenginyje 
 

1.   Mokytojui pasirinkus peržiūrėti, mokiniai iš karto matys atsakymus į kiekvieną klausimą įrenginyje. 

Paspaudus ant klausimo paskutiniame peržiūros lape, mokiniui bus rodomi to klausimo pasirinkimai. 
 

Teisingų atsakymų procentas bus rodomas įrenginio ekrano apačioje. 
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2.   Pabaigus peržiūrą, spauskite Sign Out. Atsidarys langelis, prašantis naudotojo patvirtinti išėjimą iš 

veiklos. 
 

 
 

3.   Spauskite Leave Activity. Veikla bus išjungta, o mokiniai bus grąžinti į pradinį classlab.com 

tinklapį. 
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8 skyrius 

Pamokos veiklos pristatymas 
 
 
 

Pasiruošimas pristatyti  154 

Puslapio rodymo nustatymas   154 

Padidinimas ir sumažinimas   154 

Puslapio pasukimas   155 

Nuorodų rodymas    156 

Langų perkėlimas tarp ekranų   156 

Pristatymo įrankių naudojimas    157 

Ekrano šešėlio naudojimas   157 

Langelių šešėlių naudojimas   158 

Magiško rašiklio naudojimas   159 

Teksto rašiklio naudojimas   159 

SMART Blocks naudojimas    159 

Matavimo įrankių naudojimas    161 

Minčių schemos naudojimas  161 

Matavimo įrankių nustatymas   163 

Teksto rašiklio naudojimas   165 

Redaguojamo teksto rašymas  165 

Redagavimas su teksto rašikliu    166 

Puslapio išvalymas ir atkūrimas 167 

Puslapio išvalymas   167 

Puslapio atkūrimas    169 

Ekrano nuotraukų įrankių juostos naudojimas    170 

Didintuvo naudojimas    171 

Didintuvo įrankio naudojimas    171 

Ekrano šešėlio įrankio naudojimas   173 

Išskyrimo įrankio naudojimas    174 
 

 
 

Sukūrę pamokos veiklą SMART Notebook programinėje įrangoje, galite pristatyti pamokos veiklą 

mokiniams, naudodami interaktyvų produktą ir programinės įrangos pristatymo funkcijomis. 

 

Be pamokų veiklos pristatymo mokiniams, galite palengvinti bendradarbiavimą savo klasėje naudojant 

SMART Notebook programinę įrangą ir interaktyvų produktą. Tiksliau, du žmonės vienu metu gali naudoti 

SMART Board D600 serijos arba 800 serijos interaktyviąją lentą.
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Pasiruošimas pristatyti 
Kai užbaigsite .notebook failus ir būsite pasiruošę juos pristatyti mokiniams, įrašykite failus į CD, DVD ar 

USB laikmeną. Tai leidžia prieiti prie failų ir juos rodyti, įdedant CD, DVD ar USB laikmeną į kompiuterį, 

prijungtą prie interaktyviojo produkto. Taip pat failai taps prieinami jūsų vietiniame tinkle ir galėsite juos 

naudoti su interaktyviu produktu. 

 
Toliau, pasiruoškite pristatymui atlikdami šiuos veiksmus: 

 
l  Nustatykite puslapio rodymą 

 

l  Rodykite faile nuorodas 
 

l  Jei klasėje turite kelius interaktyvius produktus, perkelkite langus į tinkamus ekranus 
 

l  Jei pristatote vaizdo ar garso įrašus, sureguliuokite garsą 
 
 

Puslapio rodymo nustatymas 
SMART Notebook programinėje įrangoje galimos šios peržiūros: 

 
l  Viso ekrano vaizdas išplečia puslapio plotą, kad užpildytų interaktyvųjį ekraną, slėpdamas 

pavadinimo juostą, įrankių juostą, užduočių juostą ir šoninę juostą. 
 

l  Skaidrus fono vaizdas leidžia matyti darbalaukį ir langus už SMART Notebook programinės įrangos 

lango ir toliau naudoti atidarytą ir skaidrų puslapį. 
 

l  Dvigubo puslapio vaizdas rodo du puslapius vieną šalia kito. 
 
 

Padidinimas ir sumažinimas 
Galite vaizdą padidinti arba sumažinti naudodami ekrano peržiūros mygtuką ar gestus (jei jūsų interaktyvus 

produktas palaiko įvairius lietimo gestus). 
 
 

Padidinimas ir sumažinimas naudojant peržiūros meniu 
 

1.   Spauskite View Screens . 
 

2.   Pasirinkite padidinimo lygį nuo 50% iki 300%. 
 

ARBA 
 

Pasirinkite Entire Page, kad visas puslapis užpildytų ekraną. 

ARBA 

Pasirinkite Page Width, kad nustatytumėte puslapio plotį į ekrano plotį. 
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Padidinimas ir sumažinimas naudojant peržiūros meniu 
 

Vilkite pirštus skirtingomis kryptimis, kad padidintumėte. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

ARBA 
 

 Vilkite pirštus artyn, kad sumažintumėte. 
 

 
 
 
 
 
 
 
 
 
 
 
 

Atsiras žinutė, rodanti padidinimo lygį. 
 
 

Puslapio pasukimas 
Jei jūsų interaktyvus produktas palaiko sukimo gestą, galite pasukti padidintą puslapį. 

 
 

Puslapio pasukimas 
 

1.   Dviem tos pačios rankos pirštais, spauskite ekraną. 
 

2.   Laikydami pirštus ant ekrano, judinkite aukštyn, žemyn, į kairę ar į dešinę. 
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3.   Kai pasieksite sritį, kurią norite matyti, patraukite pirštus. 
 
 

Nuorodų rodymas 
Galite pridėti failo kopiją, failo šaukinį, nuorodą į tinklalapį arba garso failą prie bet kurio objekto puslapyje 

(žiūrėkite „Sudėtingesnių objektų savybių naudojimas“ 107 puslapyje). Galite rodyti animuotą indikatorių 

aplink kiekvieną objektą, kuriame yra nuoroda. 
 
 

Nuorodų rodymas, kai puslapis atidaromas 
 

Pasirinkite View > Show All Links When Page Opens. 
 

Kiekvieną kartą atidarius puslapį, aplink kiekvieną objektą, kuriame yra nuoroda, rodomas animuotas 

indikatorius. Priklausomai nuo to, kaip nustatote nuorodas, kiekvienas indikatorius supa visą objektą 

arba piktogramą objekto apatiniame kairiajame kampe. Indikatoriai automatiškai išnyksta po kelių 

sekundžių. 

 
PASTABA 

 

Išvalykite pasirinkimą View > Show All Links When Page Opens, kad nuorodos nebebūtų 

rodomos atidarius puslapį. 
 

 
 

Nuorodų rodymas atidarytame puslapyje 
 

Pasirinkite View > Show All Links. 
 

Aplink kiekvieną objektą, kuriame yra nuoroda, rodomas animuotas indikatorius. Priklausomai nuo 

to, kaip nustatote nuorodas, kiekvienas indikatorius supa visą objektą arba piktogramą objekto 

apatiniame kairiajame kampe. Indikatoriai automatiškai išnyksta po kelių sekundžių. 

 

 

Langų perkėlimas tarp ekranų 
Jūs galite valdyti keletą interaktyvių produktų iš to paties kompiuterio. Galite padalinti kompiuterio ekraną 

per du ar kelis ekranus arba galite rodyti vienas programas viename ekrane, o kitas programas kitame. 

Daugiau informacijos pateikta Connecting multiple interactive whiteboards to one computer 

(smarttech.com/kb/000315). 
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Jei prijunksite kelis interaktyvius produktus prie vieno kompiuterio, galėsite perkelti langus iš vieno 

ekrano į kitą. 
 
 

Lango perkėlimas iš vieno ekrano į kitą 
 

1.   Jei dar to nepadarėte, pasirinkite, kad rodytų langą. 

 
PASTABA 

 

Langą galėsite perkelti, jei jis nebus apdidintas ar sumažintas. 

 
2.   Paspauskite ir laikykite pirmojo ekrano langą pirštu. 

 

3.   Paspauskite antrąjį ekraną pirštu kita ranka. 
 

4.   Pakelkite pirštą iš pirmojo ekrano. 
 

Langas išnyks iš pirmojo ekrano ir pasirodys antrame ekrane. 
 
 

Pristatymo įrankių naudojimas 
Pristatydami mokiniams pamokos veiklą, galite naudoti šiuos įrankius: 

 
l  Ekrano šešėlį 

 

l  Langelių šešėlius 
 

l  Magišką rašiklį 
 

l  Teksto rašiklį (rašymas redaguojamu rašalu) 
 

l  Standartinį rašiklio tipą (išblėstančių objektų kūrimas) 
 

l  SMART Blocks 
 

l  Minčių schemą 
 

l  Matavimo įrankius 
 

o    Liniuotę 
 

o    Matlankį 
 

o    Geodreieck matlankį 
 

o    kompasą 
 
 

Ekrano šešėlio naudojimas 
Jei norite uždengti informaciją ir lėtai ją atskleisti pristatymo metu, galite į puslapį pridėti ekrano šešėlį. 

Taip pat galite keisti ekrano šešėlio spalvą, kad pristatymas būtų gyvesnis. 
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Jei pridėsite į puslapį ekrano šešėlį ir išsaugosite failą, ekrano šešėlis atsiras virš puslapio atidarius failą 

kitą kartą. 
 
 

Ekrano šešėlio pridėjimas į puslapį 
 

1.   Spauskite Show/Hide Screen Shade  . 
 

Ekrano šešėlis uždengs visa puslapį. 
 

2.   Spauskite ant ekrano šešėlio, kad jo spalva pasikeistų automatiškai. 
 
 

Dalies puslapio atskleidimas 
 

Vilkite vieną iš ekrano šešėlio dydžio keitimo rankenėlių (maži apskritimai ekrano šešėlio 

kraštuose). 
 
 

Ekrano šešėlio pašalinimas  

Spauskite Show/Hide Screen Shade    . 

ARBA 

Spauskite uždaryti  viršutiniame dešiniame ekrano šešėlio kampe. 
 

 

Langelių šešėlių naudojimas 
Galite pridėti šešėlį į lentelės langelį. Tai jums leis atskleisti informaciją langeliuose pristatymo 

metu. 
 
 

PASTABOS 
 

l  Jei norite pakeisti langelio savybes; įterpti stulpelius ar eilutes, pašalinti stulpelius, eilutes ar 

langelius; padalinti arba sujungti langelius, turite pašalinti langelio šešėlį. 

l  Taip pat galite pridėti ekrano šešėlį ir uždengti visą puslapį (žiūrėkite „Ekrano šešėlio naudojimas“ 

ankstesniame puslapyje). 
 
 

Langelio šešėlio pridėjimas 
 

1.   Pasirinkite langelį. 
 

2.   Spauskite langelio meniu rodyklę, tuomet pasirinkite Add Cell Shade. 
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Langelio turinio rodymas ir paslėpimas 
 

1.   Paspauskite ant langelio šešėlio. 
 

Langelio šešėlis išnyks ir atskleis langelio turinį. 
 

2.   Spauskite  viršutiniame kairiame langelio kampe. 
 

Langelio šešėlis vėl atsiras, paslėpdamas jo turinį. 
 
 

Langelio šešėlio pašalinimas 
 

1.   Pasirinkite langelį. 
 

2.   Spauskite langelio meniu rodyklę, tuomet pasirinkite Remove Cell Shade. 
 
 

Magiško rašiklio naudojimas 
Magiškas rašiklis leis jums atlikti šiuos veiksmus: 

 
l  Sukurti objektą, kuris po truputį išnyks. Pasirinktie magišką rašiklį įrankių juostoje ir rašykite arba 

pieškite su juo. Skaitmeninis rašalas išnyks maždaug po 10 sekundžių. Daugiau informacijos 

pateikta „Rašymas, piešimas skaitmeniniu rašalu ir jo ištrynimas“. 
 

l  Atidarykite padidinimo langą. Daugiau informacijos pateikta „Didintuvo įrankio naudojimas“. 
 

l  Atidarykite išskyrimo langą. Daugiau informacijos pateikta „Išskyrimo įrankio naudojimas“. 
 
 

Teksto rašiklio naudojimas 
Teksto rašiklis leis jums atlikti šiuos veiksmus: 

 
l  Rašyti pastabas, kurios bus automatiškai konvertuotos į redaguojamą tekstą. 

 

l  Redaguoti tekstą su liečiama klaviatūra. 
 

 

Daugiau informacijos pateikta „Teksto rašiklio naudojimas“. 
 
 

SMART Blocks naudojimas  

SMART Blocks yra papildomas įrankis, leidžiantis jums atlikti matematinę veiklą su savo klase, rašant 

skaičius puslapyje ir prijungiant juos prie SMART Blocks. Galite pasirinkti iš septynių skirtingų lygčių tipų. 

Iššokantis vadovas padės jums sužinoti, kaip naudoti SMART Blocks.
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SVARBU 

 

SMART Blocks atliks skaičiavimus blokuose. Nerašykite blokų viduje. Žiūrėkite pavyzdžius žemiau. 
 
 

Galimos šios SMART Blocks veiklos: 
 

SMART Block  Funkcija  Pavyzdys 
 

Sudėties blokai gali priimti iki dviejų 

įvesčių. Rezultatas yra įvesčių suma. 

 
 
 

 
Atimties blokai gali priimti iki dviejų 

įvesčių. Rezultatas yra įvesčių skirtumas. 

 
 
 

 

Daugybos blokai gali priimti iki dviejų 

įvesčių. Rezultatas yra įvesčių produktas. 

 
 
 

 

Dalybos blokai gali priimti iki dviejų 

įvesčių. Rezultatas yra įvesčių dalmuo. 

 
 
 

 
Laipsnių blokai gali priimti iki dviejų įvesčių. 

Rezultatas yra pirmos įvesties kėlimas antra 

įvestimi. 

 
 
 

Kvadratinės šaknies blokai gali priimti iki 

dviejų įvesčių. Rezultatas yra įvesties 

kvadratinė šaknis. 

 

 
 

Nežinomi blokai gali priimti iki dviejų 

įvesčių. Rezultatas yra atsitiktinis įvesčių 

veiksmas. 
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SMART Blocks įjungimas 
 

Spauskite papildomus įrankius  , tuomet pasirinkite SMART Blocks. 
 

 

SMART Blocks iššokančio vadovo įjungimas 
 

1.   Spauskite papildomus įrankius  , tuomet pasirinkite SMART Blocks. 
 

2.   Spauskite Learn More. 
 
 

Matavimo įrankių naudojimas 
Naudodamiesi SMART Notebook programinės įrangos matavimo įrankiais, į puslapį galite įterpti 

liniuotę, matlankį, Geodreieck matlankį ar kompasą. 

 

 

Minčių schemos naudojimas 
Naudokite minčių schemą, kad greitai sukurtumėte minčių schemas, kurios skatina dinamišką mokinių 

dalyvavimą. Galite braižyti rašalu kartu su tradicinėmis sąveikomis ir kurti minčių schemas. 

 

Jei norite pradėti naudoti minčių schemą, atidarykite ją įrankių juostoje. Pagrindinis mazgas atsiranda 

automatiškai. Tada naudokite papildomus mazgus, kad galėtumėte sukurti minčių schemą. 
 
 

Pagrindinio mazgo kūrimas 
 

1.   Spauskite Start a new concept map  ir papildomų įrankių meniu. 
 

Atsidarys pagrindinis mazgas. 
 

 
 

2.   Du kartus paspauskite ant jo ir redaguokite tekstą. Spauskite savybes ar tekstą  ir atidarykite 

teksto meniu, kuriame galėsite pasirinkti teksto dydį, šriftą ar spalvą. 
 
 

Papildomų mazgų kūrimas 
 

1.   Spauskite + mygtuką pagrindiniame mazge. Atsiras naujas mazgas, sujungtas linija su pagrindiniu 

mazgu. 
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2.   Du kartus paspauskite ant mazgo ir redaguokite tekstą. 
 
 

Paveiksliuko kaip mazgo naudojimas 
 

1.   Atidarykite minčių schemą ir vilkite arba įklijuokite paveiksliuką, tekstą ar užrašą skaitmeniniu rašalu 

į Notebook puslapį. 
 

2.   Notebook rašikliu nubrėžkite apskritimą aplink paveiksliuką. 
 

 

 
3.   Paveiksliukas atsiras naujame mazge. Perkelkite mazgą kur norite Notebook puslapyje. 
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4.   Dabar rašikliu nubrėžkite paprastą liniją nuo naujo mazgo iki kito mazgo. Linija pavirs į segmentą ir 

sujungs abu mazgus. 
 

 
 

 
PATARIMAI 

o    Naudokite panaikinimo  ir atkūrimo  mygtukus norėdami panaikinti ar atkurti minčių 

schemą. 

o    Jei ištrinsite pagrindinį mazgą, bus ištrinti ir visi kiti mazgai. 

o    Galite keisti mazgo dydį paspaudę dydžio keitimo rankenėlę ir ją pajudindami.  
 

 

Matavimo įrankių nustatymas 
Pagal nustatymus, liniuotė, matlankis ir Geodreieck matlankis SMART Notebook programinėje įrangoje 

yra mėlynos spalvos ir geriausiai matomi šviesiame fone. 
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Galite keisti šių matavimo įrankių spalvą į geltoną, jei norite juos naudoti tamsiame fone. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PASTABA 
 

Šios procedūros užbaigimas daro įtaką matavimo įrankių išvaizdai .notebook failuose, peržiūrint tik į jūsų 

SMART Notebook programinės įrangos kopiją. Jei atidarysite tuos pačius .notebook failus kitoje SMART 

Notebook programinės įrangos failuose, matavimo įrankiai gali būti rodomi kita spalva 

 
 

 
 

Matavimo įrankių spalvos keitimas (Windows operacinėse sistemose) 
 

1.   Pasirinkite Edit > Preferences. 
 

Atsidarys SMART Notebook Preferences dialogo langelis. 
 
 

Matavimo įrankių spalvos keitimas (OS X operacinėse sistemose) 
 

1.   Pasirinkite Notebook > Preferences. 
 

Atsidarys dialogo langelis. 
 

2.   Spauskite Defaults. 
 

3.   Pasirinkite Blue tint (recommended for light backgrounds) matavimo įrankių išplečiamame spalvų 

sąraše, kad nustatytumėte matavimo įrankių spalvą į mėlyną. 

 

 ARBA 

 

Pasirinkite Yellow tint (recommended for dark backgrounds) matavimo įrankių išplečiamame spalvų 

sąraše, kad nustatytumėte matavimo įrankių spalvą į geltoną. 
 

4.   Spauskite OK. 
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Teksto rašiklio naudojimas 
Naudodami teksto rašiklį, galite padidinti ir redaguoti tekstą. Galite ištrinti nepageidaujamą tekstą, 

nubrėždami per tekstą brūkšnelio liniją. Galite naudoti skirtingų spalvų rašalą, kad paryškintumėte 

skirtingas teksto dalis. Taip pat galite padidinti įterpimo tarpą, įterpti tekstą ir pakeisti tekstą nauju tekstu. 

 

Teksto rašiklis leis jums atlikti šiuos veiksmus: 
 

l  Rašyti pastabas, kurios bus automatiškai konvertuotos į redaguojamą tekstą. 
 

l  Redaguoti tekstą su liečiama klaviatūra. 
 
 

Redaguojamo teksto rašymas 
Galite rašyti pastabas, kurios bus automatiškai konvertuotos į redaguojamą tekstą su teksto rašikliu. 

 
 

Redaguojamo teksto 

rašymas 
 

1.   Spauskite rašiklius  . 
 

Atsiras rašiklių įrankio mygtukai. 
 

 
 

2.   Spauskite Pen Types ir pasirinktie Text Pen. 
 

3.   Pasirinkite linijos tipą. 
 

4.   Skaitmeniniu rašalu užrašykite pastabas puslapyje. 
 

Ranka užrašytas tekstas bus konvertuotas į spausdintą tekstą. Šalia teksto atsiras patvirtinimo ir 

atmetimo piktogramos. 
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5.   Spauskite  ir patvirtinkite spausdintą tekstą. 
 

ARBA 
 

Spauskite ir atkurkite ranka užrašytas pastabas. 
 

 

Teksto redagavimas su teksto rašikliu 
Galimo didinimo pavyzdžiai yra pateikti šioje lentelėje: 

 

Redagavimas Instrukcija Pavyzdys 

Ištrinti tekstą Nubrėžkite liniją per tekstą. 
 

 

Įterpti tarpą Nubrėžkite vertikalią liniją tekste. 

 
 

Įterpti tekstą  1.   Nupieškite įterpimo ^ ženklą, kur 

norite įterpti tekstą. 

2.   Įrašykite naują tekstą atsiradusiame 

teksto langelyje. 

 

PATARIMAS 
 

Spauskite line type arba Color 
 

ir pasirinkite įterpto teksto 

spalvą. 

 
 

Bus rodomi žodžiai, labiausiai 

panašūs į tai, ką parašėte. 

3.   Pasirinkite žodį, kurį norite įterpti. 

Taip pat galite spausti  , kad 

automatiškai pasirinktumėte 

paryškintą žodį. ARBA 

Spauskite  ir atšaukite teksto įterpimą. 
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Redagavimas Instrukcija Pavyzdys 
 

Pakeisti tekstą  1.   Nubrėžkite apskritimą aplink 

norimą pakeisti tekstą. 

2.   Įrašykite tekstą apačioje 

atsiradusiame langelyje. 

Bus rodomi žodžiai, labiausiai 

panašūs į tai, ką parašėte. 

3.   Pasirinkite žodį, kurį norite įterpti 

ar spauskite  , kad automatiškai 

pasirinktumėte paryškintą žodį. 

ARBA 

Spauskite  ir atšaukite teksto 

įterpimą. 
 

Pakeisti 

teksto spalvą 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pakeisti teksto 

spalvą gestu 

 

1.   Spauskite line types arba 
 

Color ir pasirinkite naujo žodžio 

spalvą. 

2.   Nubrėžkite apskritimą aplink norimą 

pakeisti tekstą. 
 

3.   Spauskite,  kad būtų automatiškai 

patvirtinta nauja spalva. 

ARBA 
 

Spauskite,  kad atšauktumėte 

spalvos pasirinkimą. 
 

1.   Spauskite line types arba 
 

Color ir pasirinkite naujo žodžio 

spalvą. 

2.   Nubrėžkite horizontalią liniją per žodį 

ir grįžkite į linijos pradžią gestu atgal 

- pirmyn. 

Žodžio spalva automatiškai pasikeis į 

naujai pasirinktą spalvą. 

 
 
 

Puslapio išvalymas ir atkūrimas  

Pristatę pamokos veiklą mokiniams, galite išvalyti arba iš naujo nustatyti puslapius savo .notebook 

failuose, kad galėtumėte panaudoti juos kitoms pamokoms. 

 

 

Puslapio išvalymas 
 

 
Galite ištrinti skaitmeninį rašalą ar panaikinti atskirus objektus puslapyje. Taip pat galite panaikinti visus 
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objektus ar skaitmeninį rašalą vienu metu. 
 

PASTABA 
 

Negalima panaikinti užrakintų objektų arba neribotai klonuojamų objektų (žiūrėkite „Objektų 

klonavimas“ 74 puslapyje). Norint panaikinti visus objektus puslapyje, turite juos atrakinti ir išvalyti 

Infinite Cloner pasirinkimą visiems neribotai klonuojamiems objektams. 
 

 
 

Visų objektų panaikinimas iš puslapio 
 

1.   Jei dar to nepadarėte, pasirinkite norimą išvalyti puslapį. 
 

2.   Pasirinktie Edit > Clear Page. 

 
PASTABOS 

 
o    Ši funkcija bus išjungta, jei puslapyje nebus jokių objektų arba jei objektai yra užrakinti, arba 

neribojamai klonuojami. 
 

o    Taip pat galite pasirinkti šią funkciją atlikę šiuos veiksmus: 
 

o    Paspaudę dešiniu klavišą (Windows operacinėse sistemose) ar valdymo klavišą (OS X 

programinėse įrangose). 
 

o    Paspaudę puslapio meniu rodyklę puslapių rūšiuotuve. 
 

o    Paspaudę puslapio meniu rodyklę redaguojant puslapių grupes (žiūrėkite „Grupės 

kūrimas“  (Windows)  25 puslapyje). 
 

o    Paspaudę Clear Page , jei yra įrankių juostoje (žiūrėkite „Įrankių juostos 

tinkinimas“ 181 puslapyje). 
 

o    Galite panaikinti visus objektus keliuose puslapiuose tuo pačiu metu. Pasirinkite puslapių 

miniatiūras puslapių rūšiuotuve, spauskite meniu rodyklę ir pasirinkite Clear Page. 
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Skaitmeninio rašalo ištrynimas visame puslapyje 
 

1.   Jei dar to nepadarėte, pasirinkite norimą išvalyti puslapį. 
 

2.   Pasirinkite Edit > Clear Ink from Page. 

 
PASTABOS 

 
o    Ši funkcija bus išjungta, jei puslapyje nebus jokio skaitmeninio rašalo arba jei rašalas yra 

užrakintas, arba neribojamai klonuojamas. 
 

o    Taip pat galite pasirinkti šią funkciją atlikę šiuos veiksmus: 
 

o    Paspaudę dešiniu klavišą (Windows operacinėse sistemose) ar valdymo klavišą (OS X 

programinėse įrangose). 
 

o    Paspaudę puslapio meniu rodyklę puslapių rūšiuotuve. 
 

o    Paspaudę puslapio meniu rodyklę redaguojant puslapių grupes (žiūrėkite „Grupės 

kūrimas“  (Windows)  25 puslapyje). 
 

o    Paspaudę Clear Ink , jei yra įrankių juostoje (žiūrėkite „Įrankių juostos tinkinimas“ 181 

puslapyje). 
 

o    Galite panaikinti skaitmeninį rašalą keliuose puslapiuose tuo pačiu metu. Pasirinkite puslapių 

miniatiūras puslapių rūšiuotuve, spauskite meniu rodyklę ir pasirinkite Clear Ink from Page. 
 

 
 

Puslapio atkūrimas 
Jei atliksite pakeitimus puslapyje (bet neišsaugosite tų pakeitimų), galėsite atkurti puslapio būseną į 

ankstesnę, prieš pakeitimų atlikimą. 
 
 

PASTABA 
 

 Puslapio atkūrimas neperkrauna Adobe Flash Player atitinkančių, puslapyje esančių failų. 
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To Puslapio atkūrimas 
 

1.   Jei dar to nepadarėte, pasirinkite norimą išvalyti puslapį. 
 

2.   Pasirinkite Edit > Reset Page. 
 

Atsidarys dialogo langelis, prašantis patvirtinti atkūrimą. 

 
PASTABOS 

 
o    Ši funkcija bus išjungta, jei neatlikote jokių pakeitimų nuo paskutinio failo išsaugojimo. 

 

o    Taip pat galite pasirinkti šią funkciją atlikę šiuos veiksmus: 
 

o    Paspaudę dešiniu klavišą (Windows operacinėse sistemose) ar valdymo klavišą (OS X 

programinėse įrangose). 
 

o    Paspaudę puslapio meniu rodyklę puslapių rūšiuotuve 
 

o    Paspaudę puslapio meniu rodyklę redaguojant puslapių grupes (žiūrėkite „Grupės 

kūrimas“  (Windows)  25 puslapyje) 
 

o    Paspaudę Reset Page , jei yra įrankių juostoje (žiūrėkite „Įrankių juostos tinkinimas“ 181 

puslapyje) 
 

o    Galite atkurti kelis puslapius tuo pačiu metu. Pasirinkite puslapių miniatiūras puslapių rūšiuotuve, 

spauskite meniu rodyklę ir pasirinkite Reset Page. 

 

 
3.   Spauskite Reset Page. 

 
 
 

Ekrano nuotraukų įrankių juostos naudojimas 
Ekrano nuotraukų įrankių juosta leidžia jums nufotografuoti ekrano stačiakampio plotą, laisvų rankų 

naudojimo sritį, langą ar visą ekraną. 
 
 

Ekrano nufotografavimas 
 

1.   Spauskite SMART Board piktogramą  įspėjimų srityje (Windows operacinėse sistemose) ar Mac 

meniu juostą (macOS operacinėse sistemose), tuomet pasirinkite Screen Capture Toolbar. 

 
PASTABA 

 

Jei kompiuteris nėra prijungtas prie SMART interaktyvaus produkto, the 

SMART Board piktogramoje bus rodomas X apatiniame dešiniame kampe  . 
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2.   Spauskite vieną iš šių mygtukų: 
 

Nufotografuoti stačiakampio plotą. 

Nufotografuoti langą. 

 Nufotografuoti visą ekraną. 

Nufotografuoti laisvų rankų sritį. 

 

3.   Pasirinkite sritį, langą ar ekraną, kuriuos norite nufotografuoti. 
 

Atsidarys Capture langelis. Langelyje bus rodoma ekrano nuotraukos miniatiūra ir paskutinio 

pasirinkto veiksmo mygtukas. 
 

4.   Spauskite paskutinio veiksmo mygtuką. 
 

ARBA 
 

Spauskite Do something else ir pasirinkite kitą veiksmą. 
 
 

Ekrano nuotraukų įrankių juostos uždarymas 
 

Spauskite Close  (Windows operacinėse sistemose) ar Close  (macOS operacinėse sistemose) 

ekrano nuotraukų įrankių juostoje. 
 
 
 

Didintuvo naudojimas 
Naudokite didintuvo įrankį, kad jūsų auditorija galėtų matyti visas rodomas detales. 

 

 
 

 
 

Didintuvo įrankio naudojimas 
 

Didintuvo įrankio įjungimas 
 

1.   Notebook pasirinkite magišką rašiklį ir nupieškite kvadratą ar stačiakampį aplink norimą padidinti 

sritį. 
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Atsiras didintuvo įrankis. 
 

 
 

2.   Nuveskite pelytės žymeklį ant didintuvo ir paspauskite kairį klavišą. 
 

3.   Laikant kairį klavišą, perkelkite didintuvo įrankį į bet kurią rodomą sritį, kad ją 

padidintumėte. 
 

Naudokite slankiklį po didintuvu ir dar labiau padidinkite detales. 
 

Taip pat galite pirštu nuvesti didintuvo įrankį, kai naudojate SMART Board. 
 
 

Didintuvo įrankio uždarymas 
 

 

Spauskite Close  didintuvo įrankio viršutiniame dešiniame kampe. 
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Ekrano šešėlio įrankio naudojimas 
Galite naudoti ekrano šešėlį ekrano uždengimui ir jo turinio atskleidimui po truputį: 

 

 
 

 
 

Ekrano uždengimas 
 

1.   Spauskite SMART Board piktogramą  įspėjimų srityje (Windows operacinėse sistemose) ar Mac 

meniu juostą (macOS operacinėse sistemose), tuomet pasirinkite Screen Shade. 

 
PASTABA 

 

Jei kompiuteris nėra prijungtas prie SMART interaktyvaus produkto, the 

SMART Board piktogramoje bus rodomas X apatiniame dešiniame kampe   . 

 
2.   Jei jūsų kompiuteris yra prijungtas prie kelių ekranų, pasirinkite ekraną, kuriame turėtų atsirasti 

šešėlis. 
 

3.   Spauskite vieną ekrano šešėlio pusę ir vilkite norint uždengti ar atidengti ekraną. 

 
PATARIMAI 

 
o    Spauskite ant ekrano šešėlio ir pakeiskite jo spalvą. 

 
o    Du kartus paspauskite ant ekrano šešėlio ir atidenkite visą ekraną. 

 

 
 

Ekrano šešėlio pašalinimas 
 

Spauskite Close  ekrano šešėlio viršutiniame dešiniame kampe. 
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Išskyrimo įrankio naudojimas 
Galite naudoti išskyrimo įrankį pristatymo metu, kad atkreiptumėte dėmesį į kurią nors ekrano sritį: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PASTABA 
 

Kai išskyrimo įrankis yra atidarytas, galite rašyti ir redaguoti ekrano elementus tik išskirtoje 

dalyje. 
 

Taip pat galite naudoti magišką rašiklį išskyrimo įrankio atidarymui. 
 
 
 
 

Išskyrimo įrankio įjungimas 
 

1.   Spauskite SMART Board piktogramą  įspėjimų srityje (Windows operacinėse sistemose) ar Mac 

meniu juostą (macOS operacinėse sistemose), tuomet pasirinkite Spotlight. 

 
NOTE 

 

Jei kompiuteris nėra prijungtas prie SMART interaktyvaus produkto, the 

SMART Board piktogramoje bus rodomas X apatiniame dešiniame kampe . 

 
2.   Jei jūsų kompiuteris yra prijungtas prie kelių ekranų, pasirinkite ekraną, kuriame turėtų atsirasti 

išskyrimas. 

3.   Pasiriktinai, vilkite pelytės žymeklį per išskyrimo įrankio sritį, kad sumažintumėte arba 

padidintumėte tą sritį. 
 
 

Išskyrimo įrankio išjungimas 
 

Spauskite Close   išskyrimo įrankio viršutiniame dešiniame kampe. 
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Magiško rašiklio naudojimas išskyrimo įrankio įjungimui 
 

1.   Notebook pasirinkite magišką rašiklį ir nupieškite apskritimą aplink norimą išskirti sritį 
 

Atsiras išskyrimo įrankis. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.   Vilkite pelytės žymeklį per išskyrimo įrankio sritį, kad sumažintumėte arba padidintumėte tą 

sritį. 
 
 

Išskyrimo įrankio uždarymas 
 

 

Spauskite Close   išskyrimo įrankio viršutiniame dešiniame kampe. 
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Papildomų įrankių diegimas ir 

naudojimas 
 
 
 

Papildomų įrankių diegimas   177 

Papildomų įrankių naudojimas   177 

Trūkstančių papildomų įrankių nustatymas    178 

Papildomų įrankių išjungimas ir pašalinimas    178 
 

 
 
 

Galite surasti ir įdiegti SMART Notebook programinės įrangos papildomus įrankius iš  

SMART Exchange tinklapio. 
 
 
 

Papildomų įrankių diegimas 
 
 

Papildomo įrankio diegimas 
 

1.   Notebook meniu pasirinkite Add-ons > Manage Add-ons. 
 

Atsiras Add-on Manager. 
 

2.   Pasirikite vieną iš papildomų įrankių kairėje pusėje ir spauskite Done. 
 

 
 
 

Papildomų įrankių naudojimas 
Įdiegus papildomą įrankį, galite naudoti to papildomo įrankio funkcijas kaip naudojate kitas 

SMART Notebook programinės įrangos funkcijas. 
 
 

SVARBU 
 

SMART kapp papildomi įrankiai palaiko tik SMART kapp 42 ir SMART kapp 84 modelius. 
 

 
 

Papildomo įrankio peržiūra 
 

1.   Spauskite papildomus įrankius  ir atidarykite jį sąrašą. 
 

2.   Spauskite papildomų įrankių piktogramą ir atidarykite papildomą įrankį. 
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3.   Spauskite  ir grįžkite į papildomų įrankių sąrašą. 

 

 

Papildomo įrankio versijos ir kitos informacijos peržiūra  
 

1.   Pasirinkite Add-ons > Manage Add-ons programinės įrangos juostoje 
 

ARBA 
 

Spauskite  papildomo įrankio pavadinimo juostoje. 

Atsiras Add-on Manager. 

2.   Paspauskite papildomo įrankio pavadinimą. 
 

3.   Spauskite About. 
 

 
 
 

Trūkstančių papildomų įrankių nustatymas 
Jei atidarysite .notebook failo puslapį, kuris reikalauja papildomo įrenginio, kuris nėra įdiegtas arba jūsų 

kompiuteryje išjungtas, puslapio viršuje bus rodoma žinutė. Paspauskite žinutę, kad atidarytumėte Add-on 

Manager. Add-on Manager nustatys, kuris papildomas įrankis yra reikalingas. Tada galėsite įdiegti arba 

įjungti šį papildomą įrankį. 
 

 
 

Papildomų įrankių išjungimas ir pašalinimas 
Tam tikrais atvejais,  jūs galite norėti išjungti arba pašalinti įdiegtą papildomą įrankį. 

 

 

Jei išjungsite papildomą įrankį,  jis nebeatsiras SMART Notebook programinėje įrangoje, bet vis vien bus 

įdiegtas jūsų kompiuteryje. Galėsite bet kada jį įjungti. 

 

Jei pašalinsite papildomą įrankį,  jis nebeatsiras SMART Notebook programinėje įrangoje ir bus pašalintas 

iš jūsų kompiuterio. 
 
 

Papildomo įrankio išjungimas 
 

1.   Pasirinkite Add-ons > Manage Add-ons. 
 

Atsiras Add-on Manager. 
 

2.   Paspauskite papildomo įrankio pavadinimą. 
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3.   Spauskite Disable. 

 
PATARIMAS 

 

Kai norėsite vėl įjungti papildomą įrankį, spauskite Enable. 
 

 
 

Papildomo įrankio pašalinimas 
 

1.   Notebook meniu pasirinkite Add-ons > Manage Add-ons. 
 

Atsiras Add-on Manager. 
 

2.   Du kartus paspauskite papildomo įrankio pavadinimą. 
 

3.   Spauskite Remove. 

 
PASTABA 

 
o    Galite pašalinti tik SMART Notebook programinėje įrangoje įdiegtą papildomą įrankį. 

http://www.smarttech.com/kb/171309


 

 



181 smarttech.com/kb/171309 

 

 

 

10 skyrius 

SMART Notebook programinės 
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Gestų pasirinkčių nustatymas   184 

Paveiksliuko optimizavimo pasirinkčių nustatymas    185 

Didelių paveiksliukų dydžio sumažinimas rankiniu būdu   186 

Optimizuotų failų eksportavimas    186 

Numatyto fono spalvos pasirinkčių nustatymas    187 

Atstumo nuo langelio krašto ir jo turinio nustatymas    187 
 

 
 
 

šiame skyriuje paaiškinama, kaip konfigūruoti SMART Notebook programinę įrangą. 
 
 
 

Įrankių juostos tinkinimas 
 

SMART Notebook programinės įrangos įrankių juosta leidžia pasirinkti ir naudoti įvairias komandas bei 

įrankius. Jūs galite tinkinti įrankių juostą, kad ji apimtų dažniausiai naudojamus įrankius. 

 

Pridėjus arba pašalinus įrankių juostos mygtukus, galite atkurti numatytą įrankių juostos mygtukų 

rinkinį. Taip pat galite atkurti numatytuosius įrankių nustatymus, jei tinkinote ir išsaugojote nustatymus 

naudodami savybių skirtuką. 
 
 

Įrankių juostos mygtukų pridėjimas arba pašalinimas 
 

1.   Spauskite Customize the toolbar . 
 

ARBA 
 

Dešiniu klavišu paspauskite ant įrankių juostos. 
 

Atsiras Customize Toolbar dialogo langelis. 
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2.   Spauskite Actions arba Tools. 
 

3.   Atlikite šiuos veiksmus: 
 

o    Norint pridėti mygtuką į įrankių juostą, spauskite ant jo piktogramos dialogo langelyje, 

tuomet vilkite į įrankių juostą. 
 

o    Norint pašalinti mygtuką iš įrankių juostos, spauskite ant jo piktogramos įrankių juostoje, 

vilkite jį iš įrankių juostos. 

o    Norint pakeisti mygtukų išdėstymą, spauskite ant piktogramos įrankių juostoje, tuomet vilkite į 

kitą vietą įrankių juostoje. 

 
PASTABOS 

 
o    Galite pridėti, pašalinti ir pakeisti mygtukų išdėstymą įrankių juostoje, kaip pasirinkote 2 

žingsnyje. Pavyzdžiui, jei 2 žingsnyje pasirinkote Actions, galite tik pridėti, pašalinti ir 

pakeisti išdėstymą. 
 

o    Jei norite perkelti mygtuką tarp eilučių, vilkite ir laikykite jį tarp dviejų mygtukų stulpelių. 
 

Jei naudojate mažesnę ekrano skiriamąją gebą, perkelkite tik vieną ar du mygtukus tarp 

eilučių, kad išvengtumėte problemų, kai įrankių juosta yra platesnė nei SMART Notebook 

programinės įrangos langas. 

 

4.   Spauskite Done. 
 
 

Įrankių juostos mygtukų numatytų nustatymų atkūrimas 
 

1.   Spauskite Customize the toolbar . 
 

ARBA 
 

Dešiniu klavišu paspauskite ant įrankių juostos. 
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Atsiras dialogo langelis. 
 

2.   Spauskite Restore Default Toolbar. 
 
 

Įrankių numatytų nustatymų atkūrimas 
 

1.   Spauskite Customize the toolbar . 
 

ARBA 
 

Dešiniu klavišu paspauskite ant įrankių juostos. 

Atsiras dialogo langelis. 

2.   Spauskite Restore Default Tool Properties. 
 

 
 
 

.notebook failų numatytos programos keitimas 
Jei įdiegsite SMART programą, o ne SMART Notebook programinę įrangą, kuri gali atidaryti .notebook 

failus, galite nustatyti, kad programa būtų numatyta .notebook failams. Jei norite, vėliau galite pakeisti 

numatytąją programą atgal į SMART Notebook programinę įrangą. 
 
 

Numatytos programos pakeitimas atidarius failą 
 

1.   Atidarykite .notebook failą naudodami SMART Notebook programinę įrangą (žiūrėkite „Failų 

atidarymas“ 22 puslapyje). 
 

Atsiras žinutė, klausianti, ar norite pakeisti numatytą programą .notebook failams į SMART 

Notebook programinę įrangą. 
 

2.   Spauskite Yes. 
 
 

Numatytos programos pakeitimas naudojant nustatymų dialogo langelį 
 

1.   Pasirinktie Edit > Preferences. 
 

Atsiras SMART Notebook Preferences dialogo langelis. 
 

2.   Spauskite General. 
 

3.   Spauskite Make Default. 
 

4.   Jei norite, kad žinutė atsirastų atidarius .notebook failą, o jūsų numatyta programa nėra SMART 

Notebook programinė rangą, pasirinkite Tell me if SMART Notebook software isn’t the default 

program for .notebook files. 
 

5.   Spauskite OK. 
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Gestų pasirinkčių nustatymas 
Galite sąveikauti su objektais SMART Notebook programinėje įrangoje gestais, įtraukiant braukimo 

gestą bei spaudimo ir laikymo gestą. 
 

Gestas Pavadinimas  Tikslas 
 

Braukimo gestas  Sugrupuoti du ar daugiau objektų. 
 
 
 
 
 
 
 
 
 

 
Spaudimo ir laikymo gestas  Atlikti dešinio klavišo 

paspaudimą (Windows 

operacinėse sistemose) ar 

valdymo mygtuko paspaudimą 

(OS X operacinėse sistemose). 

 
 
 
 
 
 
 
 
 

 
Braukimo ir spaudimo – laikymo gestas yra numatytas nustatymuose. Tačiau, galite juos išjungti, jei 

pastebėjote, kad jūs ar jūsų mokiniai atsitiktinai atliekate šiuos gestus. 
 
 

Braukimo gesto išjungimas 
 

1.   Pasirinkite Edit > Preferences (Windows operacinėse sistemose). Atsiras SMART 

Notebook Preferences dialogo langelis. OS X operacinėse sistemose, pasirinkite Notebook 

> Preferences. Atsiras dialogo langelis. 
 

2.   Spauskite General. 
 

3.   Nuimkite varnelę nuo Use the shake gesture to group and ungroup objects langelio. 
 

4.   Spauskite OK. 
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Spaudimo ir laikymo gesto išjungimas 
 

1.   Pasirinkite Edit > Preferences (Windows operacinėse sistemose). Atsiras SMART 

Notebook Preferences dialogo langelis. OS X operacinėse sistemose, pasirinkite Notebook 

> Preferences. Atsiras dialogo langelis. 
 

2.   Spauskite General. 
 

3.   Nuimkite varnelę nuo Press and hold to perform a right-click langelio. 
 

4.   Spauskite OK. 
 

 
 
 

Paveiksliuko optimizavimo pasirinkčių nustatymas 
Jei jūsų .notebook failuose yra didelių nuotraukų (kurių dydis viršija 1 MB), failai gali būti atidaryti ir 

paleisti lėtai. Jūs galite sumažinti nuotraukų dydį nesumažinant jų kokybės. Dėl to jūsų .notebook failų 

dydis bus mažesnis, o failai bus atidaryti ir paleisti greičiau. 

 

Paveiksliuko optimizavimo pasirinktys 
 

1.   Pasirinkite Edit > Preferences (Windows operacinėse sistemose). Atsiras SMART 

Notebook Preferences dialogo langelis. OS X operacinėse sistemose, pasirinkite Notebook 

> Preferences. Atsiras dialogo langelis. 
 

2.   Spauskite Defaults. 
 

3.   Pasirinkite vieną iš pasirinkčių paveiksliuko optimizavimo išplečiamame sąraše: 
 

o    Ask every time I insert a large image turėti galimybę sumažinti arba nesumažinti didelių 

paveiksliukų failų dydžio juos įterpus. 
 

o    Never change the resolution of inserted images niekuomet nesumažinti didelių paveiksliukų 

failų dydžio juos įterpus. 
 

o    Always change image resolution to optimize file size visuomet sumažinti didelių paveiksliukų 

failų dydį juos įterpus. 
 

4.   Spauskite OK. 
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Didelių paveiksliukų dydžio sumažinimas rankiniu būdu 
Jei pasirinksite Ask every time I insert a large image paveiksliuko optimizavimo išplečiamame sąraše, 

galėsite rankiniu būdu sumažinti didelių paveiksliukų failų dydį, kai įterpsite tuos paveiksliukus į failą ar 

vėliau. 

 
 

Paveiksliuko dydžio sumažinimas įterpiant į failą 
 

1.   Įterpkite paveiksliuką, kaip aprašyta „Paveiksliukų įterpimas“ 101 puslapyje. 
 

Paspaudus Open, atsiras Image Optimization dialogo langelis. 
 

2.   Spauskite Optimize ir sumažinkite paveiksliuko failo dydį. 
 

ARBA 
 

 Spauskite Keep Resolution ir nesumažinkite paveiksliuko failo dydžio. 

 
PASTABOS 

 
o    Kai įterpiate BMP failą, SMART Notebook programinė įranga konvertuoja failą į PNG 

formatą. Šis konvertavimas sumažina failo dydį. Dėl to gali tekti eksportuoti optimizuotą 

.notebook failo versiją (žiūrėkite Optimizuotų failų eksportavimas žemiau), net jei BMP 

failas yra didesnis nei 1 MB. 
 

o    SMART Notebook programinė įranga automatiškai sumažina paveiksliukų, didesnių nei 5 MB ar 

5 megapikseliai dydį, nepaisant jūsų pasirinktų nustatymų. 
 

 
 

Paveiksliuko dydžio sumažinimas po įterpimo į failą 
 

1.   Pasirinkite paveiksliuką. 
 

2.   Spauskite paveiksliuko meniu rodyklę, tuomet pasirinkite Image Optimization. 
 

Atsiras Image Optimization dialogo langelis. 
 

3.   Spauskite Optimize. 
 
 
 

Optimizuotų failų eksportavimas 
Jei turite failų, kuriuose yra didelių paveiksliukų, arba pasirinkote Never change the resolution of inserted 

images paveiksliuko optimizavimo išplečiamame sąraše, galėsite eksportuoti optimizuotas failų versijas, 

kuriose bus sumažinti paveiksliukai. Tai yra ypač naudinga, kai reikia pristatyti .notebook failą senesniame 

ar mažiau galingame kompiuteryje. 
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Optimizuoto failo eksportavimas 
 

1.   Pasirinktie File > Export As > Optimized SMART Notebook File for . Atsiras dialogo langelis. 
 

2.   Pasirinkite, kur norite išsaugoti naują failą. 
 

3.   Windows operacinės sistemos atveju, įrašykite failo pavadinimą File name langelyje. OS X 

operacinės sistemos atveju, įrašykite failo pavadinimą Save As langelyje. 
 

4.   Spauskite Save. 
 

 
 
 

Numatyto fono spalvos pasirinkčių nustatymas 
Numatyta, kad pridėjus naujus puslapius į failą, jų fonas bus baltas. Galite pakeisti numatytą 

fono spalvą. 
 
 

PASTABA 
 

Šis nustatymas yra taikomas tik naujiems puslapiams ir bus pakeistas taikant temas. 
 

 
 

Numatyto fono spalvos pakeitimas 
 

1.   Pasirinkite Edit > Preferences (Windows operacinėse sistemose). Atsiras SMART 

Notebook Preferences dialogo langelis. OS X operacinėse sistemose, pasirinkite Notebook 

> Preferences. Atsiras dialogo langelis. 
 

2.   Spauskite Defaults. 
 

3.   Pasirinkite Change Color, tuomet pasirinkite spalvą. 
 

4.   Spauskite OK. 
 

 
 
 

Atstumo nuo langelio krašto ir jo turinio nustatymas 
SMART Notebook 11 programinė įranga prideda atstumą nuo langelio krašto lentelėse. 
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Atlikite žemiau pateiktą procedūrą, kad pašalintumėte atstumą nuo langelių krašto lentelėse. Tai ypač 

naudinga, jei sukūrėte lenteles prieš atnaujindami SMART Notebook 11 programinę įrangą ir norėjote, kad 

lentelėse turinys būtų rodomas atstumo nuo langelių krašto. 

 
 

PASTABA 
 

Žemiau pateiktos procedūros atlikimas įtakoja lentelių išvaizdą .notebook failuose tik jūsų SMART 

Notebook programinės įrangos kopijoje. Jei atidarote tuos pačius .notebook failus kitoje SMART 

Notebook programinės įrangos kopijoje, lentelės bus rodomos atstumu nuo langelių krašto (tai reiškia, 

kad ši procedūra nebuvo atlikta SMART Notebook programinės įrangos kopijoje). 
 

 
 

Atstumo nuo langelių krašto pašalinimas 
 

1.   Pasirinkite Edit > Preferences (Windows operacinėse sistemose). Atsiras SMART 

Notebook Preferences dialogo langelis. OS X operacinėse sistemose, pasirinkite Notebook 

> Preferences. Atsiras dialogo langelis. 
 

2.   Spauskite Defaults. 
 

3.   Nuimkite varnelę nuo Add cell padding to table cells langelio. 
 

4.   Spauskite OK. 
 

5.   Uždarykite ir perkraukite SMART Notebook programinę įrangą. 
 

Naujos ir jau sukurtos lentelės jūsų .notebook failuose bus rodomos be atstumo nuo langelių krašto. 
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Šiame skyriuje paaiškinama, kaip pašalinti trikdžius SMART Notebook programinėje įrangoje. 
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Adobe Flash grotuvo problemos 
 

Problema Sprendimas 
 

Vaizdo įrašai ar objektų 

animacijos negroja SMART 

Notebook pamokos metu, nes 

neįsijungia Adobe Flash 

grotuvas. 

 

Kas vyksta 

Adobe nutraukia Flash grotuvą ir jo palaikymą  2020 metais. HTML5 

pakeis Adobe Flash grotuvą kaip pageidautina internetinė platforma 

multimedijos turiniui, taigi visiems kuriantiems turinį internete, taip pat 

ir SMART Technologies, reikės naudoti HTML5 multimedijos failų, 

įtraukiant vaizdo įrašus ir animacijas, kūrimui ir grojimui. 

 
Ką daro SMART  

Skatindami naudoti failus, kurie veiks nutraukus Adobe Flash grotuvo 

naudojimą, mes nebepalaikysime grotuvo SMART Notebook 17 versijoje. 

Žiūrėkite Adobe Flash grotuvo objektų, kurių SMART Notebook 

nebepalaiko, sąrašą. 

 
Mes jau pakeitėme populiariausias Adobe Flash grotuvo veiklas 

SMART Notebook galerijoje HTML5 veiklomis. Žiūrėkite Adobe 

Flash grotuvo veiklų, kurias SMART Notebook konvertuoja, sąrašą. 

 
Ką galite padaryti jūs 

Pasiruošti Adobe Flash grotuvo nutraukimui, ištrinti nepalaikomus, Flash 

objektus ir veiklas iš SMART Notebook ir sukurti naujus naudojantis 

SMART Notebook 17 galimais įrankiais. Atsisiųskite instrukcijas iš 

smarttech.com/flashupdate. 

 
 

Galite kurti linksmas ir įdomias veiklas SMART lab . Sužinokite 

daugiau apie  SMART lab pasiūlymus ir kaip naudoti šias veiklas. 

 
Jei jums būtina paleisti Flash failą iš senesnė pamokos, galite pabandyti 

atidaryti jį Adobe Flash interneto naršyklėje. 
 

 
 
 
 

Ryšio problemos 
 

Problema Spendimas 
 

Kilo tinklo ryšio 

problema. 

 

Keletas SMART Notebook programinės įrangos komponentų 

(aktyvavimas, maestro, lab, response 2) reikalauja aktyvus interneto 

ryšio ir prieigos prie URL, kuriuos gali užblokuoti tinklo apsaugos 

priemonė ar kiti filtrai. Žiūrėkite „Įrenginių ir tinklo reikalavimai“, 

kur pateiktas URL baltasis sąrašas.

http://www.smarttech.com/kb/171309
https://blogs.adobe.com/conversations/2017/07/adobe-flash-update.html
http://www.cbc.ca/news/business/adobe-flash-end-1.4220671
http://www.cbc.ca/news/business/adobe-flash-end-1.4220671
http://knowledgebase.force.com/articles/TROUBLESHOOTING/Adobe-Flash-objects-not-supported-in-SMART-Notebook-16-2-or-later
http://knowledgebase.force.com/articles/TROUBLESHOOTING/Adobe-Flash-objects-not-supported-in-SMART-Notebook-16-2-or-later
http://knowledgebase.force.com/articles/TROUBLESHOOTING/Adobe-Flash-objects-not-supported-in-SMART-Notebook-16-2-or-later
http://knowledgebase.force.com/articles/TROUBLESHOOTING/Adobe-Flash-objects-not-supported-in-SMART-Notebook-16-2-or-later
http://knowledgebase.force.com/articles/TROUBLESHOOTING/Adobe-Flash-objects-not-supported-in-SMART-Notebook-16-2-or-later
http://knowledgebase.force.com/articles/TROUBLESHOOTING/Adobe-Flash-objects-not-supported-in-SMART-Notebook-16-2-or-later
http://exchange.smarttech.com/details.html?id=f22f3e5d-30a3-425f-ba52-f3909495a9a3
https://education.smarttech.com/en/products/smart-learning-suite/smart-lab
https://support.smarttech.com/docs/software/notebook/notebook-17/en/using/tutorial/
http://knowledgebase.force.com/articles/TROUBLESHOOTING/Adobe-Flash-content-is-not-supported-in-SMART-Notebook-16-2-but-can-be-opened-in-a-web-browser
http://knowledgebase.force.com/articles/TROUBLESHOOTING/Adobe-Flash-content-is-not-supported-in-SMART-Notebook-16-2-but-can-be-opened-in-a-web-browser
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Skaitmeninio rašalo problemos 
 

Problema Sprendimas 
 

Windows kompiuteriuose, 

SMART Notebook programinė 

įranga neatpažįsta rašto jūsų 

kalba. 
 

Norite, kad raštas atrodytų 

gražesnis ir natūralesnis 

SMART Notebook 

programinėje įrangoje. 

 
 

Nepavyksta sklandžiai rašyti 

SMART Notebook 

programinėje įrangoje 

naudojant Windows 7 

operacinę sistemą. 

 

Įdiekite atitinkamą kalbos paketą. 
 
 
 
 
 
 
Naudokite kaligrafinį rašiklio tipą, o ne standartinį (žiūrėkite 

„Rašymas, piešimas skaitmeniniu rašalu ir jo ištrynimas“ 36 

puslapyje). 

 
 
Išjunkite Single Finger Panning funkciją. Žiūrėkite 

smarttech.com/kb/147470. 

 

Kai rašote rašikliu, SMART 

Notebook programinė įranga 

naudojant Windows 7 

operacinę sistemą 

interpretuoja jūsų veiksmą 

kaip pelytės paspaudimą.  

Išjunkite Flicks funkciją. Žiūrėkite smarttech.com/kb/144274. 

 

 
 

Failų problemos 
 

Problema Sprendimas 
 

Jūsų faile yra didelių 

paveiksliukų, todėl jie 

stringa, kai atidarote 

SMART Notebook 

programinėje įrangoje. 
 

 

Eksportuokite optimizuotą failo versiją (žiūrėkite 

„Paveiksliuko optimizavimo pasirinkčių nustatymas“ 185 

puslapyje). 

http://www.smarttech.com/kb/171309
http://www.smarttech.com/kb/147470
http://www.smarttech.com/kb/144274
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Problema Sprendimas 
 

Išmetė failo ar konkrečios 

funkcijos klaidą. 
 

 
 
 
 
 
 
 
 

SMART Notebook failas yra 

sugadintas ir negali būti 

atidarytas su 

SMART Notebook 

programine įranga. 

 

l  Perkraukite kompiuterį ir pabandykite vėl atidaryti 

SMART Notebook failą. 

l  Pabandykite sukurti naują failą su problemą keliančiu turiniu 

(pavyzdžiui, pridėkite naują nuotrauką, kurios nebuvo), kad 

nustatytumėte ar problema yra visame faile. 

l  Pabandykite kitą naudotojo paskyrą ar kitą kompiuterį ir atidarykite 

SMART Notebook failą, kad nustatytumėte, ar tai failo problema, ar 

paskyros. 
 

Jei negalite atidaryti failo SMART Notebook programinė įrangoje, 

tolesnė informacija pateikiama šiame aptarnavimo puslapyje. 

 
 
 

 

Gestų problemos 
 

Problema Sprendimas 
 

Lietimo gestai neveikia 

SMART Notebook 

programinėje 

įrangoje. 

 

Įsitikinkite, kad jūsų interaktyvus produktas palaiko lietimo 

gestus ir jie yra įjungti. 

http://www.smarttech.com/kb/171309
https://community.smarttech.com/s/article/You-re-unable-to-open-a-file-with-SMART-Notebook-software?language=en_US
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Diegimo problemos 
 

Problema Sprendimas 
 

Iškilo diegimo klaida. 
 

Trikdžių šalinimo procedūros diegimo klaidoms skiriasi priklausomai 

nuo operacinės sistemos, konkrečios klaidos pranešimo ir aplinkos bei 

kompiuterio specifikacijų. Toliau pateikiami keli bendri patarimai, 

kuriuos galite išbandyti, jei diegimo metu atsiras klaidos pranešimas. 

Žiūrėkite KB straipsnį tolesnei informacijai. 
 

l  Windows: 

a.   Atnaujinkite Windows operacinę sistemą. 

b.   Perkraukite kompiuterį. 

c.   Patikrinkite ar nėra problemų keliančių sistemos failų. 

Žiūrėkite aptarnavimo dokumentą tolesnei informacijai. 

d.   Įdiekite iš naujo. 
 

l  Mac kompiuteriams: 

a.   Atnaujinkite macOS ar OS X operacinę sistemą. 

b.   Perkraukite kompiuterį. 

c.   Patikrinkite disko leidimus (jei taikoma). Žiūrėkite Apple 

aptarnavimo dokumentą tolesnei informacijai. 

d.   Įdiekite iš naujo. 
 

 
 
 
 

Pamokos turinio dingimas 
 

Problema Sprendimas 
 

Sukūrėte SMART Notebook 

pamoką namuose, bet 

viktorinos ir klausimai 

pradingsta, kai jūs ar kolega 

pristatote naudodami kitą 

kompiuterį. 

 

Jei naudojate kitą kompiuterį, o ne tą, kuriame kūrėte pamoką, galite 

atidaryti pamoką, tačiau turite prisijungti prie savo SMART Notebook 

paskyros, kad galėtumėte naudotis visomis SMART lab ir SMART 

response 2 funkcijomis. 
 

l  Pasirinkite Account iš SMART Notebook meniu ir prisijunkite, kad 

matytumėte dingusį turinį. 

http://www.smarttech.com/kb/171309
https://community.smarttech.com/s/article/A-side-by-side-or-assembly-error-occurs-when-you-install-or-start-SMART-Notebook-software
https://support.microsoft.com/en-ca/help/929833/use-the-system-file-checker-tool-to-repair-missing-or-corrupted-system-files
https://support.apple.com/en-ca/HT201560
https://support.apple.com/en-ca/HT201560
https://support.microsoft.com/en-ca/help/929833/use-the-system-file-checker-tool-to-repair-missing-or-corrupted-system-files
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Objektų problemos 
 

Problema Sprendimas 
 

Kai sukuriate 

.notebook failą viename 

kompiuteryje ir atidarote 

kitame, objektai failuose 

skiriasi. 

 
 

 
 

Norite perkelti, pakeisti dydį 

ar kitaip redaguoti objektą, bet 

tai padarius, perkeliate, 

pakeičiate ir kitu būdu 

redaguojate ir kitus objektus. 

 

Yra kelios galimos priežastys. Pateikiame dažniausias: 

o    Naudojote šriftą, kuris yra įdiegtas viename kompiuteryje, 

bet ne kitame. 

o    Skiriasi kompiuterių operacinė sistema. 
 

o    Skiriasi kompiuterių SMART Notebook programinės įrangos 

versijos. 

 
 

l  Objektai yra sugrupuoti. Bet kokie vieno objekto pakeitimai 

paveikia ir  kitus objektus. 

l  Pasirinktie objektus, tuomet pasirinktie Format > Group > 

Ungroup ir išgrupuokite juos. Dabar galėsite perkelti, pakeisti 

dydį ir kitaip redaguoti atskirus objektus. 

l  Daugiau informacijos pateikta „Objektų padėties keitimas“ 69 puslapyje. 
 

Norite perkelti, pakeisti dydį 

ar kitaip redaguoti objektą, 

bet negalite. Užrakto   

piktograma atsiranda vietoje 

meniu rodyklės, kai 

pasirenkate objektą. 

Objektas yra užrakintas, todėl negalite jo keisti. Norėdami atrakinti 

objektą, pasirinkite jį, spauskite užrakto piktogramą  

, tuomet pasirinktie Unlock. 

http://www.smarttech.com/kb/171309
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Problema Sprendimas 
 

Vienas objektas 

uždengia kitą: 

 

l  Kai kuriate objektus, naujas objektas niekuomet neuždengia kito 

objekto automatiškai, jei objektai yra toje pačioje puslapio 

padėtyje. 

l  Galite pakeisti objektų tvarką. Daugiau informacijos pateikta 

„Objektų pertvarkymas“ 71 puslapyje. 

 
 
 
 
 

 
Norite, kad antrasis objektas 

uždengtų pirmąjį: 
 

 
 
 
 
 
 
 
 
 
 

Kai užpildote objektą 

paveiksliuku, kuris yra 

didesnis nei objektas, 

paveiksliukas yra apkerpamas: 

l  Užpildydami objektą paveiksliuku, pasirinktie Scale image to fit 

ir pakeiskite paveiksliuko dydį, kad tilptų į objektą: 

 
 
 
 
 
 
 

 
 

Arba, Kai užpildote objektą 

paveiksliuku, kuris yra 

mažesnis nei objektas, 

paveiksliukas yra 

padauginamas: 

l  Daugiau informacijos pateikta „Objekto savybių keitimas“ 66 

puslapyje. 

http://www.smarttech.com/kb/171309
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Prenumeratos ir produkto rakto problemos 
 

Problema Sprendimas 
 

Norite gauti SMART 

Notebook produkto kodą. 

 
 

 
 
 
 
 
 
 
 

Norite nebenaudoti produkto 

kodo ir galėti prisijungti savo 

SMART paskyra bei naudoti 

SMART Notebook 18 bet 

kuriame kompiuteryje. 

 

l  Produkto raktas yra suteikiamas SMART programinės įrangos portale. 

SMART programinės įrangos portalo prisijungimo informacija 

pateikiama adresatams, kurie įsigijo SMART Notebook programinę 

įrangą. Susisiekite su techniniu administratoriumi, norėdami gauti 

SMART Notebook produkto raktą. 

l  Jei jūs esate techninis administratorius, jūs turėjote gauti elektroninį 

laišką su prisijungimo informacija. Prisijunkite prie SMART 

software portal ir pasižiūrėkite, kokie SMART programinės 

įrangos produkto raktai galimi jūsų organizacijai. 
 

l  Susisiekite su sistemos administratoriumi ir paprašykite pridėti 

SMART paskyros elektroninį paštą į jūsų mokyklos SMART 

Learning Suite prenumeratos SMART software portal. 

l  Jei jūs esate sistemos administratorius ir įsigijote Notebook, 

prisijunkite prie SMART software portal ir atlikite pakeitimus 

patys. 

 
PASTABA 

 

Turėtumėte naudoti SMART Notebook 17 ar naujesnę 

(18 rekomenduojama). 

 

Jums reikia atnaujinti 

SMART Learning Suite 

prenumeratą. 
 

Norite nustatyti 

SMART Notebook 

programinės įrangos versiją, 

kuria galite naudotis dėl 

prenumeratos. 
 

Norite žinoti, kai SMART 

Learning Suite programinė 

įranga veiks, kai apsibaigs 

jūsų prenumerata. 

l  Susisiekite su įgaliotu SMART pardavėju, kuris galės atnaujinti  

SMART Learning Suite prenumeratą. 
 
 

l  Iš tiesų jūs galite atsisiųsti ir įdiegti bet kurią SMART Notebook 

programinę įrangą, kuri yra leidžiama jūsų prenumeratos galiojimo 

metu. 

 
 

 
l  Kai pasibaigs jūsų SMART Learning Suite prenumerata, galėsite 

toliau naudoti SMART Notebook programinę įrangą ribotu 

režimu. Šiame režime galimos tik kelios papildomos funkcijos. 

l  Apsilankykite SMART Learning Suite subscription features page , 

kur pateikiamas konkretus sąrašas. 

http://www.smarttech.com/kb/171309
https://education.smarttech.com/products/notebook/notebook-activation-and-product-keys
https://education.smarttech.com/products/notebook/notebook-activation-and-product-keys
https://education.smarttech.com/products/notebook/notebook-activation-and-product-keys
https://education.smarttech.com/products/notebook/notebook-activation-and-product-keys
https://support.smarttech.com/docs/software/software-portal/en/using.cshtml?cshid=AddUser&amp;subscription
https://community.smarttech.com/s/article/SMART-Learning-Suite-subscription-premium-features
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Įrankių juostos ir lango problemos 
 

Problema Sprendimas 
 

Naudojant 

SMART Notebook programinę 

įrangą su interaktyviu 

 
Spauskite Move toolbar to top/bottom of window , kad 

perkeltumėte įrankių juostą iš lango viršaus į apačią. 

produktu, jūs ar jūsų           PATARIMAS  

mokiniai negalite pasiekti 

įrankių juostos. 

 

Jei turite reguliuojamo aukščio sienos tvirtinimą, taip pat galite 

sureguliuoti interaktyvios lentos ar ekrano aukštį, kad mokiniai 

galėtų pasiekti. 

 

Įrankių juostos mygtukai, 

aprašyti šiame dokumente, 

neatsiranda įrankių juostoje. 

 
 
 
 
 
 
 
 

 
Norite pakeisti numatytus 

SMART Notebook įrankių 

juostos nustatymus, 

pavyzdžiui rašiklio storį ar 

teksto šriftą. 
 

Nėra pakankamai vietos 

interaktyviame produkte, kad 

būtų rodomas jūsų puslapio 

turinys. 

 
Puslapių rūšiuotuvas, 

galerija, priedai, savybės ir 

kiti skirtukai dingsta, kai 

paspaudžiate už jų ribų. 

l  Jei atsiranda rodyklė, nukreipta į apačią, dešinėje įrankių juostos 

pusėje, paspauskite ją, kad rodytų papildomus įrankių juostos 

mygtukus. 

l  Jei norimas mygtukas neatsiranda paspaudus žemyn nukreiptą 

rodyklę, jūs ar kitas naudotojas galėjote pašalinti mygtuką 

 (žiūrėkite „Įrankių juostos tinkinimas“ 181 puslapyje). 

l  Neperkelkite daugiau nei pora mygtuku per eilutes, kad įrankių juostą 

nebūtų platesnė nei SMART Notebook programinės įrangos langas. 
 

Žiūrėkite Changing the default font in SMART Notebook software 
 
 
 
 
 

 
l  Spauskite View Screens , tuomet pasirinktie Full Screen, kad 

puslapį rodytų per visą ekraną. 

l  Pažymėkite Auto-hide langelį, kai paslėptumėte skirtukus, kai jų 

nenaudojate. 
 

Paspauskite ant vieno skirtuko piktogramos, kad jį rodytų, tuomet 

nuimkite varnelę nuo Auto-hide langelio. 

http://www.smarttech.com/kb/171309
https://community.smarttech.com/s/article/Changing-the-Default-Font-in-Notebook-Software-9-x-1378698109954
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Problema Sprendimas 
 

Du naudotojai kuria ar valdo 

objektus SMART Board 800 

serijos interaktyvioje lentoje 

SMART Notebook 

programinėje įrangoje. 

Vienas naudotojas naudoja 

savo pirštą. Kitas naudotojas 

naudoja rašiklį iš dėklo. 

Kai naudotojas, naudojantis 

rašiklį, paspaudžia mygtuką 

įrankių juostoje, pasirinktas 

įrankis ar parinktis pasikeičia 

naudotojui, rašančiam pirštu. 

 

Naudotojas, naudojantis rašiklį, turi apspausti mygtuką įrankių 

juostoje rašikliu, o ne pirštu. 

 

 
 
 

 

Susisiekimas su SMART pardavėju/aptarnavimo 

skyriumi dėl pagalbos 
 

Problema Sprendimas 
 

Norite susisiekti su SMART 

pardavėju/aptarnavimo 

skyriumi dėl pagalbos. 

 

1.   Surinkite ekrano nuotraukas, vaizdo įrašus, failų ir žingsnių 

pavyzdžius, reikalingus problemai atkurti. 

2.   Nustatykite problemos apimtį. Ar paveikti tik tam tikrų 

naudotojų profiliai? Kiek kompiuterių buvo paveikta? Kaip 

plačiai paplitusi problema? 

3.   Surinkite SMART Notebook sistemos žurnalus. 

o    Windows: atidarykite SMART Notebook programinę įrangą ir pasirinkite 

Help > Generate Diagnostic Data. 

o    macOS: atidarykite SMART Notebook programinę įrangą ir pasirinkite 

Notebook > Generate Diagnostic Data. 

http://www.smarttech.com/kb/171309
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